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Preface

The Building Energy Simulation: A Workbook Using 
DesignBuilder™ is an outcome of a series of training pro-
grams conducted for participants with varied backgrounds. 
The authors experimented with various teaching techniques 
and arrived at the conclusion that the most effective method 
of imparting these training programs is through tutorials and 
step-by-step instructions along with graphical illustrations.

The simulations in this workbook are performed using the 
DesignBuilder™ software for illustration purpose to help 
explain the aspects of a whole building energy simulation pro-
cess. This workbook adopts the ‘learning by doing’ principle 
to explain the fundamentals of building physics and building 
services, and in turn help participants understand the concept 
of building energy performance. Based on participant feed-
back during the training programs, the authors decided to use 
EnergyPlus™ with DesignBuilder as the front end to explain the 
simulation process.

The book has been organized as follows:

• The first ten chapters of this workbook cover various aspects 
of simulation, such as creating the building geometry, 
assigning material and equipment and analysing the results. 
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• Chapter 11 explains simulation for the whole building 
performance method of the ASHRAE 90.1 standard.

• Chapters 12 through 14 provide exercises to simulate 
three different building projects. 

The authors would highly appreciate any feedback or sugges-
tions for improving this workbook.
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CHAPTER ONE

Getting Started with 
Energy Simulation

This chapter is to acquaint you with energy simulation. It starts 
with the introduction of various components and requirements 
for simulation, and then gradually progresses to the concept of 
simulation using a ready example file. It establishes the impact 
of key simulation inputs such as lighting power density (LPD), 
activity, setpoint, window-to-wall ratio (WWR), orientation 
and fresh air intake on energy consumption. 

There are 11 tutorials to help you navigate through the chapter. 
By the end of this chapter, you will get familiarized with key 
input parameters, output visualization, and overall simulation 
process.

Building energy simulation

Building energy simulation is performed using a computer to 
virtually represent a building design and perform physics-based 
calculations. The simulations can range from a building compo-
nent to a cluster of buildings. For energy simulation, the build-
ing model along with the usage pattern and the weather of the 
location are required to determine various outputs, such as peak 
loads, system sizing, and energy consumption for any given 
period. This information can be utilized for estimating the util-
ity bills, for evaluating cost–benefit analysis of various design 
strategies.
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Some of the uses for energy simulation tools are:

Early design decisions: In early design stage, decisions 
such as orientation and layout of the building are taken. 
Energy simulation can help in evaluating various design 
strategies. However, a detailed simulation may not be pos-
sible because of the limited information available at this 
stage.

Component or material selection: Simulation helps in the 
decision-making process while selecting individual  com-
ponents of building envelop or systems. It is quite com-
monly used to carry out cost–benefit analysis of various 
designs and components. Therefore, modelling at this stage 
needs to be performed with greater accuracy as compared 
to modelling for early design decisions.

Retrofitting decisions: For retrofit of existing buildings, 
energy simulation can help in selecting cost effective solu-
tions. For an accurate analysis, simulation model should 
be calibrated using the measured performance data of the 
building.

What is needed for energy simulation

Energy simulation of buildings can be performed using a sys-
tematic approach. A lot of data is required. It is recommended 
that you collect the required data before you start the modelling.

The following basic information is required: 

Location and weather file: Energy simulation tools need 
hourly ambient conditions (temperature, humidity, wind 
velocity, solar radiation, etc.) at the building location. This 
information is available in weather files. Simulation tools 
use these weather files to extract the hourly ambient condi-
tions while carrying out the simulation. However, for some 
locations, the weather file may not be available. In such 
cases, the weather file of some other location with similar 
weather conditions can be used.

Weather files are available in different formats. Different 
simulation tools use different formats of weather files. 
Utilities are available on the web for converting a weather 
file from one format to another.
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Building geometry: Building elevation and floor plans 
are required to create the geometric model of a build-
ing. Architectural drawings may have many details that 
might not be directly useful for energy simulation. It is 
useful to simplify the drawings based on thermal zon-
ing into a single line drawing by removing unnecessary 
details.

Envelope components: It is necessary to have construc-
tion details, such as thickness and thermophysical proper-
ties of materials used in each layer of building envelope. 
Besides the opaque components, it is very important to 
have properties of window glass, frame and shading 
devices.

Building services: Information about various services such 
as HVAC and lighting is required. This includes equipment 
capacities, energy efficiency, location and controls.

Usage of building: The hourly values of the following are 
required: 

• Occupancy

• Lighting

• Equipment

• Thermostat setpoint

• HVAC operation

How simulation software works

The simulation program enables simultaneous interaction of the 
geometric model with outdoor conditions, occupancy, and usage 
of building systems to predict various loads arising in the build-
ing on an hourly basis. Basic laws of physics and energy balance 
equations are used for calculations. The energy consumption for 
the operation of systems corresponding to the heat and other loads 
is also calculated on the same time scale. Results of the process-
ing are passed to the calculations of next time slice and are also 
supplied to the output file. This process continues for the entire 
duration of the simulation, and the final output is seen as aggre-
gated or on the same time slice for which calculation has been 
carried out. Most simulation tools are capable of simulating the 
energy flows through different building components on an hourly 
basis, including the transient effects of the envelope and systems.
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The advantage of energy simulation over classical method is 
that various effects of thermophysical properties of materials 
and the performance of various systems under varying external 
and internal environmental conditions are considered in energy 
calculations. Most energy simulation tools do not require any 
special computing power, as they can be run on commercially 
available desktop computers or laptops.

This chapter provides basic tutorials on creating simple 
geometry, analysing the impact of building orientation, 
WWR, internal loads and fresh air delivery with a spe-
cial focus on analysing building energy performance and 
 system sizing. The tutorials are followed by exercises. There 
are many energy simulation tools  available. For this book, 
we will be using DesignBuilder. This can be downloaded 
from: https://www.designbuilder.co.uk/download/software/
previous-versions/49-designbuilder-v4-7-0-027-1.

TUTORIAL 1.1  Opening and simulating an 
example file

GOAL

To evaluate the energy performance of a building provided 
in an example file in DesignBuilder. 

WHAT ARE YOU GOING TO LEARN?

• Simulating an example file

• Viewing energy consumption results based on utility 
type or fuel, such as electricity and gas

• Viewing the end use energy consumption (lighting, 
equipment, fan, cooling, heating, pump and domestic 
hot water)

• Viewing results on a daily, monthly and annual basis

• Switching between Metric (SI) and English (IP) mea-
surement units

• Finding energy use intensity (EUI)

PROBLEM STATEMENT

In this tutorial, you are going to simulate an existing template, 
Courtyard with VAV Example, from the DesignBuilder 
library and simulate it for the climate of London. You will 

https://www.designbuilder.co.uk/download/software/previous-versions/49-designbuilder-v4-7-0-027-1
https://www.designbuilder.co.uk/download/software/previous-versions/49-designbuilder-v4-7-0-027-1
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learn how to view the daily, monthly, and annual energy 
consumptions in a graphical form. You will also learn how 
to view the annual fuel breakdown and fuel total.

SOLUTION

Step 1: Start DesignBuilder. The DesignBuilder main 
screen appears as shown in next step.

Step 2: Double-click Courtyard with VAV Example in 
the DesignBuilder templates under the Recent Files tab. 
A New project Data screen appears.
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Step 3: Click CA-SAN FRANCISCO INTL. Three 
dots (…) appear.

If you have installed DesignBuilder for the first time 
on your system, CA-SAN FRANCISCO INTL  may 
appear as location. If you have used DesignBuilder 
earlier, you may get some other location based on your 
previous settings.

Courtyard with VAV Example is a DesignBuilder 
 template file. A DesignBuilder template file helps in 
providing examples of various building typologies and 
systems such as geometry, HVAC system and passive 
strategies. Relevant data from the example files can be 
exported and imported into other DesignBuilder models.
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Step 4: Click the three dots (…). The Select the location 
template screen appears.

Step 5: Select LONDON/GATWICK ARPT. Click 
OK. The Select location for template-based new file 
screen appears.

LONDON/GATWICK ARPT is a weather file that comes 
along with the DesignBuilder installation. For all other 
locations, an Internet connection is needed to download 
the weather files.
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Step 6: Click OK.

The building layout appears with the following tabs at 
the bottom of the central display screen: 

• Edit

• Visualise

• Heating design

• Cooling design

• Simulation

• CFD

• Daylighting

• Cost and carbon

Step 7: Select Simulation tab. The Edit Calculation 
Options screen appears.
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Step 8: Enter the Simulation Period start date to 1 Jan and 
the end date to 31 Dec. Click OK to start the simulation.

A screen appears showing the simulation progress. 
Depending on the configuration of the system, it can take 
several minutes to complete the simulation.

After the simulation is completed, results are displayed 
in the Analysis subtab of the Simulation tab.

Step 9: Under Display Options, select Fuel totals from 
the Data drop-down list and Annual from the Interval 
drop-down list. A screen appears with a bar graph for 
annual fuel totals for electricity and gas. 

Note: The results are either displayed in IP or SI units 
based on your configuration of DesignBuilder. The 
steps involved in switching between SI and IP units are 
explained in Step 15.
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Step 10: Select the Normalise by floor area check box 
and All floor area from the By drop-down list to view 
the EUI of the building.

Units for the Fuel totals can be seen on the y-axis of the 
graph.
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Step 11: Change the Interval from Annual to Monthly to 
view monthly results. Refer to step 9.

Step 12: Select Grid from the Show as drop-down list to 
view results in a grid format.

The gross floor area of a building is the total built-up 
area, which includes all conditioned and unconditioned 
enclosed spaces of the building.

The term EUI refers to the energy consumption of the 
building per unit area per annum. The same term, in some 
countries, is also named as Energy Performance Index 
(EPI). The EUI of a building is calculated by dividing the 
annual total energy (all fuel types) consumption of the 
building with its gross floor area. The unit of measure-
ment is kWh/m2 yr or kWh/ft2 yr or Btu/ft2 yr. A lower 
EUI means a better energy performance.
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Step 13: Select Fuel breakdown from the Data drop-
down list to view results for fuel breakdown.

In all the above steps, the results are in SI or IP units based 
on the existing configuration of DesignBuilder in your sys-
tem. To change the units, perform the following step.
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Step 14: From the Tools menu, select Program options. 
The Edit Program Options screen appears.

Step 15: Select the International tab and select Units as 
per your requirement. Click OK. DesignBuilder updates 
all the values in the selected units. SI units will be used 
in this workbook.

Step 16: From the File menu, select Save to save this model.
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Exercise 1.1

Compare the EUIs of residential and office buildings.

‘Courtyard with VAV example’ is for an office space. Simulate 
a file with residential usage and compare the results.

Hint: Open the file House example 1. Ensure that the  location 
is London Gatwick. Repeat the steps given in Tutorial 1.1 
to find the EUI. Enter the EUI values in the last column of 
Table 1.1.

You can observe that even with the same location and build-
ing envelope, the EUIs of office buildings and residential 
buildings are different. This is mainly due to the difference 
in building usage that includes difference in timing and dura-
tion of use, occupancy density, nature of equipment used and 
other factors. Office buildings usually have a higher EUI, as 
they have higher internal loads (Table 1.1).

DesignBuilder can open only one file at a time.

Table 1.1 Energy use intensities for office and residential 
buildings

Energy use
Office building EUI 
(kWh/m2)

Residential building EUI 
(kWh/m2)

Electricity
Gas
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TUTORIAL 1.2 Creating a single-zone model

GOAL

To create a single-zone model and find heating and cooling 
capacities. 

WHAT ARE YOU GOING TO LEARN?

• Creating a new file

• Drawing a rectangular model

• Viewing the building model

• Rendering the building model

• Sizing runs for heating and cooling capacity

• Performing annual energy simulations

PROBLEM STATEMENT

Create a new file and draw a 40 m × 20 m rectangu-
lar building of height 3.5 m with location as LONDON/
GATWICK ARPT. Perform cooling and heating sizing and 
annual energy simulation. Use the Dynamic orbit option for 
different 3D views of the model.

SOLUTION

Step 1: Click File and select New Project. The Add new 
project screen appears.
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Step 2: Enter First Building in the Title text box and 
click OK. A blank building layout appears.

Step 3: Select Plan from the View rotation drop-down list.

In the DesignBuilder display, the red line represents the 
x-axis, green the y-axis, and blue the z-axis.
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Step 4: Click the Add new building button. The Add 
new building screen appears.

Step 5: Click OK. The screen appears with a cursor to 
draw a building.

Step 6: Move pointer to the Origin. Left click, move on 
the positive x-axis. The length of the segment is shown. 
(In case of any mistake, you can choose to cancel the 
drawn line by pressing the ESC key and then try again).
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Step 7: Type 40. The Length of the wall is set to 40 m. 
Ensure that the properties under the Geometry  section 
are as follows: 

• Block type – Building Block

• Form – Extruded

• Height – 3.5 m 

Press Enter.
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Step 8: Rotate the mouse wheel to zoom in or zoom out. 
Move the pointer parallel to the positive y-axis. It snaps 
when a dashed vertical line appears. Type 20 to draw the 
second side of the rectangle. Press Enter.
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Step 9: Similarly draw other segments and complete the 
rectangular building block of dimensions 40 m × 20 m. 
The following screen shows the completed block.

Step 10: Select the Dynamic orbit tab on the main menu 
bar. This shows the block in the orbit mode. Click and 
drag the mouse in the layout to view the block in the 
orbit mode.
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Now you will learn to run the system sizing.

Step 11: Select the Heating design tab at the bottom 
of the screen. The Edit Calculation Options screen 
appears.

Heating Design calculations show the heating system size 
in the worst conditions (no internal loads and solar heat 
gains) for a winter design day.

Steady-state simulations assume that the temperature 
across the envelope does not vary with time.
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Step 12: Select OK. The screen appears with the average 
and total winter steady-state design data for the  current 
building in graphical format.

This graph shows the heat balance to maintain the inside 
temperature of 22°C when the outdoor dry bulb tem-
perature is −4.4°C. You can see that there is a heat flow 
from the inside to outside (shown as negative numbers; 
the convention is that a positive value is used for a heat 
flow from the outside to inside) through the envelop and 
due to infiltration and ventilation. To balance this heat 
loss, the required zone sensible heating is 58.53 kW.
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The table also shows the air temperature, radiant tem-
perature and operative temperature, where the operative 
temperature is calculated as the average of the radiant 
and air temperatures.

Step 13: Select the Summary tab. The Heating design 
data summary appears.

The design capacity of the building is 73.16 kW, which is 
calculated considering the sizing factor of 25% over the 
steady-state heat loss of 58.53 kW. The design capacity 
normalized by area is 95.60 W/m2, which is calculated for 
the building floor area. In this case, the building dimen-
sions are 40 m × 20 m, and the building area is 800 m2 
(Net Floor area is 765.24 m2).

Design capacity is the total heat loss multiplied by the 
sizing factor.

Sizing factor is the safety factor considered in sizing the 
HVAC system. For example, the heating system is com-
monly oversized by 25%.

Steady-state heat loss is the total heat loss from the build-
ing. In other words, it is the amount of heat needed to 
maintain the given indoor comfort temperature.
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Step 14: Similarly select the Cooling design tab at 
the  bottom of the screen. The Calculation Options  – 
Building 1 screen appears. Click OK. The temperature, 
heat gains and other parameters appear in graphical 
format.

Step 15: Select the Summary tab. The screen appears 
with the cooling design data summary.

A cooling system is commonly oversized by 15%.
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The screen data are provided in table format for a clear 
view (Table 1.2).

The load calculated in the building is 68.94 kW. Cooling 
load is also described in tons of refrigeration (TR). For 
this building, it is 19.64 TR. Enter the cooling and heat-
ing capacities in Table 1.4.

Sensible versus latent heat:

Sensible heat is the energy required to change the tempera-
ture of a substance with no phase change. Sensible heat rep-
resents only the dry bulb temperature change.

A ton of refrigeration (TR), describes the heat-extraction 
capacity of refrigeration and air conditioning equipment. 
It is defined as the rate of heat transfer that results in 
the melting of 1 short ton (907 kg) of pure ice at 0°C in 
24 hours. A refrigeration ton is approximately equivalent 
to 3.5 kW of cooling effect.

(Continued)

Table 1.2 Data for the single-zone model

Zone Block 1: Zone 1

Design capacity (kW) 68.9
Design flow rate (m3/s) 4.2
Total cooling load (kW) 59.9
Sensible (kW) 52.9
Latent (kW) 7.0
Air temperature (°C) 24.0
Humidity (%) 49.5
Time of max cooling Jul 15:00
Max op temp in day (°C) 29.9
Floor area (m2) 765.3
Volume (m3) 2,678.5
Flow/floor area (l/s-m2) 5.5
Design cooling load per floor area (W/m2) 90.1
Outside dry bulb temperature at time of peak 
cooling load (°C)

27.2
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Step 16: Select the Simulation tab to perform the annual 
simulation. Select Fuel breakdown from the Data 
 drop-down list, Annual from the Interval drop-down 
list and Grid from the Show as drop-down list.

Latent heat, however, does not affect the temperature of 
a substance. Heat that causes a change of state with no 
change in temperature is called latent heat.

A cooling system should be capable of removing both the 
sensible and latent heat from the building. Therefore, the 
total cooling capacity of a system will be (sensible heat 
load + latent heat load) ×  sizing factor.

In this tutorial, sensible heat is 52.93 kW and latent heat 
is 7.01 kW. The addition of both sensible and latent heat 
is 59.9. Therefore, the design capacity calculated by mul-
tiplying 59.9 with sizing factor (1.15) is 68.93.

You can divide this by 3.51 to convert it into the unit 
of TR.

 

68 93
3 51

19 64
.
.

.= TR

Heat supplied

Solid

Gas

Liquid

Latent heat

Se
ns

ibl
e h

ea
t

Se
ns

ibl
e h

ea
t

Se
ns

ibl
e h

ea
t

Latent heat

Te
m

pe
ra

tu
re



28 BUILDING ENERGY SIMULATION

Step 17: Select the Normalise by floor area check box 
and All floor area from the By drop-down list to view 
the EUI of the building. Also select Fuel totals from the 
Data drop-down list. Enter the electricity EUI value in 
Table 1.3.

Step 18: Save the model as First Building on Desktop. 
You are going to use this model in forthcoming tutorials.
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Exercise 1.2

Create a larger building and compare the EUI with a smaller 
building. Repeat the tutorial to create an 80 m × 40 m rect-
angular building. Compare the EUI of the larger building 
with the smaller building (the 40 m × 20 m building created 
in Tutorial  1.2) and enter it in Table 1.3. Enter and compare 
the cooling and heating capacities of the larger building in 
Table  1.4. The method to calculate the EUI (kWh/m2 yr) is 
explained in Tutorial 1.1.

Table 1.3 EUI for a large and small building

Building with 40 m × 20 m 
dimension kWh/m2 yr

Building with 80 m × 40 m 
dimension kWh/m2 yr

Electricity
Gas
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The following observations can be made through the above 
exercise: 

 1. EUIs of both the buildings are different.

 2. Cooling and heating equipment capacities are greater for 
the 80 m × 40 m building compared to the 40 m × 20 m 
building. Larger buildings require higher capacity equip-
ment due to the greater envelope area, occupancy and 
internal loads.

 3. Cooling/heating equipment capacities per unit area are 
different. A larger building has a lower capacity per 
unit area. The main reason behind such a difference is 
that although most of the internal loads, such as occu-
pancy, lighting and equipment, vary linearly with area, 
the heat gain/loss through the building envelope does 
not follow the same trend due to a non-linear variation 
of the exposed surface area with the floor area or car-
pet area.

Table 1.4 Cooling and heating capacity for a large and small 
building

Building with 
40 m × 20 m 
dimensions

Building with 
80 m × 40 m 
dimensions

Capacity of cooling 
equipment (kW)
Capacity of heating 
equipment (kW)
Cooling capacity (kW/m2)
Heating capacity (kW/m2)
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TUTORIAL 1.3  Evaluating the impact of building 
location and orientation

GOAL

To evaluate the impact of the building location and its ori-
entation on the HVAC system sizing and building annual 
energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing the location of a building

• Downloading a weather file

• Changing building orientation

• Analysing the impact of weather and orientation on 
the building’s performance

PROBLEM STATEMENTS

 1. In Tutorial 1.2, a 40 m × 20 m rectangular building 
was simulated for London. Simulate the same build-
ing model for New Delhi and compare the HVAC siz-
ing, monthly energy consumption and annual energy 
consumption.

 2. Rotate the building by 90° clockwise and simulate 
it for New Delhi. Compare the results of the two 
 models (without rotation and with 90° rotation).

SOLUTION

Step 1: Open the model saved in Tutorial 1.2.
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Step 2: Click First Building.

Step 3: Select the Location tab. The Location Template 
screen appears.

Step 4: Click LONDON/GATWICK ARPT. Three dots 
(…) appear. Click the three dots. The Select the location 
template screen appears.
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Step 5: Scroll to select INDIA. Double click India and 
select NEW DELHI/PALAM. Click OK.

Step 6: Click Building 1.
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Step 7: Select the Simulation tab. If your computer is 
connected to the Internet, DesignBuilder directly down-
loads the weather file. If, for some reason, DesignBuilder 
is not able to download the weather file, you can manu-
ally download the weather file from https://energyplus.
net/weather.

Place the downloaded weather file in the folder C:\
ProgramData\DesignBuilder\Weather Data.

https://energyplus.net/weather
https://energyplus.net/weather
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Step 8: Compare the simulation results for London and 
New Delhi locations. Results for London location can be 
obtained from Tutorial 1.2.

The impact of location on building energy consumption 
can be seen from the results reported in Table 1.5.

You can observe that there is no change in room elec-
tricity and lighting. This is the result of the same inter-
nal loads, and as there is no daylight-based control, the 
change in location does not change these values.

From the results in Tables 1.5 and 1.6, the following 
observations can be made: 

• The heating energy consumption is more in London 
than in New Delhi. This is because London has a 
colder climate compared to New Delhi.

DesignBuilder uses hourly weather files with .epw 
extension. Weather files can be downloaded from 
the following link: https://energyplus.net/weather. 
Weather files that are downloaded directly from the 
website should be copied in the DesignBuilder weather 
data folder located at C:\ProgramData\DesignBuilder\
Weather Data.

Table 1.5 Energy consumption with a change in location

Annual fuel breakdown data

Type London (kWh) New Delhi (kWh)

Room electricity 33,169.41 33,169.41
Lighting 47,936.98 47,936.98
Heating (gas) 30,807.65 1,502.32
Cooling 14,379.14 101,945.7
DHW (electricity) 3,001.28 3,001.28

https://energyplus.net/weather
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• For the cooling energy consumption, it is the 
reverse because New Delhi is warmer than 
London in summers.

• Similarly, there is a significant effect of location 
on the cooling and heating equipment capacity.

Next steps show how to change the orientation.

Step 9: Select the Location tab (refer to Steps 2 and 3 
of this tutorial) and click Site Details. Enter 90 in the 
Site Orientation text box. Select the Layout tab. You can 
observe the change in the north arrow direction before 
and after changing the site orientation.

North is indicated by the direction of the north arrow in 
the sketch plan view.

North

Table 1.6 Heating and cooling equipment capacity with a 
change in location

London New Delhi

Capacity of cooling equipment (kW) 68.94 99.64
Capacity of heating equipment (kW) 73.16 43.56
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Step 10: Select the Simulation tab to get the results.

The impact of building orientation on building energy 
consumption is shown in the results recorded in 
Table 1.7. 

Site orientation (°) in DesignBuilder represents the 
alignment of the building(s) with respect to true north. 
However, since there could be multiple buildings on the 
site, this is called site orientation instead of building 
orientation.

Working at the ‘untitled’ level (here First Building) of the 
tree means working at the site level. For example, if there 
are multiple buildings on a site that are to be modelled in 
DesignBuilder, after creating one building, return to the 
site level in the tree to start creating the next building.

Therefore, all site-specific information such as location 
and orientation can be assigned to the model only when 
the site level is selected in the navigation tree.
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Changing the orientation of the building changes the 
heating and cooling energy consumption and also the 
system sizing. You may note that heating capacity does 
not get affected by the change in orientation due to the 
fact that peak requirement of heating occurs in non- 
sunshine hours. Hence, any orientation would require the 
same amount of heating (Table 1.8). 

Exercise 1.3A

For New Delhi, run simulations for three more orientations – 45°, 
180° and 270° – and compare the results (Tables 1.9 and 1.10).

Table 1.9 Energy consumption with a change in orientation

Annual fuel breakdown data

Type
0° 
(kWh)

45° 
(kWh)

90° 
(kWh)

180° 
(kWh)

270° 
(kWh)

Room electricity
Lighting
Heating (gas)
Cooling (electricity)
DHW (electricity)

Table 1.8 Heating and cooling equipment capacity with 
change in orientation

Type Orientation 0° (kW) Orientation 90° (kW)

Cooling 99.64 105.49
Heating 43.56 43.56

Table 1.7 Annual energy consumption with a change in 
orientation

Type Orientation 0° (kWh) Orientation 90° (kWh)

Room electricity 33,169.41 33,169.41
Lighting 47,936.98 47,936.98
Heating (gas) 1,502.32 1,644.22
Cooling 
(electricity)

101,945.7 103,836.7

DHW (electricity) 3,001.28 3,001.28



39Chapter One Get tinG Started with enerGy SimulatiOn

Compare the energy consumption for 0° and 180°; what do you 
observe?

It can be seen that the results for 0° and 180° are the same, and 
those of 90° and 270° are the same. This is due to symmetry in 
the shape and window distribution of the building due to which 
solar exposure for these two cases becomes similar.

A comparison of the energy consumption for 0° and 90° shows 
a difference in the cooling capacity as well as energy consump-
tion due to the change in solar exposure.

Exercise 1.3B

Change the weather location of the model with New York and 
Singapore and enter the values in Tables 1.11 and 1.12. 

Table 1.10 Heating and cooling equipment capacity with a 
change in orientation

Type 0° 45° 90° 180° 270°

Heating capacity (kW)
Cooling capacity (kW)

Table 1.11 Energy consumption with a change in location

Annual fuel breakdown data

Type New York (kWh) Singapore (kWh)

Room electricity
Lighting
Heating (gas)
Cooling
DHW (electricity)

Table 1.12 Heating and cooling equipment capacity with a 
change in location

Type New York (kW) Singapore (kW)

Heating
Cooling
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Observe and write why energy consumption and system sizing 
changed?

It can be seen that the extent of variation is significantly less 
for orientation as compared to that of the change in location.

The change in energy consumption due to orientation may be 
more pronounced in buildings having a higher aspect ratio (the 
ratio of longer and shorter sides) due to the change in solar 
exposure of the building that influences heat gain.

The change in energy consumption with location is largely due 
to the change in harshness of climatic conditions. This can be 
proportional to the cooling degree days (CDDs) for cooling 
energy consumption and heating degree days (HDDs) for heat-
ing energy consumption.

Values of CDDs and HDDs can be found in weather files, 
design data books and references such as ASHRAE.

HDDs and CDDs are a common measure used to inter-
pret the heating and cooling needs of a location. Degree 
days are the summation of the product of the difference 
in temperature (ΔT) between the average outdoor and 
the hypothetical average indoor temperature and the 
number of days the outdoor temperature above or below 
the hypothetical average indoor temperature.

The degree days are calculated in reference to a baseline 
line temperature that is commonly 18°C. Temperatures 
beyond 18°C need to be cooled and temperatures below 
18°C need to be heated.

Example: To calculate CDDs for two consecutive days.

Baseline temperature = 18°C
Daily average outdoor DBT on Day 1 = 20°C
Daily average outdoor DBT on Day 2 = 17°C
CDD on Day 1 = 20 – 18 = 2
CDD on Day 2 = 17 – 18 = −1
Total CDD = 2

The unit of measurement for CDD or HDD is degree 
days.
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TUTORIAL 1.4  Evaluating the impact of opaque 
envelope components

GOAL

To understand the impact of thermal properties for opaque 
envelope components (the external wall and roof) on the 
HVAC system sizing and energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing the wall construction in a building from the 
library of DesignBuilder

• Changing the roof construction in a building from the 
library of DesignBuilder

PROBLEM STATEMENT

For the Courtyard with VAV Example, change the exter-
nal wall from ‘Best practice wall, Medium weight’ to 
‘Brickwork single leaf construction dense plaster’ and 
record its impact on the building energy performance for 
the London weather file.

SOLUTION

Step 1: Open the Courtyard with VAV Example model 
from the template.
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Step 2: Select the Construction tab.

DesignBuilder uses the tree structure for data organiza-
tion. The ‘Template’ is the root and all the other fields are 
the branches. DesignBuilder Templates are databases of 
typical generic data.

Therefore, when editing the template at the root level, it 
changes at all branches, but if changes are made at the 
branch level, root and other branches will not change.

Objects such as external walls in the construction tem-
plate can also be edited individually without changing 
the complete root template. However, in that case, it is 
to be noted that this particular object will be decoupled 
from the root. This means that changing the roof object 
does not impact the value of this object.
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Step 3: Make sure that Best practice Wall, Medium 
weight is selected as External walls.

Step 4: Select the Simulation tab. The Edit Calculation 
Options screen appears. Click the Annual simulation link 
to set annual simulation period.
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Step 5: Record the energy simulation results.

results.

In the next steps, you are going to change the external wall 
construction.

Step 6: Click Edit. The Construction Template screen 
appears.

Step 7: Click External walls under the Construction 
section. Three dots (…) appear. Click the three dots. The 
Select the construction screen appears.
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Step 8: Select Brickwork single leaf construction 
dense plaster.

Step 9: Select the Simulation tab and perform annual 
energy simulation. View the energy simulation results in 
Tables 1.13 and 1.14 and compare. 

It can be observed that changing the wall impacts the 
equipment sizing and energy consumption.

Table 1.13 Energy consumption with a change in the external 
wall construction

Annual fuel breakdown data

Type

Best practice 
wall, medium 
weight (kWh)

Brickwork single 
leaf construction 
dense plaster (kWh)

Room electricity 24,963.73 24,963.73
Lighting 27,058.50 27,058.50
System fans 26,415.89 27,748.42
System pumps 60.09 67.75
Heating (gas) 35,640.30 78,542.51
Cooling (electricity) 52,979.69 53,300.88
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Exercise 1.4

Open the model prepared in Tutorial 1.2. Assign flat roof con-
struction as shown in Tables 1.15 and 1.16. Simulate and com-
pare the results for London.

Table 1.14 Heating and cooling equipment capacity (kW) with 
a change in the external wall construction

Type
Best practice wall, 
medium weight

Brickwork single leaf 
construction dense plaster

Cooling 73.77 76.55
Heating 56.04 92.32

Table 1.15 Energy consumption with a change in roof construction

Annual fuel breakdown data

Type

Roof, ins entirely above 
deck, R-24 (4.2), U-0.040 
(0.227) (kWh)

Uninsulated flat 
roof, medium 
weight (kWh)

Room electricity
Lighting
System fans
System pumps
Heating (electricity)
Heating (gas)
Cooling

Table 1.16 Heating and cooling sizing with a change in roof 
construction

Heating and cooling sizing (kW)

Type
Roof, ins entirely above deck, 
R-24 (4.2), U-0.040 (0.227)

Uninsulated flat 
roof, medium weight

Heating
Cooling
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You can follow similar steps as you have performed for the 
external wall. 

TUTORIAL 1.5  Evaluating the impact of WWR 
and glass type

GOAL

To evaluate the impact of glazing area and glazing proper-
ties on the energy performance of a building.

WHAT YOU ARE GOING TO LEARN?

• Creating zones in a building

• Changing WWR

• Changing glazing type

PROBLEM STATEMENT

Create a 60 m × 40 m five-zone, single-story building 
model for London. Take WWR of 30% and 80% and evalu-
ate the building energy performance. Compare cooling 
and heating equipment sizing of north and south zones. 

In the field of building energy simulations, glazing area is 
most commonly quantified in terms of WWR. WWR is 
the ratio of the total glazing area to the total external wall 
area in conditioned zones. 
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Similarly, compare sizing in east and west zones. Evaluate 
the impact of glazing by changing the single pane clear 
glazing (Sgl Clr 3 mm) to high-performance low SHGC 
dual pane glazing (Dbl Blue 6 mm/13 mm Air). 

Step 1: Open a new project and draw a building with 
60 m × 40 m.

Data structure hierarchy in DesignBuilder:

Site→Building→Floors/Levels→Zones/Rooms→ Opaque 
Components→Transparent→Components

Assigning a template to the upper level branch will result 
in the same template for all the sub-branches. For example, 
if a construction template named ‘Framed Construction’ 
is assigned to the building, all floors and zones will have 
the same template – ‘Framed Construction’.

When a particular sub-branch is edited, it is separated 
from the main branch resulting in a need for a separate 
edit from the main branch.

(Continued)
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Step 2: Click Block 1 in navigation tree. The display 
changes to Zone 1.

Step 3: Click the draw construction line button to mark 
lines on the zone. You need to draw an internal partition 
of 10 m offset.

For example, if a particular zone (such as zone 1) of the 
first floor of the building is selected and the construc-
tion template is changed from ‘Framed Construction’ 
to ‘Mass Construction’, and later the whole building is 
selected and the construction template is changed from 
‘Framed Construction’ to ‘Steel Construction’, construc-
tion template of  zone 1 still retains ‘Mass Construction’.

Similar to other drafting programs, DesignBuilder pro-
vides some important drafting options such as snap 
points, gridlines and direction snap. Make sure to select 
the relevant options while creating the custom geometry.
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Step 4: Place the pointer near the top-left corner. The 
pointer snaps to the corner (green square appears at the 
centre of the cross hair). Left click once the pointer has 
snapped, and then move the mouse in the right direction 
over the north wall of the building and type 10. It draws 
a construction line of 10 m from the top-left corner on 
the north wall.

Zone 1

Generic office area

9 90 m 50 10 m

Step 5: Click the right end of the construction line. Now 
move the mouse vertically down parallel to the west wall 
of the building with an offset of 10 m (as achieved in the 
previous step) and snap to the south wall (this time cross 
hair will change to the red square because it will be edge 
snapping) and click.
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Zone 1

Generic office area

Step 6: Continue drawing all construction lines to mark 
core and perimeter zones.

Zone 1

Generic office area

Step 7: Click the Draw partition button. The screen 
appears with a cursor to draw the internal partitions.
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Step 8: Trace the construction line to draw a perimeter 
zone on the north.

Zone 1

Generic office area

Start End

Step 9: Repeat Step 8 to draw other three zones. This 
step results in a total of five zones, four perimeters and 
one core as shown below with Axonometric View. (Note: 
No need to redraw the partition drawn in the previous 
steps.)
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Step 10: Select and rename each zone based on its orien-
tation. (For renaming you need to single click the zone 
name and wait for about 1 second, and then click again. 
A text box appears to enter a new name.)

Step 11: Click Building 1 in the navigation tree. Now 
you are going to set WWR for the whole building.

Perimeter and Core zoning is common in building energy 
simulations, especially when the internal layout of the build-
ing that is being modelled is not designed. The Perimeter 
and Core zoning is also practiced while modelling large 
open floor plans.
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Step 12: Select the Openings tab. The Glazing Template 
screen appears.

Step 13: Make sure that window to wall percentage is 30.

Step 14: Select the Visualise tab. Use the orbit tool for 
3D visuals.

Step 15: Select the Heating design tab.
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Step 16: Ensure Air temperature is selected in the 
Temperature control drop-down list. Click OK.

Step 17: Select the Summary tab. The results are 
 displayed in a grid view. For each zone, the heating 
capacity is shown in the table.

Step 18: Select the Cooling design tab. Ensure Air tem-
perature is selected as temperature control. Click OK.

Air temperature control means controlling the mean air 
temperature of the zone to the assigned setpoint tempera-
tures. Other control types mainly include operative tem-
perature and adjusting zone radiant temperature control 
fraction. These control types are mainly used in advanced 
research and comfort analysis studies.
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Step 19: Select the Summary tab to view the cooling 
system sizing results of each zone (Table 1.17). 

It can be seen that the peak cooling for the east zone is at 
10:00 and for the west zone at 16:00. Further, note that 
the cooling capacity for the west zone is more than the 
east zone. Also, the design capacity for the south zone 
is more than the north zone. This is because London is 
located at 51.5° north latitude, resulting in more solar 
radiation on the south façade.

Step 20: Run energy simulation and record the results for 
fuel breakdown. Save the model to use in forthcoming 
tutorials.

Step 21: Repeat previous steps and set WWR to 80.

Step 22: Select the Visualise tab. Use the orbit tool for 
3D visuals.
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Step 23: Record the heating and cooling design data and 
fuel breakdown (Tables 1.18 and 1.20). 

Now compare the results for each zone to gain a bet-
ter understanding of the impact of WWR on sizing. The 
comparison is shown in Table 1.19. 

Also compare the energy consumption of the two models 
(Table 1.20). 

In the tutorial so far, you have learned to change WWR 
and its impact on sizing and energy consumption. Now 
you will see the impact of glazing by changing from 
a single pane clear glazing (‘Sgl Clr 3mm’) to a dual 
pane low SHGC high-performance glazing (‘Dbl Blue 
6mm/13mm Air’) with 30% WWR. Before going to the 
next step, make sure that the WWR is 30% and you are 
at the building level in the navigation tree.
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Step 24: Select the Openings tab and select the Sgl Clr 
3mm from the library and run the annual simulation.

Step 25: Now select the Dbl Blue 6mm/13mm Air from 
the library and run the annual simulation.

When you compare the results by changing the glazing 
from single glazing to double glazing, notice that there is 
a change in the consumption of electricity for cooling and 
gas for heating (Table 1.21). 

Table 1.19 Heating and cooling sizing for 30% and 80% WWR

Heating sizing (kW) Cooling sizing (kW)

WWR 30% WWR 80% WWR 30% WWR 80%

North 43.37 48.36 35.92 42.65
South 43.32 48.21 45.37 70.14
East 26.82 29.44 26.18 49.01
West 26.82 29.44 31.97 56.34
Core 52.6 66.41 53.95 56.21

Table 1.20 Energy consumption with 30% and 80% WWR

Annual fuel breakdown data

Type WWR 30% (kWh) WWR 80% (kWh)

Room electricity 99,994 99,993
Lighting 1,44,513 1,44,512
Heating 90,292 91,614
Cooling 36,454 63,526
DHW 9,048 9,048
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Exercise 1.5

Repeat the above tutorial for Sydney, Australia.

 a. Observe the effect when WWR is changed from 30% to 
80% (Tables 1.22 and 1.23). 

Table 1.21 Annual energy consumption with a change in glass 
type

Annual fuel breakdown data

Type
Single glazing (Sgl 
Clr 3mm) kWh

Double glazing (Dbl Blue 
6mm/13mm Air) kWh

Room electricity 99,994 99,994
Lighting 1,44,513 1,44,513
Heating (gas) 1,10,841 1,00,895
Cooling 35,809 30,798
DHW 9,048 9,048

Table 1.22 Energy consumption with 30% and 80% WWR

Annual fuel breakdown data

Type WWR (30%) (kWh) WWR (80%) (kWh)

Room electricity
Lighting
Heating (electricity)
Heating (gas)
Cooling (electricity)

Table 1.23 Heating and cooling sizing capacity with 30% and 
80% WWR

Heating sizing (kW) Cooling sizing (kW)

WWR 30% WWR 80% WWR 30% WWR 80%

North
South
East
West
Core
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 It can be seen that cooling sizing, and cooling energy 
consumption increases with increase in WWR. This is 
because larger glass area results in larger solar gain. 
Further, as the U-value of the window is inferior to the 
U-value of the wall, larger window results in larger heat 
gain in summers. It is interesting to note that heating 
sizing and heating energy consumption also increases 
with the increase in WWR. Though an increased solar 
heat gain through the glass tends to reduce the require-
ment of heating during daytime, the heat loss through 
the glass due to conduction offsets this effect. At any 
given time, glass of only one or two orientations would 
allow solar radiation to enter, whereas glass of other ori-
entations would lose more heat through conduction as 
compared to a façade with a smaller WWR, assuming 
that the walls are more insulated than the glass. Further, 
during off-sunshine hours, the entire glazed area results 
in more heat loss if the U-value of the glass is inferior to 
that of the wall.

 However, in subsequent chapters, it will be seen that this effect 
is combined with a reduction in lighting energy consum p -
tion if artificial light is simulated with a dimming feature.

 b. Observe the effect with the change in glass type for 30% 
WWR (Tables 1.24 and 1.25). 

Table 1.24 Energy consumption with a change in glass type

Annual fuel breakdown data

Type

Single glazing 
(Sgl Clr 3mm) 
kWh

Double glazing (Dbl 
Blue 6mm/13mm 
Air) kWh

Room electricity
Lighting
Heating (electricity)
Heating (gas)
Cooling (electricity)
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TUTORIAL 1.6  Evaluating the impact of occupancy 
density

GOAL

To evaluate the impact of occupancy density on cooling and 
heating loads, and the whole building energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing occupancy density

PROBLEM STATEMENT

Use the model created in Tutorial 1.5 (60 m × 40 m with five 
zones). Set WWR to 30%, minimum fresh air (l/s-person) to 
2.5, Mech vent per area (l/s-m2) to 0.3, and model infiltra-
tion (ac/h) to 0.20. Run simulations with occupancy den-
sity  (people/m2) set to 0.07 and 0.10. Analyse the change 
in energy consumption. Use the AZ-PHOENIX/SKY 
HARBOR, USA weather file.

SOLUTION

Step 1: Select the Activity tab, and under the Occupancy 
section, set the occupancy density (people/m2) to 0.1. 
Under the Minimum Fresh Air section, set Fresh air 
(l/s-person) to 2.5 and Mech vent per area (l/sm2) to 0.3.

Table 1.25 Heating and cooling sizing capacity with the 
change in glass type

Cooling and heating system sizing

Type
Single glazing 
(Sgl Clr 3mm) kW

Double glazing (Dbl Blue 
6mm/13mm Air) kW

Heating
Cooling
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Step 2: Select the Construction tab. Under the Airtight-
ness section, set Model Infiltration Constant rate as 
0.200 ac/h.

Step 3: Perform the annual simulation and record the 
results.

Step 4: Set the occupancy density to 0.07 people/m2. 
Perform the annual simulation and record the results 
(Table 1.26). 

Here if you observe the results, they clearly show that a 
change in occupancy density has an impact on the total 
energy consumption.

The impact of occupancy density on energy consumption 
can be explained as follows:

• An increase in occupancy density increases cool-
ing energy consumption due to the increased load 
 (addition of sensible and latent loads from the occu-
pants) in the zone air.
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• An increase in occupancy density decreases the heat-
ing energy consumption since the heat added by the 
occupants to the indoor air helps in reducing the heat-
ing loads. However, this effect is not straightforward 
since a higher occupancy would require a higher 
fresh air intake that would in turn increase heating 
energy consumption. Further, for blowing more air 
into the space, the increase in fan power is also a 
factor that cannot be neglected.

• Occupancy density has no impact on lighting or 
equipment energy consumption unless these are 
directly related to the occupancy.

Exercise 1.6

For the same tutorial, observe the effect on cooling and heating 
equipment sizing (Table 1.27). 

It can be seen from the results that change in occupancy alters 
heating and cooling sizing as well.

Two important parameters are used to show the occupancy 
of a zone: 

 1. Occupancy density and schedule: As seen in the 
tutorial, occupancy density is the maximum num-
ber of people in a zone. Schedule of occupancy 
defines when a zone is occupied or unoccupied and 
by how many people.

 2. Metabolic activity: The amount of heat given out 
by people depends on the activity they perform. For 
example, a person who is exercising gives out more 
heat as compared to a person who is sleeping.

Table 1.26 Annual energy consumption with the change in 
occupancy density

Type 0.1 people/m2 0.07 people/m2

Room electricity 99,994 99,994
Lighting 1,44,513 1,44,513
Heating (gas) 1,045 1,096
Cooling (electricity) 2,02,307 1,92,100
DHW (electricity) 9,048 9,048
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Increasing occupancy density results in additional sensible and 
latent heat into the space leading to higher cooling capacity and 
higher energy consumption.

Higher occupancy density leads to higher fresh air and supply 
air requirements. Hence, system capacity needs to be increased.

TUTORIAL 1.7 Evaluating the impact of space activity

GOAL

To understand the impact of space activity on cooling and 
heating loads, and energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing space activity

• Understanding various activity types

• Understanding the impact of activity type on sizing and 
energy consumption

PROBLEM STATEMENT

Create a 20 m × 15 m single-zone model. Set the activity 
template to Office and Restaurant and compare. Study the 
effect on sizing and energy consumption for London.

SOLUTION

Step 1: Create a 20 m × 15 m single-zone model. You can 
refer to Tutorial 1.2 to create a single-zone model.

Table 1.27 Heating and cooling sizing capacity with a change 
in occupancy density

Type 0.1 people/m2 0.07 people/m2

Cooling
Heating
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Step 2: Select the Activity tab. The Activity Template 
appears.

Step 3: Simulate the model and record the results.

Step 4: Select the Activity Template as Eating/drink-
ing area. It changes internal gains and schedules of the 
space.
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Step 5: Double click on RestPub_EatDrink_Occ 
 schedule under the Occupancy tab. The Edit 
 schedule-RestPub_EatDrink_Occ screen appears. 
(You can note the occupancy schedule for comparison 
with the other activity template as shown in Table 1.28.)

Schedules are used in DesignBuilder to define with 
respect to time the following:

• Occupancy

• Equipment, lighting HVAC operation

• Heating and cooling temperature setpoints

• Transparency of component blocks (usually 
seasonal)

Occupancy, equipment and lighting schedule are defined by 
a fraction (0–1). The maximum gain values (e.g. people/m2) 
are multiplied by the values in the schedule to obtain the 
actual value to use at each time step in the simulation.

Source: http://www.designbuilder.co.uk/helpv4.7/ 
#Schedules_-_EnergyPlus_Compact_Schedules.htm

http://www.designbuilder.co.uk/helpv4.7/#Schedules_-_EnergyPlus_Compact_Schedules.htm
http://www.designbuilder.co.uk/helpv4.7/#Schedules_-_EnergyPlus_Compact_Schedules.htm
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Table 1.28 Workday schedules for a generic office and eating/
drinking area

Generic office area 
Office_OpenOff_Occ

Eating/drinking area 
RestPub_EatDrink_Occ

Schedule: Compact,
Office_OpenOff_Occ,
Fraction,
Through: 31 Dec,
For: Weekdays 
SummerDesignDay,
Until: 07:00, 0,
Until: 08:00, 0.25,
Until: 09:00, 0.5,
Until: 12:00, 1,
Until: 14:00, 0.75,
Until: 17:00, 1,
Until: 18:00, 0.5,
Until: 19:00, 0.25,
Until: 24:00, 0,
For: Weekends,
Until: 24:00, 0,
For: Holidays,
Until: 24:00, 0,
For: WinterDesignDay 
AllOtherDays,
Until: 24:00, 0;

Schedule: Compact,
RestPub_FoodPrep_Occ,
Fraction,
Through: 31 Dec,
For: Weekdays SummerDesignDay,
Until: 06:00, 0,
Until: 07:00, 0.25,
Until: 08:00, 0.75,
Until: 14:00, 1,
Until: 15:00, 0.75,
Until: 17:00, 0.25,
Until: 18:00, 0.75,
Until: 22:00, 1,
Until: 23:00, 0.75,
Until: 24:00, 0.25,
For: Weekends,
Until: 06:00, 0,
Until: 07:00, 0.25,
Until: 08:00, 0.75,
Until: 14:00, 1,
Until: 15:00, 0.75,
Until: 17:00, 0.25,
Until: 18:00, 0.75,
Until: 22:00, 1,
Until: 23:00, 0.75,
Until: 24:00, 0.25,
For: Holidays,
Until: 06:00, 0,
Until: 07:00, 0.25,
Until: 08:00, 0.75,
Until: 14:00, 1,
Until: 15:00, 0.75,
Until: 17:00, 0.25,
Until: 18:00, 0.75,
Until: 22:00, 1,
Until: 23:00, 0.75,
Until: 24:00, 0.25,
For: WinterDesignDay AllOtherDays,
Until: 24:00, 0;
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Step 6: Click Cancel. The screen closes.

Step 7: Select the Simulation tab to get energy consump-
tion results.

Compare both cases (Table 1.29). 

The results show the impact of Activity type on energy 
consumption.

From the model, you can find out the interior load param-
eters (Table 1.30). You can get this data from the Activity 
and Lighting tabs. You can co-relate the change in energy 
consumption with the change in interior loads.
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Table 1.29 Annual energy consumption with a change in space 
activity

Type
Generic office 
area (kWh)

Eating/drinking 
area (kWh)

Room electricity 12,131.16 32,225.33
Lighting 17,532.15 12,259.07
Heating (gas) 12,729.33 24,047.98
Cooling (electricity) 6,529.12 8,596.75
DHW (electricity) 1,097.67 43,672.32

Table 1.30 Internal load data for generic office and eating/
drinking area

Interior load Unit
Generic 
office area

Eating/
drinking area

Occupancy People/m2 0.111 0.2
Target illuminance Lux 400 150
Interior light W/m2 

per - 100 lux
5 5

Equipment W/m2 11.77 18.88
DHW l/s-day 0.2 5.69
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Exercise 1.7

Compare the cooling and heating energy consumption for a 
generic office area and classroom (Table 1.31). 

From the model, you can find out the change in the internal load 
parameter (Table 1.32).

Activity type: Classroom can be found under ‘Universities 
and college’ category.

Table 1.31 Annual energy consumption for a generic office and 
eating/drinking area

Type
Generic office 
area (kWh)

Class room area 
(kWh)

Room electricity
Lighting
Heating (Gas)
Cooling (Electricity)
DHW (Electricity)

Table 1.32 Internal load for a generic office and eating/
drinking area

Interior load Unit
Generic 
office area

Classroom 
area

Occupancy People/m2

Target illuminance lux
Interior light W/m2 100 lux
Equipment W/m2

DHW l/s-day
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Compare office and class room schedules in Table 1.33. 

Table 1.33 Workday schedules for a generic office and class 
room area

Generic office area Office_OpenOff_Occ Classroom area
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TUTORIAL 1.8  Evaluating the impact of lighting 
and equipment power

GOAL

To understand the impact of lighting and equipment power 
density on HVAC system sizing and energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing lighting power density (LPD)

• Changing equipment power density (EPD)

PROBLEM STATEMENT

Compare the energy consumption when you set the LPD 
as 13.13 and as 10.0 W/m2. Use the Courtyard with VAV 
Example template for London.

SOLUTION

Step 1: Select the Lighting tab, and under the General 
Lighting section, set the LPD shown as Lighting energy 
(W/m2) to 13.13.

Lighting power density represents the load of any light-
ing equipment in any defined area or the watts per square 
meter of the lighting equipment. It can be obtained by 
dividing the total lighting load by the area.

Tip: Does your Lighting energy have units as W/m2 - 
100 lux rather than W/m2?

If yes, change this to W/m2 in the following way:

Go to: Edit→Model Options Data→Data→Gain 
Data→Lighting Gains Units, and change the lighting 
gain units to W/m2.
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Step 2: Click Simulate and click the Annual simulation 
link to perform annual simulation.

Step 3: Repeat the steps to set the LPD to 10.00. Perform 
annual energy simulation. Compare the end use energy 
consumption for both cases (Table 1.34).

From the end use energy consumption shown in Table 1.34, 
it is clear that a reduction in LPD decreases the lighting 
energy consumption. Also, note the decrease in cooling and 
fans and pump energy consumption.

Table 1.34 Annual fuel breakdown with a change in LPD

Type
LPD – 13.13 W/m2 
(kWh)

LPD – 10.0 W/m2 
(kWh)

Room electricity 24,963.73 24,963.73
Lighting 23,685.21 18,039.00
System fans 25,854.88 24,916.21
System pumps 57.99 54.61
Heating (gas) 36,880.63 39,053.90
Cooling (electricity) 51,073.34 48,160.19
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Exercise 1.8

Set the equipment power density to 20 and 10 W/m2 and study the 
impact on building energy consumption and sizing (Tables 1.35 
and 1.36). 

It can be clearly seen from the results that reducing the LPD and 
EPD not only results in the reduction of energy consumption 
for lighting, but it also helps reduce the cooling energy. This is 
because the energy consumed in lighting or operating equipment 
such as computers finally gets converted into heat and usually gets 
added into the space. This additional heat increases the energy 
consumption of the fans and pumps and also increases the system 
sizing. In cases of heating energy consumption, the reverse effect 
is observed since lighting and equipment add additional heat to 
the space, thereby reducing energy requirement for heating.

Table 1.35 Energy consumption with a change in equipment 
power density

Annual fuel breakdown data

Type
EPD (20 W/m2) 
(kWh)

EPD (10 W/m2) 
(kWh)

Room electricity
Lighting
System fans
System pumps
Heating (electricity)
Heating (gas)
Cooling (electricity)

Table 1.36 Heating and cooling sizing capacity with a change 
in equipment power density

Type EPD (20 W/m2) (kW) EPD (10 W/m2) (kW)

Heating
Cooling
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TUTORIAL 1.9  Evaluating the impact of daylight 
controls

GOAL

To evaluate the impact of daylight controls on energy 
consumption. 

WHAT ARE YOU GOING TO LEARN?

• Specifying daylight controls in a building model

• Evaluating the impact of daylight controls on energy 
consumption

PROBLEM STATEMENT

Create a 60 m × 40 m model with a core and four perimeter 
zones. Consider a perimeter depth of 5 m. (Refer Tutorial 
1.5 for steps to create the model.) Set WWR to 60% and 
use ‘Sgl Grey 3mm’ glass (VLT ~ 60%). Perform annual 
energy simulation without daylight sensors, then install 
daylight control in the north zone. Compare the lighting 
energy consumption with and without daylight control for 
London Gatwick location, United Kingdom. 

Tip: For single pane glass with 60% visible light transmit-
tance, select ‘Sgl Grey 3mm’ with a light transmission value 
of 0.611 under the Single category of the glazing library.
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SOLUTION

Step 1: Create a five-zone core and perimeter model of 
size 60 m × 40 m. Set WWR to 60% and select Sgl Grey 
3mm glass.

Step 2: Select the Simulation tab. The Edit Calculation 
Options screen appears. Select the Hourly checkbox 
under Output Intervals for Reporting and then click 
OK. After simulation, hourly results appear under the 
Analysis tab.



80 BUILDING ENERGY SIMULATION

Step 3: Click the Export data icon to export the hourly 
energy consumption in the spreadsheet. (Ensure that 
Fuel breakdown, Hourly interval and Grid options are 
selected.)

Step 4: Select File from the Export to drop-down list. 
Select CSV spreadsheet from the Format drop-down 
list. Click OK. The Export CSV file screen appears.
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Step 5: Enter the File name Without daylight sensor 
and save the file on Desktop.

Step 6: Select Annual from the Interval drop-down list.

Record the simulation results.

In the next step, you are going to install the daylight sen-
sor in the north zone.

Step 7: Select the Edit tab. Click the North zone in the 
navigation tree. It shows the north zone in the Layout 
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tab. Select the Lighting tab. The Lighting properties are 
displayed.

Step 8: Expand the Lighting control section. Select the 
On check box. Select Linear from the Control type 
drop-down list.

Different types of lighting control options that exist in 
DesignBuilder are as follows:  

 1. Linear

 2. Linear/off

 3. Stepped

Linear control, also called as continuous control, reduces the 
power input of the luminaire continuously, thereby decreas-
ing the output light from the lamp till it reaches the mini-
mum input and output fraction provided as a user input. this 
is possible with continuously dimmable fixture and lamps. 
the decrease in the input power (proportionally the lighting 
output) depends on the daylight illuminance requirement in 
the space. as the daylight illuminance increases, the input 
power reduces till it reaches the minimum input power and 
light output fraction and remains at the minimum specified 
ratio with a further increase in daylight illuminance.
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Step 9: Select the Layout tab. The daylight sensor is 
displayed.

Step 10: Perform the simulation and record the annual 
and hourly results of the lighting energy consumption.

Step 11: Compare the results with and without lighting 
controls (Table 1.37). 

Step 12: Draw the graph for hourly lighting energy 
consumption for 1 January with and without a daylight 
sensor by using the data exported using a spreadsheet 
program.
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Table 1.37 Annual energy consumption with or without 
lighting control for the north zone

Type
Without lighting 
controls (kWh)

With lighting 
controls (kWh)

Room electricity 99,892 99,892
Lighting 1,44,366 1,32,533
Heating (gas) 1,36,863 1,42,500
Cooling (electricity) 43,744 41,748
DHW (electricity) 9,039 9,039
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 The above figure shows the hourly lighting energy 
consumption for 1 January. It can be observed that 
there is a reduction in the energy consumption with 
the use of daylight sensor and dimmable luminaire.

 The effect of daylight control is similar to that of 
reducing LPD as discussed in the previous exercise.

 The daylight control reduces the artificial lighting 
load whenever daylight is available in the space. The 
lighting loads are reduced to the extent that the com-
bined lux levels of artificial light and daylight equals 
the setpoint lux level.

 This reduction in LPD reduces the lighting energy 
consumption. For example, east and south zones 
would have different extent and timing of availabil-
ity of daylight, and hence these would have different 
energy savings too.

Exercise 1.9

Add daylight control in the south zone of the model and study 
the effect on the energy consumption (Table 1.38). 

It can be observed that the deployment of lighting control 
increases the heating energy consumption and decreases the 
cooling energy consumption.

Table 1.38 Annual energy consumption with or without 
lighting control for the south zone

Type
Without daylight 
controls (kWh)

With daylight 
control (kWh)

Room electricity
Lighting
System fans
System pumps
Heating (electricity)
Heating (gas)
Cooling (electricity)



85Chapter One Get tinG Started with enerGy SimulatiOn

TUTORIAL 1.10  Evaluating the impact of setpoint 
temperature

GOAL

To evaluate the impact of setpoint temperature on sizing 
and energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing the setpoint for heating

• Changing the setpoint for cooling

PROBLEM STATEMENT

Create a 60 m × 40 m model with a core and four perim-
eter zones. Consider a perimeter depth of 5 m. (Refer to 
Tutorial 1.5 for steps to create the model.) Set the heating 
setpoint to 20°C and 22°C. Simulate the model with the 
PARIS-AEROPORT CHAR weather file. Analyse the 
effect of setpoint on the energy consumption and HVAC sys-
tem sizing.

SOLUTION

Step 1: Create a five-zone core and perimeter model of 
size 60 m × 40 m.

Step 2: Select the Activity tab and go to Heating 
Setpoint Temperatures. Enter 20.0 in Heating (°C) box.

Step 3: Perform the annual simulation and record all end 
use energy consumption.

Step 4: Repeat steps to set the heating temperature at 
22°C. Simulate the model.
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Step 5: Compare result for both cases (Tables 1.39 
and 1.40). 

You can observe that increasing the heating setpoints 
increases the heating energy consumption and heating 
sizing (Table 1.40). 

Exercise 1.10

Repeat the tutorial for the change in the cooling setpoint from 
24°C to 25°C. Compare the results for cooling sizing and energy 
consumption. Set the weather location as Brisbane, Australia 
(Tables 1.41 and 1.42). 

Table 1.39 Energy consumption with a change in heating 
setpoint temperature

Annual fuel breakdown data

Heating temperature 
20°C (kWh)

Heating temperature 
22°C (kWh)

Room electricity 99,895 99,895
Lighting 1,44,369 1,44,369
Heating (gas) 61,076 92,223
Cooling (electricity) 51,646 52,776
DHW (electricity) 9,039 9,039

Table 1.40 Heating sizing capacity with a change in heating 
setpoint temperature

Heating sizing

Type
With heating setpoint 
temperature 20°C (kW)

With heating setpoint 
temperature 22°C (kW)

Heating 161.45 175.05
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The following can be observed: 

• Increasing the heating setpoint results in an increase in 
energy consumption since more heat is to be added to 
the space for keeping a higher temperature. This also 
results in a higher system capacity since the rate of heat 
addition at an elevated temperature is to be matched 
with the higher rate of heat loss. In case of gas heaters 
using hot water panels, the energy consumption of the 
pump also increases with the increase in the setpoint.

• Similarly, a lower cooling setpoint demands the 
removal of more heat, thereby causing more energy 
consumption. This also results in a higher capacity of 
the cooling equipment and more pump and fan energy 
consumption.

Table 1.41 Energy consumption with a change in cooling 
setpoint temperature

Annual fuel breakdown data

Type
With cooling 
setpoint 24°C (kWh)

With cooling 
setpoint 25°C (kWh)

Room electricity
Lighting
System fans
System pumps
Heating (electricity)
Heating (gas)
Cooling (electricity)

Table 1.42 Cooling sizing capacity with change in cooling 
setpoint temperature

Type
With cooling setpoint 
24°C (kW)

With cooling setpoint 
25°C (kW)

Cooling
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TUTORIAL 1.11  Evaluating the impact of fresh air 
supply

GOAL

To evaluate the impact of the fresh air supply quantity on 
energy consumption. 

WHAT ARE YOU GOING TO LEARN?

• Changing the fresh air flow rate

PROBLEM STATEMENT

Create a single-zone 20 m × 15 m model. Set the fresh air 
supply rate (l/s-person) to 5 and 7.5 and compare. Study 
the effect on energy consumption for the AZ-PHOENIX 
DEER VALLEY, USA location.

SOLUTION

Step 1: Create a single-zone 20 m × 15 m model. Select 
the Activity tab.
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Step 2: Expand the Minimum Fresh Air section and 
enter 5 in the Fresh air (l/s-person). 

Step 3: Simulate the model and record the results.

Compare the end use energy consumption results for the 
fresh air supply of 5 and 7.5 l/s-person (Table 1.43). 

It can be seen from the above table that with the increase 
in the fresh air rate, there is an increase in the  cooling/
heating energy consumption.

Table 1.43 Energy consumption with a change in fresh air 
supply quantity

Annual fuel breakdown data

Type
Fresh air supply of 5 
l/s-person (kWh)

Fresh air supply of 
7.5 l/s-person (kWh)

Room electricity 12,131 12,131
Lighting 17,532 17,532
Heating (gas) 800 812
Cooling (electricity) 31,124 31,442
DHW (electricity) 1,098 1,098
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Exercise 1.11

Compare cooling and heating energy consumption for the 
change of fresh air supply volume from 5 to 9 l/s-person 
(Table 1.44). 

An increase in the fresh air supply rate increases the energy 
consumption due to several factors: 

• More fresh air brings in more sensible as well as latent 
load from outside. This in turn increases the load on the 
equipment, which increases the cooling/heating energy 
consumption.

• The energy consumption of the fan is proportional to 
the volumetric flow rate. With the increase in the flow 
rate because of the additional energy required to blow 
more supply air (for heating/cooling), the fan energy 
consumption increases.

• More heating/cooling load and higher air flow rate result 
in the requirement of more water flow as heat adding/
removal medium for a fixed change in temperature across 
the air handling unit since more heat is to be taken away 
per unit time. This requirement of a higher flow rate 
increases the pump rating and results in a higher energy 
consumption by the pump.

Table 1.44 Heating and cooling energy consumption by 
changing the fresh air supply quantity

Cooling energy consumption 
electricity (kWh)

Heating energy 
consumption gas (kWh)

5 l/s-person 9 l/s-person 5 l/s-person 9 l/s-person

Jan
Feb
Mar
Apr
May
Jun
Jul
Aug
Sept
Oct
Nov
Dec
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CHAPTER TWO

Geometry of Buildings

In this chapter, we discuss the geometrical aspects, such as 
thermal zoning, aspect ratio, floor multiplier, and surface 
adjacency.

Usually buildings have several rooms; however, from model-
ling perspective, there  may not be a requirement to model each 
room separately. If adjacent spaces have the same specifica-
tions, such as schedule, occupancy, and cooling and heating 
temperature setpoint, you can combine these spaces and model 
it as a single zone. By doing this, the complexity of the model 
and its simulation run time can be reduced without affecting the 
energy simulation results. Similarly, in cases of multi-storied 
buildings, with typical floors, the model can be simplified by 
modelling only three floors: ground, mid and top.

One of the important parameters that need to be considered 
while designing the building is aspect ratio, which is the ratio 
of the length to width of a building. The aspect ratio affects the 
envelope area. Increase in the envelope area leads to a higher 
heat gain/loss from the building. However, higher aspect ratio 
helps in better distribution of daylight and more access to win-
dows for the occupants.

The impact of these aspects on building performance is 
explained through four tutorials in this chapter.
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TUTORIAL 2.1 Defining thermal zoning for a building

GOAL

To evaluate the effect of architectural and thermal zoning on 
the end use energy consumption and simulation run time.

WHAT ARE YOU GOING TO LEARN?

• Defining thermal zoning

• Adding internal mass

PROBLEM STATEMENT

Create a multi-zone (15 zones as shown in the following 
 figure) building with a rectangular footprint of 100 m × 
50 m. Find its energy performance and simulation run time. 
Create another model by combining similar spaces into 
thermal zones and compare the energy performance and 
run time duration with the previous model.

Use the FRANKFURT MAIN ARPT, Germany weather 
file.

10

10

20

50

100

All dimensions are in metre.

SOLUTION

Step 1: Open a New Project and create a 100 m × 50 m 
block with internal partitions. (Use construction lines to 
facilitate easy snapping while creating the partitions.)
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Step 2: Select the Construction tab and select Outer  volume 
in the Zone floor area calculation method drop-down list.

Zone floor area calculation method

This setting dictates whether internal or external 
 measurements (include external wall thickness inside the 
zone boundary or not) are used to calculate the zone floor 
area. This is required to calculate per m2 values such as 
occupancy and other internal gains as well as floor area 
values for general reporting.

Inner – where the zone volume used in thermal calcula-
tions is derived from the zone inner geometry.

Outer – where the zone volume used in thermal calcula-
tions is derived from the zone outer geometry.

http://www.designbuilder.co.uk/helpv4.7/Content/
GeometryAreasAndVolumes.htm

http://www.designbuilder.co.uk/helpv4.7/Content/GeometryAreasAndVolumes.htm
http://www.designbuilder.co.uk/helpv4.7/Content/GeometryAreasAndVolumes.htm
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Step 3: Perform hourly simulation for the whole year and 
record the energy consumption and the run time.

Step 4: Repeat step 1 while combining zones for spaces 
with similar activity, schedule and setpoints. In this 
example, let us assume that the north zones (zones 7, 8, 9 

Recording a run time:

After the simulation is complete, type the following path 
to open the eplusout.err file. You can use any text editor to 
open this file.

C:\Users\User \ AppData\ Loca l \ Design Bui lder \
EnergyPlus\eplusout.err

The actual folder name on a computer depends on the 
language setting and your Windows user name. In the 
path given above, the Windows user name is ‘User’.

Alternatively, you can open the EnergyPlus folder from 
the DesignBuilder file option.

At the end of the file, you can find Elapsed Time.

You need to record the elapsed time.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/_DesignBuilder_files_

location_and_extensions.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
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and 10), as shown in the following figure, are similar and 
can be combined into a single thermal zone. Similarly, 
the south zones (12, 13, 14 and 15) can be combined 
into a single thermal zone. Do note that zone numbers 
in your model might differ as zones are numbered in the 
sequence they are created.

You can select the internal partition and delete the inter-
nal partition by pressing the delete key. (Please ensure 
that you are at the block level.)

Generic office area

Zone 7Zone 6 Zone 2

Zone 3Zone 5

Zone 4

Zone 8 Zone 9 Zone 10

Zone 15 Zone 1Zone 14

Zone 11

Zone 13 Zone 12

Generic office area

Zone 6 Zone 2

Zone 3Zone 5

Zone 4

Zone 8

Zone 9 Zone 1

Zone 7
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Step 5: Perform annual simulation and record the energy 
consumption and the run time.

Compare the energy simulation results and the simula-
tion run time (Tables 2.1 and 2.2).

A ‘thermal zone’, usually termed simply ‘zone’, is a  virtual 
or real segment of a building that has a  homogeneous, 
enclosed volume of air. In a simple approach, each physi-
cal space can be treated as one zone. However, to  simplify 
the modeller’s work, and to reduce the calculation time, 
areas having similar thermal and usage conditions such 
as occupancy, setpoint, and solar exposure, and those that 
are serviced by common mechanical equipment, can be 
clubbed to create one zone. Temperatures, supply units, 
and layout.

Table 2.1 Annual fuel breakdown energy with architectural 
zoning and lumped thermal zones

Type
With architectural 
zoning (kWh)

With lumped thermal 
zones (kWh)

Room electricity 216,715 216,715
Lighting 313,200 313,200
Heating (gas) 238,755 238,281
Cooling (electricity) 99,454 99,166
DHW (electricity) 19,609 19,609

Table 2.2 Simulation run time with architectural zoning and 
lumped thermal zones

With architectural 
zoning

With lumped 
thermal zones

Simulation run time 48.04 seconds 31.03 seconds
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As seen in the results, combining architectural zones to 
form thermal zones reduces the simulation run time. In 
this case, there is an approximately 37% decrease in the 
simulation run time. Note that because there is a dif-
ference in the models, there is a slight difference in the 
energy simulation results.

Exercise 2.1

Create thermal zoning for the plan shown in the  following 
 figure. Compare the simulation run time and energy consump-
tion for the models with architectural and thermal zoning 
(Tables 2.3 and 2.4).

Office

Office
50

10

10

10

100

20

25

30
15

10
Office Office

Office

Office

Office Office

All dimensions are in metre

Lobby

Office

Office

Meeting

Office

Table 2.3 Annual fuel breakdown energy with architectural 
zoning and lumped thermal zones

Type
With architectural 
zoning (kWh)

With lumped thermal 
zones (kWh)

Room electricity
Lighting
Heating (gas)
Cooling (electricity)
DHW (electricity)

Table 2.4 Simulation run time with architectural zoning and 
lumped thermal zones

With architectural 
zoning (kWh)

With lumped thermal 
zones (kWh)

Run time
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TUTORIAL 2.2  Evaluating the effect of a 
zone multiplier

GOAL

To evaluate the effect of a zone multiplier on the energy 
consumption and simulation run time.

WHAT ARE YOU GOING TO LEARN?

• Using zone multiplier

PROBLEM STATEMENT

Use the Zone Multiplier Example template file to evaluate 
the impact of a floor multiplier on the building energy con-
sumption and simulation run time. This file contains two 
buildings with and without the floor multiplier. You need 
to select one building at a time and simulate for London 
Gatwick Airport, United Kingdom.

DesignBuilder has the concept of zone multiplier. The 
zone multiplier data allow you to reduce the size of your 
model in cases where there are similar zones by specify-
ing that certain zones are repeated and so only need to be 
simulated once. A typical use is for multi-storey  buildings 
with identical (or very similar) floors. The concept of 
zone multiplier when applied at the floor level multiplies 
all the zones on the given floor, effectively working as 
floor multiplier. Hence, in a building where there are 
 several identical floors, you can model one floor and use 
a zone multiplier on that floor.

(Continued)
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SOLUTION

Step 1: Open the Zone Multiplier Example template 
from DesignBuilder templates. The layout appears with 
two buildings.

No zone multiplier
(seven zones

required)

Zone multiplier = 5

Adiabatic
component

blocks

Same building with a zone multiplier
(only three zones required)

Source: http://www.designbuilder.co.uk/
helpv4.7/#Zone_Multiplier.htm

http://www.designbuilder.co.uk/helpv4.7/#Zone_Multiplier.htm
http://www.designbuilder.co.uk/helpv4.7/#Zone_Multiplier.htm


100 BUILDING ENERGY SIMULATION

Step 2: Click the No Zone Multiplier building in the 
navigation tree. It selects the building that does not use 
a floor multiplier.

Step 3: Perform annual simulation. Record simulation 
run time. The results appear. Record the energy simula-
tion results.

Step 4: Select the Edit tab. Click the Uses Zone 
Multiplier building in the navigation tree. Expand the 
Uses Zone Multiplier.
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Step 5: Under Mid, click Zone 1.

Step 6: Select the Activity tab. Since the mid five floors 
are typical floors, the Zone multiplier for the whole 
floor is set to 5.

When using a floor multiplier, calculations are  performed 
only for one floor and multiplied by the zone multiplier. 
This helps in reducing the simulation run time.

Compare the results for the models with and without the 
zone multiplier (Table 2.5).

Table 2.5 Impact of a zone multiplier

Annual fuel breakdown data

Type
Without floor multiplier
(kWh)

With floor multiplier
(kWh)

Room electricity 29,238.68 29,238.68
Lighting 52,820.29 52,820.29
Heating (gas) 33,237.48 33,203.70
Cooling 
(electricity)

22,250.89 21,744.07

DHW (gas) 2998.37 2998.37
Simulation time 25.13 seconds 13.67 seconds
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The results show that using a zone multiplier reduces the 
simulation run time. However, it has a slight impact on 
the energy consumption.

Exercise 2.2

Create a building with a total of 20 floors. First 10 floors have 
a floor plate of dimensions 50 m × 50 m. Floors 11 to 20 have a 
floor plate of dimensions 25 m × 25 m. Each floor has a height 
of 3 m. All floors are centrally aligned. Perform annual energy 
simulation of the building with and without floor multiplier. 
Compare energy and runtime of the simulation.

TUTORIAL 2.3  Evaluating the impact 
of the aspect ratio

GOAL

To evaluate the impact of building aspect ratio on energy 
performance.

WHAT ARE YOU GOING TO LEARN?

• Modelling building with different aspect ratio but 
same floor area

PROBLEM STATEMENT

In this tutorial, you are going to analyse the impact of the 
aspect ratio of the building on the energy performance. You 
need to create models with different aspect ratios for a floor 
plate of areas 64 m2 and 625 m2. Simulate various cases as 
given below and compare their energy consumption for the 
London Gatwick weather location. Make sure that WWR 
is 30%.

 a. For a floor area of 64 m2, Table 2.6 gives the length 
and breadth values for various aspect ratios

For a rectangular building, aspect ratio is the ratio of the 
longest dimension of the building footprint to the narrow-
est dimension. An aspect ratio of 1.0 represents a square 
building footprint.
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 b. For a floor area of 625 m2, Table 2.7 gives the 
length and breadth values for various aspect 
ratios

SOLUTION

Step 1: Open a new project file.

Table 2.6 Different aspect ratios for a 64 m2 floor area

S. No.
Length 
l (m)

Breadth 
b (m)

Aspect 
ratio l/b

Floor 
area l × b 
(m2)

Façade area 
(window + 
wall) (m2)

Façade 
area/floor 
area

1  8.00 8.00 1 64 112.00 1.75
2 11.31 5.65 2 64 118.79 1.86
3 13.85 4.62 3 64 129.33 2.02
4 16.00 4.00 4 64 140.00 2.19

Table 2.7 Different aspect ratios for a 625 m2 floor area

S. No.
Length 
l (m)

Breadth 
b (m)

Aspect 
ratio l/b

Area 
l × b (m2)

Façade area 
(window + 
wall area) (m2)

Façade 
area/floor 
area

1 25.0 25.0 1 625 350.00 0.56
3 43.3 14.4 3 625 404.15 0.646
5 55.9 11.2 5 625 469.57 0.75
7 66.1 9.4 7 625 529.15 0.846
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Step 2: Create an 8 m × 8 m building (aspect ratio 1).

Step 3: Simulate the model and store the results (Table 2.8).

Table 2.8 Energy simulation results for an 8 m × 8 m model

Room 
electricity Lighting Heating (gas)

Cooling 
(electricity)

DHW 
(electricity)

Wh/m2 Wh/m2 Wh/m2 Wh/m2 Wh/m2

43,342.96 62,639.97 65,691.39 37,698.21 3921.82
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Step 4: Repeat steps 1 to 3 for aspect ratios 2, 3 and 4, 
respectively. Compare the energy simulation results for 
all cases (Table 2.9).
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Table 2.9 Energy consumption with different aspect ratios 
(without daylight sensor)

Aspect ratio 1 2 3 4

(8 m × 
8 m)

(11.3 m × 
5.7 m)

(13.9 m × 
4.6 m)

(16 m × 
4 m)

Room electricity 
(Wh/m2)

43,342.96 43,342.96 43,342.96 43,342.96

Lighting (Wh/m2) 62,639.97 62,639.97 62,639.97 62,639.97
Heating (gas) 
(Wh/m2)

65,691.39 66,469.18 69,815.29 73,499.85

Cooling 
(electricity) 
(Wh/m2)

37,698.21 38,203.12 40,965.80 43,371.99

DHW 
(electricity) 
(Wh/m2)

3,921.82 3,921.82 3,921.82 3,921.82
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Step 5: Repeat all the above steps with daylight sensor 
(Table 2.10).
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Table 2.10 Energy consumption with varying aspect ratios (with 
daylight sensor)

Aspect ratio 1 2 3 4

(8 m × 
8 m)

(11.3 m × 
5.7 m)

(13.9 m × 
4.6 m)

(16 m × 
4 m)

Room 
electricity 
(Wh/m2)

43,342.96 43,342.96 43,342.96 43,342.96

Lighting 
(Wh/m2)

15,987.71 15,997.28 15,752.72 14,627.30

Heating (gas) 
(Wh/m2)

82,736.33 83,288.69 86,451.32 90,868.41

Cooling 
(electricity) 
(Wh/m2)

26,754.61 27,236.63 29,863.74 32,160.17

DHW 
(electricity) 
(Wh/m2)

3,921.82 3,921.82 3,921.82 3,921.82
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Step 6: Repeat all the above steps for the floor area of 
625 m2 (Tables 2.11 and 2.12).

You need to draw the model with the help of plans as 
shown in the following figures with aspect ratios 1, 3, 5 
and 7.
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Table 2.12 Energy consumption for different aspect ratios (with 
daylight sensor)

Aspect ratio 1 3 5 7

(25 m × 
25 m)

(43.3 m × 
14.4 m)

(55.9 m × 
11.2 m)

(66.1 m × 
9.4 m)

Room electricity 
(Wh/m2)

43,342 43,342 43,342 43,342

Lighting (Wh/m2) 35,176 25,783 19,702 18,443
Heating (gas) 
(Wh/m2)

54,576 60,245 62,566 65,177

Cooling (electricity) 
(Wh/m2)

13,529 12,912 12,876 14,513

DHW (electricity) 
(Wh/m2)

3,921 3,921 3,921 3,921

Table 2.11 Energy consumption for different aspect ratios 
(without daylight sensor)

Aspect ratio 1 3 5 7

(25 m × 
25 m)

(43.3 m × 
14.4 m)

(55.9 m × 
11.2 m)

(66.1 m × 
9.4 m)

Room electricity 
(Wh/m2)

43,342 43,342 43,342 43,342

Lighting (Wh/m2) 62,640 62,639 62,639 62,640
Heating (gas) 
(Wh/m2)

45,401 46,695 46,654 48,641

Cooling (electricity) 
(Wh/m2)

20,772 22,038 23,289 25,238

DHW (electricity) 
(Wh/m2)

3,921 3,921 3,921 3,921
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Exercise 2.3

 a. Analyse the effect of the aspect ratio for all cases 
described in the tutorial for the 90° orientation.

 b. Repeat the tutorial for the hot and dry climate (UAE) and 
observe the energy simulation results.
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TUTORIAL 2.4  Evaluating the impact of 
adjacency of the surface

GOAL

To evaluate the impact of the ground surface on the energy 
performance.

WHAT ARE YOU GOING TO LEARN?

• Assigning surface adjacency

• Making surface adiabatic

PROBLEM STATEMENT

In this tutorial, you are going to create a 50 m × 25 m 
 single-zone model. Assign ground floor construction to a 
200 mm aerated concrete slab. Set the ground floor surface 
adjacency to Auto and as Adiabatic. Compare the effect of 
the surface adjacency on the energy consumption for QC – 
Montreal/Mirabel INT’L A, Canada.

SOLUTION

Step 1: Create a 50 m × 25 m single zone model. Expand 
Zone 1 in the navigation tree.
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Step 2: Click Ground Floor.

Step 3: Select the Construction tab.

Step 4: Under the Floors section, click Ground floor. 
Three dots (…) appear. Click the dots. The Select the 
construction screen appears.
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Step 5: Click the Add new data button to create a new 
construction.

Step 6: Go to the Layers section and make sure that 
Areated Concrete Slab is the material and the thick-
ness is 0.2000 m. Click OK.

Step 7: Click the Adjacency section. It displays the 
Adjacency property of the selected surface.

Ensure Auto is selected in the adjacency drop-down list.
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Step 8: Perform annual energy simulation. Record the 
results for the end use energy consumption.

Step 9: Repeat step 6 to select Adiabatic from the 
Adjacency drop-down list.

Step 10: Run simulation to view the results.

Compare the end use energy consumption breakdown 
(Table 2.13).

You can observe that there is a change in the cooling 
and heating energy consumption when the ground floor 
surface property is set to adiabatic.

Table 2.13 Annual fuel breakdown data for building with 
ground floor adjacency set to adjacent to ground and adiabatic

Type Adjacent to the ground (kWh) Adiabatic (kWh)

Room electricity 52,293.80 52,293.80
Lighting 75,575.88 75,575.88
Heating (gas) 159,140.60 160,616.20
Cooling (electricity) 23,653.23 26,540.71
DHW (electricity) 4,731.72 4,731.72
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Many modellers prefer to define the ground temperature 
just below the slab and exclude the earth layers from 
the model. This has the advantage of simplicity and 
clarity and the approach recommended by EnergyPlus 
developers.

Note: The default ground temperatures provided in 
DesignBuilder assume that an earth layer is included in 
the constructions adjacent to the ground. If an earth layer 
is not included, then you should increase the default site 
ground temperatures to values closer to those typically 
found just below the ground slab.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/Ground_Modelling.htm

The EnergyPlus weather file provides ground tempera-
tures for undisturbed sites. However, you should not use 
the ground temperatures in the EnergyPlus weather file 
header because these are for undisturbed sites.

The temperature beneath a building is significantly 
affected by the building itself – the EnergyPlus 
 documentation recommends using a ground tempera-
ture of 2°C below average internal temperatures for large 
commercial buildings (where the perimeter heat loss 
is relatively less important). Note that this temperature 
should be applied directly below the slab and should not 
include ground material; so if you use this approach to 
ground temperature definition, you should switch off the 
use of the ground construction at the site level.

EnergyPlus cannot model very thick constructions, so it is 
necessary to use less thick constructions (2 m or smaller) 
combined with some assumptions about temperatures at 
about half a meter below the floor.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/Ground_Modelling.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Ground_Modelling.htm


115

CHAPTER THREE

Material and Construction

The aim of this chapter is to explain how to create a model 
while defining materials and constructions and to evaluate 
their impact on the energy consumption of buildings. The 
chapter starts with a tutorial on evaluating the impact of 
thermal mass in the envelope by comparing the performance 
of lightweight and heavyweight external wall construction. 
Learners can also find a method for calculating the thick-
ness of insulation on the roof or external walls. The tutori-
als cover analysis of roof insulation location (overdeck or 
underdeck), use of a cool roof and radiant barrier.
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TUTORIAL 3.1  Evaluating the effect of lightweight 
and heavyweight construction

GOAL

To evaluate the effect of thermal mass – the lightweight and 
heavyweight external wall construction in a building with 
night purge – on the thermal performance of the building. 

WHAT ARE YOU GOING TO LEARN? 

• Assigning lightweight and heavyweight construction

• Getting zone temperatures

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model and 
set external wall construction to lightweight and heavyweight. 
Find out the air temperatures inside the zone for both the cases. 
You need to analyse it for the DUBAI INTERNATIONAL, 
United Arab Emirates weather location.

You are going to use the following construction for external 
walls: 

• Uninsulated wall, lightweight (wood derivative – 
plywood 15 mm)

• Uninsulated wall, heavyweight (stone – granite, 
450 mm)

SOLUTION

Step 1: Open a new project file. Create a 50 m × 25 m 
building. 
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Step 2: Select the Construction tab. 

Step 3: In the Construction section, click Project 
wall. External walls gets highlighted. Click the Add 
new item icon. The Edit construction-Wall screen 
appears. 

Step 4: Enter Light weight as the Name. Go to the 
Layers section and select Plywood as material (you can 
find it under the Wood branch), and set the thickness to 
0.025. Click OK. A message box appears. 

Step 5: Select Light Weight as the external wall. 
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Step 6: Go to the Airtightness section and enter 3.000 
in the Constant rate (ac/h) box. Click On 24/7 in the 
Schedule field. Three dots appear. Click the dots. The 
Select the Schedule screen appears. 

Step 7: Click the Create copy of highlighted item icon. 
Make sure that the copy of the item is highlighted. 

Step 8: Click the Edit selected data icon. The Edit 
Schedule screen appears. 
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Step 9: In the General section, enter Night Purge in the 
Name box. Under the Profiles section, edit the schedule 
as shown below. Click OK. 

Step 10: Make sure that the Night Purge schedule 
is set. 
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Step 11: Click Flat roof element - 1250.000 m2 
in the navigation tree and select Adiabatic from 
the Adjacency drop-down list. Click Building 1 in 
the navigation tree. 

To understand the effect of the thermal mass of the 
 external wall, we want to remove the heat gains and 
losses from the roof. To achieve this, the roof has been 
made adiabatic.

Step 12: Go to the Building 1 level. Select the Activity 
tab and select Density (people/m2) as 0.06 and Office 
Equipment Gain (W/m2) as 1.00. (The internal load has 
been reduced so that the effect of the thermal mass is clearly 
visible. If the internal loads are higher, then the inside zone 
temperature is dominated by the internal load and you cannot 
observe the effect of the thermal mass from the envelope.) 

Adiabatic surface means that heat is not transferred 
across its external surface.

Source: http://www.designbuilder.
co.uk/helpv4.7/#Adjacency.htm

Night purge is a technique used in conditioned buildings 
in which during unoccupied night hours, cool ambient 
air is passed through the building to flush out the heat 
released/accumulated in the building.  

http://www.designbuilder.co.uk/helpv4.7/#Adjacency.htm
http://www.designbuilder.co.uk/helpv4.7/#Adjacency.htm
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Step 13: Select the Openings tab and ensure that 
Preferred height is selected and window-to-wall per-
centage is set as 0.00. 

Step 14: Select the Lighting tab and select the Lighting 
energy (W/m2-100 lux) as 0.25. 
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Step 15: Select the HVAC tab and select the tem-
plate as <None> and clear Mechanical Ventilation, 
Heating, Cooling, DHW and Natural Ventilation 
check boxes. 

Step 16: Simulate the model for hourly interval reporting. 
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Step 17: Click OK. The results are displayed in the grid. You 
need to click on Zone 1 to get the results at the zone level. 
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Step 18: Click the Export Data icon. The Export 
Results Spreadsheet dialog box appears. You can save 
this results file on your desktop to retrieve it easily. 

Step 19: Repeat the previous steps to create a high thermal 
mass external wall. 

Step 20: Perform hourly simulation and record the 
results.

Compare the indoor air temperature for both cases with 
the outside dry-bulb temperature. 
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• As shown in the above figure, the temperature 
difference between the indoor air and outside air 
is higher for high thermal mass buildings. This is 
because building walls with a high thermal mass 
tend to store and increase the time taken for the 
heat to transfer from the outside to inside.

• The room air temperature in a high thermal mass 
building has less swing as compared to the room 
air temperature of a low thermal mass building 
that follows the outside temperature pattern.

• The occurrence of the highest room air temper-
ature in a high thermal mass building is not at 
the same time when the outside air temperature 
peaks. Rather, it is shifted to a later time of the 
day. This difference in time when the peaks are 
observed in room temperature and the outside air 
temperature is defined as the thermal lag.

Exercise 3.1

Repeat the tutorial with insulation on the lightweight external 
wall. Compare the results with and without insulation on the 
lightweight wall.
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TUTORIAL 3.2 Evaluating the impact of roof insulation

GOAL

To study the effect of roof insulation on the building energy 
consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Creating roof construction

• Setting the U-value of the roof

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model. 
Construct a roof with a 100 mm Aerated concrete slab and 
glass fibre slab insulation of varying thicknesses. Achieve 
the U-values given in Table 3.1 by varying the insula-
tion thickness. Find out the energy consumption for each 
variation. Use the weather file of WIEN/SCHWECHAT-
FLUG, AUSTRIA.

Table 3.1 U-values and R-values of the roof

S. No.
U-value R-value

(m2 K/W) S. No.
U-value R-value 

(m2 K/W)(W/m2 K) (W/m2 K)

1 1 1 10 0.31 3.25
2 0.8 1.25 11 0.29 3.5
3 0.67 1.5 12 0.27 3.75
4 0.57 1.75 13 0.25 4
5 0.5 2 14 0.24 4.25
6 0.44 2.25 15 0.22 4.5
7 0.4 2.5 16 0.21 4.75
8 0.36 2.75 17 0.2 5
9 0.33 3
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SOLUTION

Step 1: Open a new project and create a 50 m × 25 m 
building.

Step 2: Select the Construction tab.

Step 3: Go to the Construction section, click Flat 
roof, and then click the Add new item icon. The Edit 
 construction – Roof screen appears. 

R-value or thermal resistance (R) – The R-value of any 
section having one or more layers with parallel surfaces 
is an indication of the resistance offered by the section to 
the heat flow. It is the reciprocal of thermal conductance. 
For a structure having plane parallel faces, the thermal 
resistance is equal to the thickness (L) of the structure 
divided by the thermal conductivity (k).

 
R

L
k

=
 

(3.1)

The R-value of individual payers can be added to arrive at 
the total R-value of the section.

It is also expressed as the ratio of the temperature differ-
ence across an insulator and the heat flux (the heat trans-
fer per unit area per unit time).

Thermal transmittance (U-factor) – thermal 
 transmittance (U) – The thermal transmission in the unit 
time through the unit area of the given section divided by 
the temperature difference between the fluid on either side 
of the building unit in steady-state conditions. It is also 
called the U-value. Its unit is W/m2 K. It can be treated as 
a measure of the heat loss through the unit area of a build-
ing section such as a wall, floor or roof. A low U-value 
generally indicates high levels of insulation.
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Step 4: Select 2 from the Number of layers drop-down list. 

Step 5: Enter 0.1000 as the Thickness (m) in the 
Outermost layer section. Select Glass Fibre Slab from 
Insulating materials for the innermost layer. 

Step 6: Click anywhere in the blank space under the 
Innermost layer section to update the help section.
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Step 7: Click the Set U-value link. The Set Construction 
U-value screen appears. 

Step 8: Enter the U-value (W/m2 K) as 1.0. Click OK. 
A confirmation message appears with the updated insu-
lation thickness. 

Step 9: Click OK. The insulation thickness is updated. 



130 BUILDING ENERGY SIMULATION

Step 10: Select the Calculated tab. The updated U-Value 
of the construction appears. 

Step 11: Click OK. 

Step 12: Perform annual energy simulation and record 
the results. 

Step 13: Repeat the previous steps to set the U-values as 
given in Table 3.1. For each U-value, simulate and record 
the results.

Compare the results for all simulations (Table 3.2). 
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• In this scenario, the impact of insulation on the heating 
energy consumption is more than that on the cooling 
energy consumption.

• The law of diminishing returns can be seen here, as the 
heating energy consumption does not proportionally 
decrease with the increase in the insulation thickness.

Exercise 3.2

Repeat the above with the Miami, Florida location.

Table 3.2 Heating and cooling energy consumption for 
different U-values

S. No.
U-value 
(W/m2 K)

R-value 
(m2 K/W)

Total heating 
consumption 
(gas) (kWh)

Total cooling 
consumption 
(electricity) 
kWh

1 1 1 122,679.00 30,154.15
2 0.8 1.25 108,379.80 30,443.14
3 0.67 1.5 99,166.45 30,778.71
4 0.57 1.75 92,090.48 31,118.85
5 0.5 2 87,049.97 31,404.42
6 0.44 2.25 82,713.34 31,677.60
7 0.4 2.5 79,882.75 31,879.73
8 0.36 2.75 77,004.63 32,093.25
9 0.33 3 74,849.12 32,266.08
10 0.31 3.25 73,423.50 32,383.91
11 0.29 3.5 71,980.63 32,507.87
12 0.27 3.75 70,537.98 32,630.72
13 0.25 4 69,108.34 32,756.97
14 0.24 4.25 68,383.09 32,823.62
15 0.22 4.5 66,954.23 32,955.86
16 0.21 4.75 66,236.32 33,021.09
17 0.2 5 65,521.70 33,087.50



132 BUILDING ENERGY SIMULATION

TUTORIAL 3.3  Evaluating the impact of the 
position of roof insulation

GOAL

To evaluate the impact of the position of roof insulation 
(overdeck and underdeck). 

WHAT ARE YOU GOING TO LEARN? 

• Editing roof construction

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model. 
Use the construction layers as given in the following table. 
Find out the energy consumption for each variation. Use the 
weather data for FRANKFURT MAIN ARPT, Germany 
and DUBAI INTERNATIONAL, United Arab Emirates 
(Table 3.3).

In most of the locations, except for very high latitudes, 
the external surface of the roof is directly exposed to 
solar radiation for the longest duration as compared to 
other surfaces of the building. The solar radiation upon 
being absorbed by the external surface of the roof turns 
into heat, which subsequently gets transmitted into the 
rooms below through the roof slab. The slab, due to its 
thermal mass, also accumulates heat while transmitting 
it beneath, which continues to be transmitted even after 
sunset due to the temperature difference between the 
slab and room interiors. To avoid this transmission and 

(Continued)

Table 3.3 Construction layers

Case I Case II

Outermost 
layer

Concrete, medium 
density, 0.15 m

XPS extruded 
polystyrene - HFC 
blowing, 0.05 m

Innermost 
layer

XPS extruded 
polystyrene - HFC 
blowing, 0.05 m

Concrete, medium 
density, 0.15 m
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SOLUTION

Step 1: Open a new project. Create a 50 m × 25 m build-
ing. Change the weather location to Frankfurt, Germany.

Step 2: Select the Construction tab.

Step 3: Add a roof with underdeck insulation – 0.15 m 
of Concrete, Medium density (from Concretes materi-
als), and 0.05 m of XPS Extruded Polystyrene - HFC 
Blowing (from Insulating materials). 

Step 4: Perform the annual simulation and record the 
results. 

accumulation of heat, insulation on the top surface is 
required in the form of overdeck insulation. A reduc-
tion in heat transmission by using insulation results in 
low energy consumption for operating cooling devices.

If insulation is provided on the inner surface of the roof, it 
is termed as underdeck insulation. It results in decreasing 
energy consumption for cooling devices since it reduces 
the radiant heat from entering the rooms.

In locations requiring heating of buildings, the reverse 
is the approach. Insulation is provided on the inner side 
for reducing the heat flow from the inside to outside. As 
a concept insulation should be put as early as possible in 
the path of a heat flow, whether from outside to inside or 
from inside to outside.
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Step 5: Repeat the tutorial for overdeck insulation. 

Step 6: Simulate the model and compare the results for 
the two cases (Table 3.4).

Frankfurt requires predominantly heating and under-
deck insulation, preventing the internal heat from being 
absorbed by the slab mass, thereby reducing the heating 
energy consumption.

Step 7: Change the weather location to DUBAI 
INTERNATIONAL, United Arab Emirates and com-
pare the energy consumption for overdeck and underdeck 
insulation (Table 3.5).

Cooling is the predominant requirement in Dubai. 
Overdeck insulation prevents the external heat from 
being absorbed by the slab mass, thereby reducing cool-
ing energy consumption.

Table 3.4 Annual fuel breakdown for underdeck and overdeck 
roof insulation for Frankfurt location

With underdeck roof 
insulation (kWh)

With overdeck roof 
insulation (kWh)

Room electricity 52,293.8 52,293.8
Lighting 75,575.8 75,575.8
Heating (gas) 78,150.5 83,534.8
Cooling (electricity) 25,341.2 21,440.5
DHW (electricity) 4,731.7 4,731.7
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Exercise 3.3

Repeat the above tutorial for the external wall. Use the weather 
data for FRANKFURT MAIN ARPT, Germany and DUBAI 
INTERNATIONAL, United Arab Emirates (Table 3.6).

Table 3.6 Construction layers for external walls

Case I Case II

Outermost layer Brickwork 230 mm XPS extruded 
polystyrene - HFC 
blowing, 0.05 m

Innermost layer XPS extruded 
polystyrene - HFC 
blowing, 0.05 m

Brickwork 230 mm

Table 3.5 Annual fuel breakdown for underdeck and overdeck 
roof insulation for Dubai location

With underdeck roof 
insulation (kWh)

With overdeck roof 
insulation (kWh)

Room electricity 52,293.8 52,293.8
Lighting 75,575.8 75,575.8
Heating (gas) 659.4 71.2
Cooling (electricity) 171,781.6 169,637.4
DHW (electricity) 4,731.7 4,731.7
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TUTORIAL 3.4  Evaluating the impact of the 
air gap between roof layers

GOAL

To evaluate the effect of the air gap thickness in roof con-
struction on the energy consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Adding the air gap between the roof layers

• Changing the air gap thickness

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a roof consisting of the following layers (starting with 
the outermost layer): 

 1. 0.01 m of cement/plaster/mortar-plaster

 2. 0.15 m concrete, medium density

 3. Air gap with varying thicknesses (as given below)

 4. 0.01 m gypsum plasterboard

Thickness of the air gap: 

 1. No air gap

 2. Air gap 15 mm (downwards)

 3. Air gap 17 mm (downwards)

 4. Air gap 25 mm (downwards)

 5. Air gap 50 mm (downwards)

 6. Air gap 100 mm (downwards)

 7. Air gap 300 mm (downwards)

Find out the energy consumption for LONDON/GATWICK 
ARPT, United Kingdom.

An air gap is different from the air space layer. An air 
gap is enclosed on either side, whereas an air space is a 
gap left between exterior finish layers and interior insula-
tion layers – as commonly practiced in the lightweight 
construction. The main role of the air space layer is to act 
as vapour and water drain/barrier, as compared to an air 
gap that improves the overall insulation properties of the 
wall/roof section.
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SOLUTION

Step 1: Open a new project. Create a 50 m × 25 m 
building.

Step 2: Select the Construction tab.

Step 3: Add a new roof with three layers. Select Cement/
plaster/mortar- cement plaster from Plaster materi-
als with thickness (m) as 0.0100, Concrete, Medium 
density from Concretes materials with thickness (m) 
as 0.1500  m, and select Gypsum plasterboard from 
Plaster materials with thickness (m) as 0.0100 m. 

Step 4: Simulate the model and record the results. 

Step 5: Again select the Construction tab. Edit the roof 
construction. 
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Step 6: Select the Thickness of the Innermost layer (we 
want to insert a new layer above this layer; hence, we 
have to select this layer). Click Insert layer. 

Step 7: Select Air gap 15mm (downwards) from Gases 
materials for the newly inserted layer (Layer 3) and enter 
0.001 as thickness (m).  

Step 8: Simulate the model and record the results.
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Step 9: Repeat the previous steps for all the air gap thick-
nesses given in the problem statement.

Compare the results for all simulations (Table 3.7). 

No air gap
-

50,000

100,000

150,000

200,000

250,000

Air gap
100 mm

Air gap
300 mm

Air gap
50 mm

Air gap
25 mm

Air gap
17 mm

Air gap
15 mm

kW
h

Annual cooling and heating consumption

Heating consumption (gas) (kWh)

Cooling consumption (electricity) (kWh)

Table 3.7 Comparison of annual fuel breakdown data for 
various air gaps

Annual fuel breakdown data

Room 
electricity 
(kWh)

Lighting 
(kWh)

Heating 
(gas) 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

No air gap 52,293.80 75,575.88 210,535.00 10,037.76 4,731.73

Air gap 15 mm 52,293.80 75,575.88 146,784.70 11,597.16 4,731.73

Air gap 17 mm 52,293.80 75,575.88 144,410.50 11,689.15 4,731.73

Air gap 25 mm 52,293.80 75,575.88 142,125.00 11,780.55 4,731.73

Air gap 50 mm 52,293.80 75,575.88 137,828.30 11,954.16 4,731.73

Air gap 100 mm 52,293.80 75,575.88 135,788.40 12,042.50 4,731.73

Air gap 300 mm 52,293.80 75,575.88 133,825.40 12,127.33 4,731.73
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TUTORIAL 3.5  Evaluating the impact of 
surface reflectance

GOAL

To evaluate the effect of surface reflectance on the energy 
performance of buildings. 

WHAT ARE YOU GOING TO LEARN? 

• Changing surface reflectivity

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a roof consisting of the following layers (starting with 
the outermost layer): 

• 0.015 m cement/plaster/mortar-plaster

• 0.150 m concrete, medium density

• 0.015 m cement/plaster/mortar-plaster

Vary the roof solar reflectivity on the outermost mate-
rial from 0.9 to 0.1 in steps of 0.1. Find out the impact 
of roof solar reflectivity on the energy consumption for 
SINGAPORE/PAYA LEBA.

SOLUTION

Step 1: Open a new project. Create a 50 m × 25 m building.

Step 2: Select the Construction tab.

Surface absorptance is the property of the surface mate-
rial to absorb radiation, and it is the opposite to surface 
reflectance, which is the capability to reflect radiation. 
For opaque surfaces, surface absorptance and surface 
reflectance values are therefore ratios whose sum is 
always equal to 1.

Solar reflectivity = Solar absorptance – 1
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Step 3: Add a new roof with three layers. Select Cement/
plaster/mortar - cement plaster from Plaster materials 
with thickness (m) as 0.01, Concrete, Medium density 
from Concretes materials with thickness (m) as 0.15 and 
Cement/plaster/mortar-cement plaster from Plaster 
materials with thickness (m) as 0.01. 

Step 4: Click Cement/plaster/mortar - cement plaster 
in the outermost layer and click the Create copy of high-
lighted item icon. 
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Step 5: Select the Copy of Cement/plaster/mortar - cement 
plaster and click the Edit highlighted item icon. 

Step 6: Enter Plaster - Surface Absorptance 0.9 in the 
Name box. 

Step 7: Select the Surface Properties tab and enter 
Solar absorptance as 0.900. 
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Step 8: Click the Select this data icon. 

Step 9: Perform the annual simulation and record the 
results. 

Step 10: Repeat the previous steps for all the values of 
solar absorptance given in the problem statement.

Compare the results for all simulations (Table 3.8). 

Table 3.8 Annual fuel breakdown data for different surface 
absorptance

Surface 
absorptance

Surface 
reflectance

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

0.9 0.1 52,293.80 75,575.88 249,997.20 4,731.73
0.8 0.2 52,293.80 75,575.88 241,298.20 4,731.73
0.7 0.3 52,293.80 75,575.88 232,533.50 4,731.73
0.6 0.4 52,293.80 75,575.88 223,629.40 4,731.73
0.5 0.5 52,293.80 75,575.88 214,548.10 4,731.73
0.4 0.6 52,293.80 75,575.88 205,382.60 4,731.73
0.3 0.7 52,293.80 75,575.88 196,176.00 4,731.73
0.2 0.8 52,293.80 75,575.88 186,744.60 4,731.73
0.1 0.9 52,293.80 75,575.88 177,542.70 4,731.73
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Exercise 3.5

Repeat the above tutorial for the FRANKFURT MAIN 
ARPT, Germany weather location (Table 3.9).
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TUTORIAL 3.6  Evaluating the impact of roof 
underdeck radiant barrier

GOAL

To evaluate the impact of underdeck radiant barrier on the 
energy performance. 

WHAT ARE YOU GOING TO LEARN? 

• Changing the emissivity of a material

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a roof consisting of the following layers (starting with 
the outermost layer). 

• 0.01 m cement/plaster/mortar-plaster

• 0.15 m concrete, medium density

• 0.01 m cement/plaster/mortar-plaster

Vary the thermal emittance on the innermost material of 
the roof (ceiling) from 0.1 to 0.9 in steps of 0.1. Find out the 
impact of roof thermal emittance on the energy consump-
tion for CA-SAN FRANCISCO INTL, USA.

Thermal absorptance (emissivity)
The thermal absorptance represents the fraction of 
 incident long wavelength radiation that is absorbed by 
the material. This parameter is used when calculating the 
long wavelength radiant exchange between various sur-
faces and affects the surface heat balances (both inside 
and outside as appropriate). Values for this field must be 
between 0.0 and 1.0 (with 1.0 representing ‘black body’ 
conditions).

http://www.designbuilder.co.uk/helpv4.7/Content/
SurfaceProperties.htm

Radiant barrier is the coating used under the roof deck to 
limit the heat transfer from the inside to outside and the 
outside to inside.

http://www.designbuilder.co.uk/helpv4.7/Content/SurfaceProperties.htm
http://www.designbuilder.co.uk/helpv4.7/Content/SurfaceProperties.htm
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SOLUTION

Step 1: Open a new project. Create a 50 m × 25 m 
building.

Step 2: Select the Construction tab.

Step 3: Add a new roof with three layers. Select Cement/
plaster/mortar - cement plaster from Plaster mate-
rials with thickness (m) as 0.01, Concrete, Medium 
density from Concretes materials with thickness (m) 
as 0.1500 and select Cement/plaster/ mortar - cement 
plaster from Plaster materials with thickness (m) 
as 0.0100. 

Step 4: Click Cement/plaster/mortar - cement plaster 
in the innermost layer, create a copy and rename it as 
New Cement/plaster/mortar - cement plaster. 
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Step 5: Click the Edit highlighted item icon. 

Step 6: Select the Surface properties tab and enter 
0.900 as the Thermal absorptance (emissivity). 

Step 7: Simulate the model and record the results. 

Step 8: Repeat the previous steps for all the values of 
thermal emissivity given in the problem statement.

Compare the results for all simulations (Table 3.10). 
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Exercise 3.6

Repeat the tutorial for the DUBAI INTERNATIONAL, 
United Arab Emirates weather location (Table 3.11).

Table 3.10 Comparison of annual fuel breakdown data for 
thermal absorptance

Thermal 
absorptance 
(emissivity)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Heating 
(gas) 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity)

0.9 52,293.80 75,575.88 62,966.75 15,490.71 4,731.73
0.8 52,293.80 75,575.88 62,696.43 15,513.52 4,731.73
0.7 52,293.80 75,575.88 62,352.68 15,553.91 4,731.73
0.6 52,293.80 75,575.88 61,982.36 15,619.02 4,731.73
0.5 52,293.80 75,575.88 61,489.79 15,720.82 4,731.73
0.4 52,293.80 75,575.88 60,888.78 15,881.52 4,731.73
0.3 52,293.80 75,575.88 60,104.81 16,128.46 4,731.73
0.2 52,293.80 75,575.88 59,024.70 16,510.27 4,731.73
0.1 52,293.80 75,575.88 57,484.44 17,130.53 4,731.73
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TUTORIAL 3.7 Evaluating the impact of a green roof

GOAL

To evaluate the impact of a green roof on the energy 
consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Creating a green roof

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a roof consisting of the following layers (starting with 
the outermost layer): 

• 0.01 m cement/plaster/mortar-plaster

• 0.15 m concrete, medium density

• 0.01 m cement/plaster/mortar-plaster

Add a green roof to the outermost layer of the roof. Find 
out the change in energy consumption with and without a 
green roof for DUBAI INTERNATIONAL, United Arab 
Emirates.

Table 3.11 Annual fuel breakdown data

Thermal 
absorptance 
(emissivity)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Heating 
(gas) 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity)

0.9
0.8
0.7
0.6
0.5
0.4
0.3
0.2
0.1
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SOLUTION

Step 1: Open a new project. Create a 50 m × 25 m 
building.

Step 2: Select the Construction tab.

Step 3: Add a New roof with three layers. Select Cement/
plaster/mortar - cement plaster from Plaster materi-
als with thickness (m) as 0.0100, Concrete, Medium 
density from Concretes materials with thickness (m) 
as 0.1500, and Cement/plaster/mortar - cement 
plaster from Plaster materials with thickness (m) as 
0.0100. 

Step 4: Simulate the model and record the results without 
a green roof.

Now you are going to add a green roof.

Step 5: Add a New roof with four layers. Select 12 
in. Soil at R-0.104/ in. from sands, stones and soil 
materials with thickness (m) as 0.305, Ethylene pro-
pylene diene monomer (EPDM) from rubber materi-
als with thickness (m) as 0.0015 and select Concrete, 

A green roof or living roof is a roof of a building that 
is partially or completely covered with vegetation and a 
growing medium planted over a waterproofing membrane.

http://www.designbuilder.co.uk/
helpv4.7/Content/GreenRoof.htm

http://www.designbuilder.co.uk/helpv4.7/Content/GreenRoof.htm
http://www.designbuilder.co.uk/helpv4.7/Content/GreenRoof.htm
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Medium density from concretes materials with thick-
ness (m) as 0.1500, and Cement/ plaster/ mortar - 
cement plaster from Plaster materials with thickness 
(m) as 0.0100. 

Step 6: Click 12 in. Soil at R-0.104/ in. In the outermost 
layer, it highlights and creates a copy. 

Step 7: Select the copy of 12 in. Soil at R-0.104/ in. 
Rename it Green Roof Layer. 
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Step 8: Select the Green roof tab. Select the Green roof 
check box. 

Step 9: Click OK. Green Roof Layer appears as the out-
ermost layer. 

Step 10: Perform annual simulation and record the 
results.

Compare the results for both simulations (Table 3.12).
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Exercise 3.7

Repeat the above tutorial for the CA – San Francisco, USA 
weather file (Table 3.13). 

Table 3.13 Annual fuel breakdown consumption with and 
without a green roof

Annual fuel breakdown consumption

Without a green 
roof (kWh)

With a green 
roof (kWh)

Room electricity
Lighting
Heating (gas)
Cooling (electricity)
DHW (electricity)

Table 3.12 Annual fuel breakdown with and without a 
green roof

Without a green 
roof (kWh)

With a green 
roof (kWh)

Room electricity 52,293.80 52,293.80
Lighting 75,575.88 75,575.88
Heating (gas) 2,483.94 470.05
Cooling (electricity) 196,202.30 188,443.40
DHW (electricity) 4,731.73 4,731.73
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CHAPTER FOUR

Openings and Shading

Openings are required in buildings to bring daylight and fresh 
air, and provide outdoor views. The energy for artificial elec-
tric light can be reduced if there is sufficient daylight in the 
space. However, daylight increases the heat gain in a space. 
If the  climate is hot/warm, it results in an increase in the air- 
conditioning energy consumption. Hence, there is a need to 
optimize the window-to-wall ratio (WWR) to get the minimum 
energy consumption while getting sufficient daylight.

Choosing glass type is also important for buildings; build-
ing glass is specified by some important properties such as 
U-value, solar heat gain coefficient (SHGC) and visible light 
transmittance (VLT). Generally, VLT to SHGC ratio is taken 
as an indicator of glass performance in cooling dominated loca-
tions. Higher is this ratio, better is the glass. Building shades 
can be used to cut the direct solar radiation in buildings and 
get diffused daylight inside the perimeter space. Overhangs and 
fins are classified as fixed building shades. Operable shades can 
also be used to cut the direct radiation from windows.

In this chapter, through the three tutorials, you are going to 
learn how to analyse the impact of different glazing types, fixed 
shades and operable shades for a given climate. This can be 
useful in the analysis of different designs and approaches for 
reducing solar heat gains through windows.
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TUTORIAL 4.1  Evaluating the impact of window 
wall ratio and glazing type

GOAL

To evaluate the impact of WWR and glazing type on the 
energy consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Setting WWR

• Selecting glazing type

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m five-
zone model with a 5 m perimeter depth. You are going to 
use the following glass types for the simulations (Table 4.1).

Find out energy consumption for all cases for 
SINGAPORE/PAYA LEBA.

SOLUTION

Step 1: Create a 50 m × 25 m five-zone model with a 5 m 
perimeter depth. 

PART I: With Dbl Green 6mm/6mm Air glass.

Step 2: Select the Openings tab and select Glazing type 
as Dbl Green 6mm/6mm Air. Set WWR to 0.00%. 

Window-to-wall ratio (WWR), is the ratio of the total win-
dow area to the total gross exterior above grade wall area.

Light-to-solar gain (L/S) is the ratio between the VLT and 
SHGC. It provides a gauge of the relative efficiency of dif-
ferent glass or glazing types in transmitting daylight while 
blocking heat gains. The higher the number, the more the 
light transmitted without adding excessive amounts of heat.
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Step 3: Simulate the model and record the results.

Step 4: Repeat the previous steps to set WWR (from 10% 
to 90% in steps of 10%) as given in the problem statement.

Record the results for all WWRs without lighting con-
trol (Table 4.2).

Step 5: Select the Lighting tab. In the Lighting Control 
section, select the ON check box. 

When you select the ON check box, you get the daylight 
sensor placed in all zones. You can see that the lighting 
energy consumption for the daylit perimeter zones will 
decrease.

Table 4.2 Annual energy consumption with a double glazing 
window without daylight controls

Double glazing without daylight controls (Dbl Green 6mm/6mm Air)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 73,871.52 194,815.30 4,625.02 324,426.33
20 51,114.49 73,871.52 201,498.70 4,625.02 331,109.73
30 51,114.49 73,871.52 207,691.50 4,625.02 337,302.53
40 51,114.49 73,871.52 213,531.40 4,625.02 343,142.43
50 51,114.49 73,871.52 219,081.10 4,625.02 348,692.13
60 51,114.49 73,871.52 224,293.80 4,625.02 353,904.83
70 51,114.49 73,871.52 229,142.60 4,625.02 358,753.63
80 51,114.49 73,871.52 233,851.40 4,625.02 363,462.43
90 51,114.49 73,871.52 238,187.40 4,625.02 367,798.43
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Step 6: Simulate the model and record the results.

Record the results for all WWRs with lighting  control 
(Table 4.3).

Step 7: Compare the results with and without daylight 
controls (Table 4.4). 

Table 4.3 Annual energy consumption with a double glazing 
window with daylight controls

Double glazing with daylight controls (Dbl Green 6mm/6mm Air)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 53,353.82 182,543.10 4,625.02 291,636.43
20 51,114.49 46,939.31 185,863.80 4,625.02 288,542.62
30 51,114.49 45,119.64 191,441.50 4,625.02 292,300.65
40 51,114.49 44,352.53 197,248.60 4,625.02 297,340.64
50 51,114.49 43,660.43 202,749.90 4,625.02 302,149.84
60 51,114.49 43,205.62 208,067.20 4,625.02 307,012.33
70 51,114.49 42,831.40 213,031.60 4,625.02 311,602.51
80 51,114.49 43,154.81 218,172.20 4,625.02 317,066.52
90 51,114.49 42,800.91 222,551.70 4,625.02 321,092.12

Table 4.4 Comparison of the total annual energy consumption 
for a double glazed window with and without daylight sensors

WWR 
(%)

Annual energy 
consumption without 
daylight controls (kWh)

Annual energy 
consumption with day 
light controls (kWh)

0 317,924.23 317,924.23
10 324,426.33 291,636.43
20 331,109.73 288,542.62
30 337,302.53 292,300.65
40 343,142.43 297,340.64
50 348,692.13 302,149.84
60 353,904.83 307,012.33
70 358,753.63 311,602.51
80 363,462.43 317,066.52
90 367,798.43 321,092.12
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The results show that with double glazed glass, a build-
ing consumes the minimum energy at 20% WWR, when 
daylight controls are installed in the building in all its 
daylit perimeter spaces. 

PART II: With Sgl Clr 6mm glass.

Step 8: Repeat the previous steps to get simulation results 
with Sgl Clr 6mm glass (Tables 4.5 through 4.7). 
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Table 4.5 Annual energy consumption for a single glazed 
window without daylight controls

Single glazing without daylight controls (Sgl Clr 6mm)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 73,871.52 199,104.20 4,625.02 328,715.23
20 51,114.49 73,871.52 209,534.90 4,625.02 339,145.93
30 51,114.49 73,871.52 218,763.50 4,625.02 348,374.53
40 51,114.49 73,871.52 227,147.50 4,625.02 356,758.53
50 51,114.49 73,871.52 234,957.70 4,625.02 364,568.73
60 51,114.49 73,871.52 242,125.10 4,625.02 371,736.13
70 51,114.49 73,871.52 248,650.70 4,625.02 378,261.73
80 51,114.49 73,871.52 254,622.30 4,625.02 384,233.33
90 51,114.49 73,871.52 260,126.20 4,625.02 389,737.23

Table 4.6 Annual energy consumption for a single glazed 
window with daylight controls

Single glazing with daylight controls (Sgl Clr 6mm)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 47,477.93 183,586.70 4,625.02 286,804.14
20 51,114.49 44,369.11 192,984.40 4,625.02 293,093.02
30 51,114.49 43,484.96 202,437.50 4,625.02 301,661.97
40 51,114.49 43,065.26 211,079.50 4,625.02 309,884.27
50 51,114.49 42,599.63 219,113.30 4,625.02 317,452.44
60 51,114.49 42,272.71 226,499.70 4,625.02 324,511.92
70 51,114.49 42,010.69 233,254.80 4,625.02 331,005.00
80 51,114.49 42,242.57 239,633.50 4,625.02 337,615.58
90 51,114.49 41,992.99 245,322.10 4,625.02 343,054.60
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The results show that with single glazed glass, a build-
ing consumes the minimum energy at 10% WWR when 
daylight controls are installed in the building in all its 
daylit perimeter spaces. 

PART III A: With ASHRAE 90.1-2007 equivalent glass 
(U-1.20 (6.81), SHGC-0.25 and VLT 53%).

Step 9: Now refer to the previous steps and get simulation 
results with ASHRAE 90.1 equivalent glass. Vertical 
glazing, 0%–40% of wall, U-1.20 (6.81) and SHGC-
0.25 (Tables 4.8 and 4.9). 

Table 4.7 Comparison of the total annual energy consumption 
for a single glazed window with and without daylight sensors

WWR (%)

Annual energy 
consumption without 
daylight controls (kWh)

Annual energy 
consumption with 
daylight controls (kWh)

0 317,924.23 317,924.23
10 328,715.23 286,804.14
20 339,145.93 293,093.02
30 348,374.53 301,661.97
40 356,758.53 309,884.27
50 364,568.73 317,452.44
60 371,736.13 324,511.92
70 378,261.73 331,005.00
80 384,233.33 337,615.58
90 389,737.23 343,054.60
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Table 4.8 Annual energy consumption with ASHRAE 90.1 
equivalent glass without daylight controls

ASHRAE 90.1 Glass without daylight controls (vertical glazing, 
0%-40% of wall, U-1.20 (6.81) and SHGC-0.25)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 73,871.52 191,587.80 4,625.02 321,198.83
20 51,114.49 73,871.52 194,916.30 4,625.02 324,527.33
30 51,114.49 73,871.52 198,107.40 4,625.02 327,718.43
40 51,114.49 73,871.52 201,055.30 4,625.02 330,666.33
50 51,114.49 73,871.52 203,782.00 4,625.02 333,393.03
60 51,114.49 73,871.52 206,272.20 4,625.02 335,883.23
70 51,114.49 73,871.52 208,605.50 4,625.02 338,216.53
80 51,114.49 73,871.52 210,932.40 4,625.02 340,543.43
90 51,114.49 73,871.52 212,968.10 4,625.02 342,579.13
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Step 10: Compare the results with and without daylight 
sensors (Table 4.10). 

Table 4.9 Annual energy consumption with ASHRAE 90.1 
equivalent glass with daylight controls

Good glazing with daylight controls (vertical glazing, 0%–40% of 
wall, U-1.20 (6.81) and SHGC-0.25)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 51,701.49 178,250.50 4,625.02 285,691.50
20 51,114.49 46,126.67 178,795.00 4,625.02 280,661.18
30 51,114.49 44,625.61 181,601.70 4,625.02 281,966.82
40 51,114.49 43,983.63 184,642.30 4,625.02 284,365.44
50 51,114.49 43,373.37 187,426.20 4,625.02 286,539.08
60 51,114.49 42,948.02 190,069.90 4,625.02 288,757.43
70 51,114.49 42,597.32 192,549.70 4,625.02 290,886.53
80 51,114.49 42,902.14 195,325.90 4,625.02 293,967.55
90 51,114.49 42,571.14 197,496.00 4,625.02 295,806.65

Table 4.10 Comparison of simulation results of glass with and 
without daylight sensors

WWR (%)

Annual energy 
consumption without 
daylight controls (kWh)

Annual energy 
consumption with 
daylight controls (kWh)

0 317,924.23 317,924.23
10 321,198.83 285,691.50
20 324,527.33 280,661.18
30 327,718.43 281,966.82
40 330,666.33 284,365.44
50 333,393.03 286,539.08
60 335,883.23 288,757.43
70 338,216.53 290,886.53
80 340,543.43 293,967.55
90 342,579.13 295,806.65
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Step 11: Now compare the results for all simulations of dou-
ble glazing glass, single glazing glass and ASHRAE 90.1 
equivalent glass with lighting controls (Table 4.11). 
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Table 4.11 Comparison of the total annual energy consumption 
for all glass types with daylight controls

WWR 
(%)

Double glazing 
(L/S = 1.35) 
(kWh)

Single glazing 
(L/S = 1.09) 
(kWh)

ASHRAE 90.1 
equivalent glazing 
(L/S = 2.12) 
(kWh)

0 336,004.18 336,004.18 336,004.18
10 306,612.44 306,036.66 305,364.20
20 304,903.64 311,950.44 298,535.13
30 310,044.69 321,242.29 299,836.25
40 315,943.50 330,149.92 302,380.69
50 321,484.33 338,323.96 304,731.91
60 326,813.57 345,953.19 307,113.99
70 331,942.46 353,023.54 309,480.51
80 337,800.03 360,149.95 312,833.83
90 342,264.91 366,045.43 314,854.56
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PART III B: With ASHRAE 90.1-2007 equivalent glass 
(U-1.20 [6.81], SHGC-0.25 and VLT 53%) with the shading 
of a 0.5 m overhang.

Step 12: Select the Openings tab, select the Local shad-
ing check box under the Shading section and select 0.5m 
Overhang from the Type (Table 4.12). 

Table 4.12 Annual energy consumption with ASHRAE 90.1 
equivalent glass, with fixed shade and daylight controls

Good glazing with daylight controls (vertical glazing, 0%–40% of 
wall, U-1.20 (6.81) and SHGC-0.25)

WWR 
(%)

Room 
electricity 
(kWh)

Lighting 
(kWh)

Cooling 
(electricity) 
(kWh)

DHW 
(electricity) 
(kWh)

Annual 
consumption 
(electricity) 
(kWh)

0 51,114.49 73,871.52 188,313.20 4,625.02 317,924.23
10 51,114.49 53,819.91 178,846.40 4,625.02 288,405.82
20 51,114.49 47,004.59 177,688.30 4,625.02 280,432.40
30 51,114.49 45,294.22 179,536.80 4,625.02 280,570.53
40 51,114.49 44,561.03 181,742.40 4,625.02 282,042.94
50 51,114.49 43,683.38 184,197.20 4,625.02 283,620.09
60 51,114.49 43,139.11 186,824.00 4,625.02 285,702.62
70 51,114.49 43,017.17 189,495.10 4,625.02 288,251.78
80 51,114.49 43,106.45 192,231.50 4,625.02 291,077.46
90 51,114.49 42,705.82 194,444.50 4,625.02 292,889.83
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Compare the results for with and without shading con-
trols for ASHRAE 90.1 equivalent glass (Table 4.13). 
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Annual energy consumption with daylight controls (kWh)

10 20 30 40
WWR

50 60 70 80 90

Table 4.13 Annual energy consumption results for ASHRAE 90.1 
equivalent glass with and without shading

WWR (%)

Annual energy 
consumption without 
daylight controls (kWh)

Annual energy 
consumption with daylight 
controls (kWh)

0 317,924.23 317,924.23
10 285,691.50 288,405.82
20 280,661.18 280,432.40
30 281,966.82 280,570.53
40 284,365.44 282,042.94
50 286,539.08 283,620.09
60 288,757.43 285,702.62
70 290,886.53 288,251.78
80 293,967.55 291,077.46
90 295,806.65 292,889.83
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For warm/hot climates: 

 1. If a building is without daylight controls, then the 
energy consumption increases with the increase 
in WWR. With the increase in WWR, heat gains 
through glass increase in the building and due 
to the absence of artificial lights dimming, the 
energy consumption increases.

 2. If a building is having daylight sensors, then 
artificial lights can be dimmed when  sufficient 
daylight is available. With the increase in WWR, 
more daylight is available to the perimeter spaces. 
Daylight sensors help in reducing the artificial 
lighting load and offset the heat gains through the 
glass. However, after a point when the perimeter 
spaces are daylit, an increase in WWR does not 
save the artificial lighting energy as the lamps are 
fully dimmed. After this point with the increase 
in WWR, the heat ingress increases, thereby 
increasing the overall energy consumption.

 3. Glass with a higher visible light to solar gain 
(L/S) needs to be selected to get the maximum 
benefit from daylight.

Exercise 4.1

Repeat the above tutorial for WIEN/HOHE VARTE, Austria.

TUTORIAL 4.2  Evaluating the impact of overhangs 
and fins

GOAL 

To evaluate the impact of window overhangs and fins on the 
energy performance.

WHAT ARE YOU GOING TO LEARN? 

• Modelling overhangs and fins

PROBLEM STATEMENT

In this tutorial, you are going to use a 30 m × 30 m model 
with a 5 m perimeter depth. You need to select the split no 
fresh air HVAC system to the simulation model.
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You need to simulate the model with the following options: 

 1. No shades

 2. Overhangs

 3. Vertical fins

Use location DUBAI INTERNATIONAL, United Arab 
Emirates.

SOLUTION

Step 1: Open a new project and create a 30 m × 30 m 
building with a 5 m perimeter depth.

Step 2: Select the Openings tab. Select the Single glaz-
ing, clear, no shading template. Select Sgl Grey 6mm in 
Glazing type. 

Step 3: Select the HVAC tab. Select the Split no fresh air 
template. Clear the Heated check box under the Heating 
section and clear the On check box under DHW. Select 
the check box under Cooling system and enter 3.0 as CoP. 

When you use the Split no fresh air template, you can get 
the cooling energy consumption for all zones separately.
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Step 4: Select the Simulation tab and select the Output 
tab, expand Summary Tables and select the All 
Summary check box under the Summary Annual 
Reports section. 
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Step 5: Perform annual simulation and view the data in 
graphical format. 

Step 6: Select the Summary tab. 

Step 7: Scroll down to read Annual and Peak 
Values – Other. 
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Step 8: Record the annual value for the energy transfer 
zone (GJ) for all perimeter zones (Table 4.14).

Save the simulation model for the next step.

Now you are going to model window overhangs.

Step 9: Select the Openings tab.

Step 10: Click the Shading section. Shading options appear. 

Table 4.14 Annual value for the energy transfer for each zone 
with no shading

Zone Annual value for energy transfer (GJ)

North 73.95
East 109.18
West 96.75
South 98.46



173Chapter FOUr Openings and shading

Step 11: Select the Local shading check box. It displays 
shading type. 

Step 12: Select the Visualize tab. It displays the rendering 
of the building. Make sure that all windows are modelled 
with an overhang. 

Step 13: Repeat the previous steps to get simulation 
results (Table 4.15).

Save the simulation model with  the  name DB_overhang.

In the next steps you are going to model vertical fins.

Step 14: Open the saved simulation model.

Step 15: Select Overhang + sidefins (0.5m projection) 
and make a copy of the current selection and edit for 
changes. 

Table 4.15 Annual value for energy transfer with overhangs

Zone Annual value (GJ)

North 72.30
East 100.23
West 88.33
South 87.45
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Step 16: Enter 0.5 m Fins as the name. 

Step 17: Select the Overhangs tab. 
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Step 18: Clear the Overhangs check box. 
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Step 19: Visualize the model. Make sure that all win-
dows have side fins. 

Step 20: Perform annual simulation and record the 
results (Table 4.16).

Compare the results for all the cases (Table 4.17). 
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Table 4.16 Annual value of energy transfer for vertical fins

Zone Annual value (GJ)

North 73.16
East 107.74
West 95.36
South 96.06
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Table 4.17 Comparison of the annual cooling energy for all 
types of shades

Annual cooling energy (GJ)

Zone No shade With overhangs With fins

North 73.95 72.30 73.16
East 109.18 100.23 107.74
West 96.75 88.33 95.36
South 98.46 87.45 96.06
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The following are the steps to get the sunpath diagram: 

Step 1: Select the Visualize tab.

Step 2: Under the Display options, select the Show sun-
path diagram check box.

Step 3: Click the Apply changes icon.

Exercise 4.2

Repeat the above tutorial for both overhangs and fins to observe 
the combined effect. Compare the energy consumption for all 
the perimeter zones.

TUTORIAL 4.3  Evaluating the impact of internal 
operable shades

GOAL 

To evaluate the impact of window internal operable shades 
on the energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Modelling operable shades

PROBLEM STATEMENT

In this tutorial, you are going to use the model created in 
Tutorial 4.2 (a 30 m × 30 m model with a 5 m perimeter 
depth). Find the energy consumption and solar gain for all 
perimeter zones.

You need to simulate the model with the following options: 

 1. Overhang with a 0.5 m depth

 2. Internal operable shades with solar control

Use the New Delhi/Palam, India weather location.

SOLUTION

Step 1: Open the model created in Tutorial 4.2 with a 
0.5  m overhang. Select the Openings tab and change 
window height to 1.00 m. Select the Simulation tab. The 
Edit Calculation Options screen appears. 
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Step 2: Simulate the model and select the Sub-hourly 
check box. Click OK. The results are displayed. 

Step 3: Select Internal gains from the Data drop-down 
list. Click East in the navigation tree. It shows internal 
gains for the east zone. 
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Step 4: Click the Export data button. The Export 
Results Spreadsheet screen appears.

Step 5: Select File from the Export to the drop-down 
list and CSV spreadsheet from the Format drop-down 
list. Click OK. 

Step 6: Name the file as East Zone Results and save this 
for the comparison of results. 



181Chapter FOUr Openings and shading

Similarly, repeat the previous step and save the results 
files for all the perimeter zones.

The next steps show how to model internal shades.

Step 7: Select the Openings tab. Select the Window 
shading check box under the Shading section. It dis-
plays shading type.

Step 8: Select High reflectance – low transmittance 
shade from the Type. Select 4-Solar from the Control 
type drop-down list. Set 250 as solar setpoint (W/m2). 
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Step 9: Simulate the model and record the results for all 
four zones.

Compare the results for two cases in each orientation: 
only overhang and overhang with internal shade for solar 
gains (kW) for 4 April. 
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The previous graph shows the profile of solar gains 
through the window on the east façade with overhang 
and overhang + internal shades for a day (4 April); you 
can observe the reduction in solar gains due to internal 
shades between 7 AM and 10 AM.

The following sunpath diagram shows direct radiation 
coming from the east window at 7 AM. Use of the inter-
nal shade can cut the direct solar radiation. 

Solar control type operates the indoor shading devices 
based on the amount of radiation given in W/m2. In this 
example, the solar setpoint considered is 250 W/m2; 
hence, whenever the solar radiation on the window is 
above this setpoint, the window shading will be down to 
reduce the incoming heat through radiation.

Indoor operable shades have other control types such as 
schedules and illuminance levels.
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You can observe from the graph plotted above that the 
internal shade is effective on the west window from 
14:00 to 19:00 on 4 April. This can also be seen from the 
following sunpath diagram that when there are no inter-
nal shades, west facing windows get direct solar radia-
tion at 16:00 h. 
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You can observe from the graph above that internal 
shades are not required on the south window on 4 April 
for this building. This can also be seen from the follow-
ing sunpath diagram that the south zone is not getting 
any direct glare with an  overhang of 0.5 m. This is due 
to the fact that the altitude of the sun in daytime, except 
for sunrise and sunset hours, is high enough on 4 April 
to not cause glare through windows. 
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You can observe from the graph above that the internal 
shade is not required on the north façade on 4 April. 
This can also be seen from the sunpath diagram that 
the window in the north direction is shaded on 4 April.

Now plot the solar gains from the south window façade 
on 6 February when the sun is at a lower altitude. 
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You can observe that with the internal shades there is a 
reduction in solar gains from the south window between 
12:00 and 16:00 h. 
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It is observed from the graph above that internal shades 
are more effective for the east, west and south zones for 
the New Delhi climate. 

The following two graphs give the direct normal radiation 
and global horizontal radiation on 4th April. You can see 
that the solar radiation curve is smooth, implying that the 
sky is clear.
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Exercise 4.3

Repeat the above tutorial for operable shade controlled Outdoor 
air temp + Solar on window. You can consider the outdoor 
temperature setpoint as 35°C for the New Delhi/Palam, India 
weather location.



http://taylorandfrancis.com
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CHAPTER FIVE

Lighting and Controls

As daylight varies throughout the day, it cannot provide 
 targeted illuminance levels the whole day. Sensors can be used 
to measure the deficit in the illuminance levels and can con-
trol the artificial lighting to provide the balance lumens. The 
operating level of artificial lights in daylit areas can be varied  
to achieve energy savings. Energy simulation tools are capable 
of handling this phenomenon. This is explained through two 
tutorials in this chapter.

TUTORIAL 5.1  Evaluating the impact of 
daylighting-based controls

GOAL 

To evaluate the effect of daylighting-based controls on the 
energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Modelling daylight controls

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a 5 m perimeter depth.

You are going to evaluate the following lighting controls: 

 a. No lighting control

 b. Linear/off

Use the WIEN/HOHE WARTE, Austria weather location.
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SOLUTION

Step 1: Open a new project and create a 50 m × 25 m 
building with a 5 m perimeter depth.

Step 2: Select the Openings tab and select Dbl Grey 
6mm/6mm Air as the Glazing type from the drop-down 
list. 

Step 3: Select the Activity tab. Select the 24×7 Generic 
Office Area template from the Miscellaneous 24hr 
activities folder. 

Step 4: Select the Lighting tab. Make sure to clear the 
On check box under Lighting Control.
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Step 5: Perform hourly simulation and record the results. 
For getting the results of each zone, go to the Navigation 
Tree on the left, select the zone and select Internal 
gains from the Data drop-down list and Hourly from the 
Interval drop-down list. 
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Step 6: Save the model using the ‘Save as’ option.
In the next steps, you are going to install daylight 
controls.

Step 7: Select the Lighting tab.

Step 8: Select the On check box under the Lighting 
Control section. Select Linear from the Control type 
drop-down list. 

Based on the control type, lighting controls dim or turn 
off the internal lighting when the assigned illuminance 
level is met. This reduces the lighting energy consump-
tion as well as the internal heat gain due to the artificial 
lighting. This reduction in heat gain decreases the cooling 
load and hence the cooling energy consumption.
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Step 9: Select the Hourly Simulation tab and record the 
results. For getting the results of each zone, go to the 
Navigation Tree on the left, select the zone and select 
Internal gains from the Data drop-down list and Hourly 
from the Interval drop-down list.

Step 10: Compare the hourly comparison of the light-
ing energy consumption for all options for 18 May. You 
can use a spreadsheet program to plot the comparative 
graphs. 
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From the above graph, it is clear that with the installation 
of controls, the lighting power consumption has reduced 
with the the lighting being automatically switched off 
between 06:00 and 18:00 h in different zones based on 
the daylight availability.

You can also get the solar radiation profile for 18 May 
by selecting Site Data from the Data drop-down list. 
Export the Direct Normal Solar and plot using a spread-
sheet program.
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The date of 18 May is selected for the simulation. The solar 
radiation curve is smooth with no perturbations due to 
clouds. Hence, it has been selected for the tutorial.
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Exercise 5.1

Repeat the above tutorial and compare the energy consumption 
for stepped lighting controls.

TUTORIAL 5.2  Evaluating the impact of daylight 
sensor placement

GOAL 

To evaluate the impact of daylight sensor positioning on the 
energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Defining daylight sensors positioning

PROBLEM STATEMENT

In this tutorial, you are going to use a 10 m × 10 m single-
zone model with one window only on the south façade. 
Window area is 40% of gross south facade area. Find out 
the change in internal lighting gains in the zone with the 
use of a daylight sensor with linear/off.

Place daylight sensor(s) at the following locations: 

 1. 2 m from the window

 2. 8 m from the window

 3. At 2 and 8 m from the window

Use the New Delhi/Palam, India weather location.

SOLUTION

Step 1: Open a new project and create a 10 m × 10 m 
single-zone model. Press the ESC button to get out from 
the Edit mode. 
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Step 2: Click on the west window; it highlights the 
window. 

Step 3: Click Delete selected object(s) (Del). Then 
click Yes on the message box. The  window disappears. 
Similarly, you can delete windows on the north and east 
façade with the help of Dynamic orbit. 
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Step 4: Select the Openings tab and select Dbl Grey 
6mm/6mm Air from the glazing type. Set Window to 
wall % as 40.00. 

Step 5: Select the Activity tab. Select the 24×7 Generic 
Office Area template from the Miscellaneous 24hr 
activities branch. 
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Step 6: Select the Lighting tab. Set the Normalised 
power density (W/m2-100 lux) to 3. 

Step 7: Make sure to clear the ON check box under the 
Lighting Control section. 

Step 8: Perform hourly simulation and record the results. 

Now you are going to enable the daylight control in the 
model.

Step 9: Select the Lighting tab.
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Step 10: Select the ON check box under the Lighting 
Control section and select Linear/off in the Control 
type. Set 100 for % Zone covered by Lighting Area 1. 
Select the Layout tab. 

Step 11: Select the Activity tab and make sure that the 
target illuminance (lux) is 400. 

Step 12: Select Zone 1 from the Navigation Tree. The 
daylight sensor can be seen in the layout.
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Step 13: Select the Sensor and click the Move selected 
object icon. Click the daylight sensor and place it 2 m 
away from the window with the help of construction 
lines. 
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Step 14: Select the Simulation tab. The Edit Calcu-
lation Options screen appears. Select the Output 
tab and click the Detailed Daylight Outputs  section. 
Select the Daylight map output check box. Click OK. 
Perform hourly simulation. 

Step 15: Record the results. Plot hourly lighting data for 
4 April.
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In the above graph, you can observe that the  lighting 
consumption is zero between 09:00 and 17:00 h. To get 
the lux level at this time, you need to get the illuminance 
map.
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Step 16: Open the eplusmap file that exists in the 
EnergyPlus folder. 

 

Step 17: Get the data for 11:00 h.

Table 5.1 gives the Illuminance map when the sensor is 
placed near the window. In the map, each cell reports the 
illuminance (in lux) at the location specified by the (X;Y) 
coordinates in the column and row headers. These are 
XY pairs separated by a semi-colon for ease in import-
ing into the spreadsheet. In eplusmap file, the Z coor-
dinate of the map is shown in the title (the illuminance 
map is set in a plane) and the date and time are indicated 
in the upper left cell of the map. You can observe that at 
09:00 h all artificial lights are off because of sufficient 
illuminance near the sensor. This leads to low illumi-
nance in the interiors of the space.
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You can also get the solar radiation profile on 4 April 
by selecting Site Data from the Data drop-down list. 
Export the Direct Normal Solar and plot using a spread-
sheet program. 
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Step 18: Save the model using the Save as option.

Now, you are going to change the location of the daylight 
sensor at 8 m distance from the south window.

Step 19: Move the daylight sensor 8 m away from the 
window towards the north (as explained earlier). 
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Step 20: Perform hourly simulation. Record the annual 
results. Also record hourly lighting data for 4 April.
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Hourly lighting load for 4 April (the daylight sensor at 
8 m away from the window).

In the above graph, you can observe that lighting energy 
consumption between 08:00 and 17:30 h is higher com-
pared to when the sensor is placed near the window. 
When the sensor is moved away from the window it gets 
into darker portion of the room and is triggered when 
more daylight enters the room. This increase in daylight 
might take some time thereby delaying the time when 
the lights are switched off. This increases the lighting 
energy consumption but ensures that sufficient light is 
available even in the interior areas of the room when 
the lights are switched off. However, this might lead to 
higher illuminance levels near the window, leading to 
visual discomfort.

So there is a need to place two sensors at different posi-
tions to get energy savings and visual comfort.

Step 21: Save the model using the Save as option.

Now, you are going to install one more daylight sensor.
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Step 22: Select the Lighting tab and select the Second 
lighting area check box. Enter 50.0 as the % Zone 
 covered by Lighting Area 1 and % Zone covered by 
Lighting Area 2. Make sure the Target Illuminance 
(lux) is 400. 
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Step 23: Perform hourly energy simulation and record 
the results. 
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In the above graph, we can observe the lighting consump-
tion between 08:00 and 17:30 h. The energy consumption 
is less compared to the case when the sensor is placed far 
from the window, as artificial lights are switched off near 
the window when there is sufficient daylight.

Get the data for 11:00 h for illuminance levels (Table 5.2). 

Now compare the annual energy consumption for all 
three cases (Table 5.3). 
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It can be observed that the placement of the sensor affects 
the energy consumption. It is due to the fact that while 
using a single sensor, the controller assumes the same 
illuminance level in the entire zone as is found on the 
sensor. With this approach, when the sensor is placed 
close to the window, the model calculates the requirement 
of artificial light against a higher daylight level, as 
compared to the case of a lower daylight level when the 
sensor is placed far away. With two sensors, the space is 
divided into two zones independently controlled hence 
the energy consumption is between the two cases as 
discussed above. In practice, however, even while using a 
single sensor, different fixtures can be calibrated to adjust 
against different daylight levels at various depths.

Table 5.3 Annual lighting energy consumption 
with different sensor placements

Sensor placement
Annual lighting energy 
consumption (kWh)

No sensor 9,319.25
Near to the window 5,258.40
Far from the window 6,950.23
With two sensors 6,056.55
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CHAPTER SIX

Heating and 
Cooling Design

This chapter explains how to size and model the heating, ven-
tilation and air conditioning (HVAC) systems. Out of the three 
tutorials, one explains the effect of HVAC operating criteria on 
energy consumption. Often, thermostats of HVAC are oper-
ated by sensing the air temperature, and the same criterion is 
also used for the evaluation of thermal comfort hours through 
simulation. This tutorial shows the difference in alternative 
approaches using the case of ‘operative temperature’, that is, 
a combination of air temperature and mean radiant tempera-
ture. The second tutorial explains the method of sizing HVAC 
systems, and the third one covers the effect of using different 
calculation algorithms for performing HVAC calculations in the 
simulation.

TUTORIAL 6.1  Evaluating the impact of temperature 
control types

GOAL

To evaluate the impact of temperature control types – air 
temperature and operative temperature on HVAC equip-
ment sizing and energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Changing temperature setpoint control types and 
 evaluating its impact
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PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m model 
with a 5 m perimeter depth with the following specifications: 

• Number of floors: G+1

• Window-to-wall ratio: 40%
• Glass type: Dbl Blue 6mm/13mm Air (U-value-2.70° 

W/m2 K, SHGC-0.48, VLT-0.50)

• Roof construction: Roof, Ins Entirely above Deck, 
R-50(8.8), U-0.020(0.114)

• Activity template: 24×7 Generic Office Area

Find the cooling equipment sizing and energy consumption 
for the ground floor with the following two temperature 
controls: 

 1. Air temperature (AT)

 2. Operative temperature (OT)

Use the New Delhi/Palam, India weather location.

SOLUTION

Step 1: Open a new project and create a 50 m × 25 m 
building with a 5 m perimeter depth and select the tem-
plate as 24×7 Generic Office Area. 

Step 2: Go to the Building level and select the Building 
on the edit screen.
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Step 3: Click Clone selected object(s). Click the origin 
of the floor, move the cursor to the top of the floor to 
paste the cloned floor. 
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Step 4: Select the Openings tab. Select Dbl Blue 
6mm/13mm Air as Glazing type and set the layout as 
Preferred height 1.5m, 40% glazed. 
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Step 5: Select the Construction tab and select Roof, Ins 
Entirely above Deck, R-50 (8.8), U-0.020 (0.114) as 
the Flat roof type. 

Step 6: Select the Cooling design tab. The Calculation 
Options screen appears.

Step 7: Select Air temperature from the Temperature 
control drop-down list. Click OK. The results are dis-
played in the Analysis tab. 
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Step 8: Select the Summary tab. Record the results. 

Step 9: Select the Simulation tab. In the Edit Calculation 
Options screen, select the Options tab. Ensure that 
the Air temperature is selected. Ensure that Hourly 
Simulation is selected in General tab. Click OK.

Day of week field is used to identify the appropriate 
daily profile within the schedules to use for the Cooling 
design calculations. The day type should be the day 
when the most extreme conditions and highest cool-
ing loads are expected. You should normally keep the 
9-SummerDesignDay default option, while running 
simulations.
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Step 10: Click South in the Ground Floor in the navigation 
tree. Record the air temperature and operative temperature 
for 4 April. (Data displayed on the screen is for the whole 
year; you can scroll to get the data for 27 March.) 

Step 11: Repeat the previous steps (the cooling design 
and simulation) by selecting the operative temperature 
control in place of the air temperature control.

Operative temperature is defined as follows:

A uniform temperature of a radiantly black enclosure in 
which an occupant would exchange the same amount of heat 
by radiation plus convection as in the actual non-uniform 
environment. It is the combined effect of the mean radiant 
temperature and air temperature calculated as the average 
of the two. It is also known as dry resultant temperature or 
resultant temperature. It can be calculated as follows:

t
t t
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a
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× +

+√

( )( )10

1 10

ϑ

ϑ

mr

where: 
ϑ = the air velocity
ta  = the air temperature
tmr = the mean radiant temperature

The mean radiant temperature of an environment is 
defined as the uniform temperature of an imaginary 
black enclosure that would result in the same heat loss by 
radiation from the person as the actual enclosure.
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Step 12: Select Operative temperature from the 
Temperature control drop-down list. Click OK and get 
the summary of analysis. 

Step 13: Select the Summary tab. Record the results 
in a separate spreadsheet (hourly values for AT, OT 
on 27 March for all zones on the ground floor, cooling 
design data and annual energy consumption results).

Now compare the results for both the cases (Table 6.1). 

Step 14: Plot AT and OT for the Ground Floor: South 
zone with the air temperature control for 27 March. 

Table 6.1 Design capacity of cooling equipment

Zone

Design capacity of cooling 
equipment (kW)

Air temperature 
control

Operative 
temperature control

Ground: East 15.49 20.19
Ground: West 17.44 22.61
Ground: North 23.71 26.43
Ground: South 23.81 26.75
Ground: Core 51.98 53.76
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You can observe that the zone air temperature is main-
tained at 24°C. However, the operative temperature of 
the zone is not constant over the day. In this case, the 
operative temperature of the zone is higher than the 
zone air temperature due to the higher temperature of 
the exposed walls and windows. It can also be noted that 
this difference is highest during  afternoon because the 
exposed surfaces of the south zone absorb solar radiation 
resulting in a higher surface temperature.

A higher operative temperature can cause discomfort 
despite the air temperature being maintained at 24°C. 
Hence, to get comfort in the zone, there is a need to set 
the thermostat based on the operative temperature.

Step 15: Now plot temperatures (AT and OT) for the 
Ground Floor: South zone with the operative tempera-
ture control. 
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It can be noted that for maintaining a constant operative 
temperature during the afternoon, the air temperature 
was reduced significantly to compensate for the higher 
surface temperature in the zones.
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Step 16: Plot a chart for the annual cooling energy con-
sumption for the air and operative temperature controls. 
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As discussed in the previous step, because the air tempera-
ture was reduced below 24°C to compensate for the higher 
surface temperature, the energy consumption in the opera-
tive temperature control mode is higher than that in the air 
temperature control mode.

Now repeat the steps for the following two cases: 

• Add a local shading 0.5 m overhang

• Use Vertical glazing, 0%–40% of wall, U-1.20 
(6.81), SHGC-0.25 glass with local shading as a 
0.5 m overhang

Simulate both the models for the air temperature based ther-
mostat control. Record the results and plot the temperatures 
for all the zones on the ground floor.  Also run annual simu-
lations and observe the energy consumption.

Step 17: Plot the temperatures for all zones on the ground 
floor with the air temperature for 4 April. 
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Air temperature
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The results display that by putting shade above the 
opening reduces the operative temperature. Use of high 
performance glass also reduces the OT as the high per-
formance glass surface tends to remain cooler then low 
performance glasses.
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It can also be seen that the pattern of operative 
 temperature is different for each zone. It is governed by 
the time of day when the zone receives solar radiation. 
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For the core zone it can be observed that the variation in 
OT is minimal since the walls are not receiving direct 
solar radiation and thus not getting heated up to the 
extent of the perimeter zones.

Step 18: Now, plot temperatures for the Ground Floor: 
South zone with the operative temperature control.
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Step 19: Plot a chart for the annual cooling energy 
 consumption for the air and operative temperature 
controls. 
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Analysis of results:

The thermostat control in conventional HVAC systems 
is activated as per the air temperature; however, human 
comfort is a function of operative temperature. Operative 
temperatures include the combined effect of air tem-
perature and mean radiant temperature. During sum-
mer, perimeter spaces are uncomfortable due to higher 
operative temperatures. Therefore, there is an increase in 
the cooling equipment sizing of the system, because the 
operative temperature setpoint continues to condition the 
building until comfort conditions are met.

You can observe that the effect of the operative tem-
perature setpoint is more noticeable in perimeter zones 
of the building compared to the core zone. This can be 
explained by the fact that the perimeter zones have more 
surfaces that are connected with the outdoor environ-
ment, whereas for the core zone, only the roof is con-
nected to the outdoor environment.

Exercise 6.1 

Repeat the above tutorial for 20% WWR (Table 6.2). 
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TUTORIAL 6.2  Evaluating the impact of design day 
selection

GOAL

To find the cooling equipment capacity using the design-
day and annual energy simulation approaches.

WHAT ARE YOU GOING TO LEARN? 

• Sizing using two methods: design day and annual 
energy simulation methods

PROBLEM STATEMENT 

In this tutorial, you are going to use a 50 m × 25 m model 
with a 5 m perimeter depth.

Find the peak cooling load 

 a. With the design day 15 July (as explained in Tutorial 
6.1)

 b. Using annual energy simulations

Table 6.2 Comparison of the design capacity of cooling 
equipment for air temperature and operative temperature 
controls

Zone

Design capacity of cooling 
equipment (kW)

Air temperature 
control

Operative 
temperature control

Ground: East

Ground: West

Ground: North

Ground: South

Ground: Core
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 Use the New Delhi/Palam, India weather file. Find the 
total cooling load for both options. Also note the time of 
occurrence of the maximum cooling load in each case.

COOLING DESIGN CALCULATION

Cooling design calculations are carried out to deter-
mine the capacity of the mechanical cooling equipment 
required to meet the hottest summer design weather con-
ditions likely to be encountered at the site location.

Cooling design simulations using EnergyPlus have the 
following characteristics: 

• Periodic steady-state external temperatures calcu-
lated using the maximum and minimum design 
summer weather conditions

• No wind

• Includes solar gains through windows and sched-
uled natural ventilation

• Includes internal gains from occupants, lighting 
and other equipment

• Includes consideration of heat conduction and con-
vection between zones of different temperatures

For buildings situated in the Northern Hemisphere, cool-
ing design calculations are made for the month of July, 
and for buildings in the Southern Hemisphere they are 
made for the month of January.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/_Cooling_design_simulation.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Cooling_design_simulation.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Cooling_design_simulation.htm
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SOLUTION

Step 1: Open a new model and create a 50 m × 25 m 
 building with a 5 m perimeter depth. Select the Cooling 
design tab. The Calculation Options screen appears. 

Step 2: Click OK. The results are displayed on the 
Analysis tab. 
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Step 3: Select the Summary tab. It shows the design 
capacity for 15 July. Select Coincident and record the 
results. 

 

In the next steps, you are going to find out the cooling 
load using annual energy simulations.

Step 4: Select the Simulation with Hourly tab. After 
completion of the simulation, select System loads from 
the Data drop-down list. 

‘Cooling design’ does not require the weather data file for the 
calculation. DesignBuilder has all the required information 
in the ‘ASHRAE_ 2005_Yearly_DesignConditions.xls’ file. 
This file can be accessed at C:\ProgramData\DesignBuilder\
Weather Data path.

These details automatically get loaded in the 
DesignBuilder when the location is selected.



226 BUILDING ENERGY SIMULATION

 

Step 5: Click the Export icon to export the results to the 
spreadsheet (Table 6.3). 
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Step 6: Open the spreadsheet and sort the results for the 
total cooling (kW) in decreasing order. This provides the 
peak total cooling (kW) of the building.

Compare the results for the building (Table 6.4).

The results show that there is a difference between the 
peak total cooling load of the building with the design day 
and without explicitly defining the design day. One should 
always be cautious while selecting the design day for cool-
ing. Sometimes the design day might not represent the day 
of the maximum total cooling load.

Save the simulation model for use in next tutorials.

Table 6.3 Total cooling load

Day month Time Total cooling (kW)

19 June 4:00:00 PM –158.2764
17 June 3:00:00 PM –158.2065
19 June 5:00:00 PM –158.1657
19 June 3:00:00 PM –158.0092
17 June 4:00:00 PM –157.7638
18 June 4:00:00 PM –156.7041
18 June 3:00:00 PM –156.598
17 June 12:00:00 PM –156.2252
18 June 5:00:00 PM –156.2232
21 June 5:00:00 PM –156.0791
24 June 4:00:00 PM –156.0511
17 June 5:00:00 PM –156.0495
10 June 4:00:00 PM –156.0368
17 June 11:00:00 AM –156.0086
24 June 5:00:00 PM –155.972
17 June 2:00:00 PM –155.8881
9 July 5:00:00 PM –155.832
20 June 3:00:00 PM –155.7305

Table 6.4 Total cooling load for design day and annual energy 
simulation

With design day on 15 July With annual energy simulation

Total cooling 
load (kW)

Date and time 
of peak

Total cooling 
load (kW)

Date and time of 
peak (building)

150.79 15 July at 15:00 158.27 19 June at 14:00
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In some cases, design conditions, namely, max dry bulb, 
concurrent wet bulb and minimum dry bulb temperature 
are known to HVAC designers. As a third alternate, these 
conditions can directly be filled in DesignBuilder. 

Exercise 6.2

Repeat the same steps as in the tutorial for London to find the 
heating design capacity.

You can use the heating sizing tab for this (Table 6.5). 
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TUTORIAL 6.3  Evaluating the impact of the air flow 
calculation method

GOAL 

To evaluate the impact of the air flow calculation method 
on HVAC equipment sizing.

WHAT ARE YOU GOING TO LEARN? 

• Changing the air flow calculation method and finding 
the design air flow

Heating design calculations are carried out to determine 
the size of the heating equipment required to meet the 
coldest winter design weather conditions likely to be 
encountered at the site location.

The simulation calculates the heating capacities required 
to maintain the temperature setpoints in each zone and 
displays the total heat loss broken down as follows: 

• Glazing

• Walls

• Partitions

• Floors

• Roofs

• External infiltration

• Internal natural ventilation (i.e. the heat lost to 
other cooler adjacent spaces through windows, 
vents, doors and holes)

Table 6.5 Total heating design capacity for design day and 
annual energy simulation

With design day on 15 Jan With annual energy simulation

Total heating 
design 
capacity (kW)

Date and time 
of peak of 
heating load

Total heating 
design capacity 
(kW)

Date and time 
of peak 
heating load 
(building)
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PROBLEM STATEMENT 

In this tutorial, you are going to use the simulation model 
used for Tutorial 6.2 (50 m × 25 m model with a 5 m perim-
eter depth) with building usage as classroom. Find the 
cooling equipment sizing, and design flow rates, for the fol-
lowing airflow calculation methods: 

 1. Sensible

 2. Sensible + latent

Use the AZ - PHOENIX/SKY HARBOR, USA weather file.

SOLUTION

Step 1: Open the model saved in Tutorial 6.2 (a 50 m × 
25 m building with a 5 m perimeter depth).

Step 2: Select the Activity tab. Select Classroom in the 
Universities and colleges section. 

Step 3: Select the Cooling design tab. The Calculation 
Options screen appears.

Step 4: Select Sensible only from the Airflow calcula-
tion method drop-down list. Click OK. The results are 
displayed in the Analysis tab. 
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Step 3: Select the Summary tab. Record the results.

Step 4: Repeat the previous steps to select Sensible+latent 
from the Airflow calculation method drop-down list. 
Click OK. 

The supply air for cooling

 
Q

q
C t t

s
s

R s

=
−1( )

The supply air for dehumidification

 
Q

q
C W W

L
L

R s

=
−2( )

where: 
Qs = supply air volume required to satisfy the peak 
sensible load
QL = supply air volume required to satisfy the peak 
latent load
qs = peak sensible load
qL = peak latent load
tR = room air temperature
ts = supply air temperature
WR = room humidity ratio
Ws = humidity ratio of the dehumidified supply air
C1 = 1.23 (For calculation in SI units)
C2 = 3010 (For calculation in SI units)
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Step 5: Select the Summary tab. Record the results. 

Compare both cases (Table 6.6). 

Table 6.6 Design capacity and design flow rate for each zone

Zone
Design 
capacity (kW)

Design flow rate (m3/s)

Sensible only Sensible + latent

Core 15.88 4.72 3.64
East 26.94 1.07 0.86
West 13.38 1.28 1.02
North 61.03 2.12 1.67
South 27.94 2.19 1.73
Total 145.16 11.38 8.92
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Exercise 6.3 

Repeat the above tutorial for the London Getwick Airport, UK 
(Table 6.7).

Factors that influence the sensible 
cooling load

Factors that influence the 
latent cooling load

 Glass, windows or doors
• Solar radiation striking 

windows, skylights or glass 
doors

• Thermal resistance of exterior 
walls

• Partitions (that separate spaces 
of different temperatures)

• Ceilings under an attic
• Thermal resistance of roofs 

and floors
• Air infiltration through cracks/

gaps in the building, doors and 
windows

• Building occupants
• Equipment and appliances 

operated in the summer
• Light

Moisture is introduced 
into a structure through: 

• Building occupants
• Equipment and 

appliances that 
release vapour in 
space, such as tea 
kettle

• Air infiltration 
through cracks/gaps 
in the building, doors 
and windows and 
frequent doors 
opening to the 
ambience

Table 6.7 Design capacity and design flow rate for each zone

Zone
Design 
capacity (kW)

Design flow rate (m3/s)

Sensible only Sensible + latent

Core

East

West

North

South

Total
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CHAPTER SEVEN

Unitary HVAC Systems

In most unitary HVAC systems, coefficient of performance 
(COP) and fan properties are the two key aspects that govern 
their energy consumption. Higher COP is associated with a 
reduction in energy consumption. Unitary systems require 
a fan for blowing air over the condenser as well as evaporator 
tubes. A  fan is characterized by its static pressure and volu-
metric air flow rate. High static pressure and flow rate help in 
achieving setpoint faster, however, they are also associated with 
higher energy consumption. If these parameters are not speci-
fied properly, results of the energy model could significantly 
deviate from the actual performance. This chapter explains the 
method of modelling unitary systems by specifying COP and 
fan properties.

TUTORIAL 7.1  Evaluating the impact of unitary 
air conditioner COP

GOAL

To evaluate the impact of unitary air conditioner COP on 
building energy performance. 

WHAT ARE YOU GOING TO LEARN? 

• Modelling the unitary HVAC system

• Changing the cooling system COP

PROBLEM STATEMENT

In this tutorial, you are going to create a 50 m × 25 m 5-zone 
model with 5 m perimeter depth. You need to model the uni-
tary HVAC system and then change the COP of the system.
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You need to change the cooling COP from 1.5 to 3.5 with 
increments of 0.5.

Use FL – MIAMI, USA weather file. Find energy con-
sumption for all COP values.

SOLUTION

Step 1: Open a new project and create a 50 m × 25 m 
building with five zones and consider a 5 m perimeter 
depth. Select the HVAC tab. 

COP = desired effect/work input

For cooling:

 
COPcooling =

Q
W

o

 
(7.1)

For heating:

 
COPHeating

k= Q
W  

(7.2)

where:
Qo = heat absorbed in the evaporator
Qk = heat rejected in the condenser
W = compressor work

The COP of the refrigeration cycle is a dimensionless 
index used to indicate the performance of a thermody-
namic cycle or the thermal system. The  magnitude of 
COP is usually greater than 1. 
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Step 2: Make sure Simple HVAC detail is displayed 
under the Help tab. 

There are three HVAC model options available in 
DesignBuilder:

Simple HVAC is suitable for use at early design stages. 
The heating/cooling system is modelled using basic loads 
calculation algorithms.

Compact HVAC – the heating/cooling systems are 
defined in DesignBuilder using moderately basic HVAC 
descriptions that are expanded into detailed HVAC defi-
nitions and modelled in EnergyPlus including boiler, 
chiller and fan part-load characteristics. Compact HVAC 
is now a deprecated feature and may not be supported in 
future releases.
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Step 3: Click Template under the HVAC Template 
 section. It displays three (…) dots. Click the three dots. 
The Select the HVAC template screen appears. 

Step 4: Select Packaged DX. Click OK. 

Detailed HVAC – the HVAC system is modelled in full 
detail using EnergyPlus air and water-side components 
linked together on a schematic layout drawing. This 
option will usually involve more work in setting up the 
setpoints, etc. especially for large models, but there is 
increased flexibility.

Source: http://www.designbuilder.co.uk/helpv4.7/ 
Content/_HVAC_model_detail.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_HVAC_model_detail.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_HVAC_model_detail.htm
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The screen appears showing the selected template as 
Packaged DX: 

Step 5: Enter 1.5 as the Cooling system seasonal CoP in 
the Cooling section. 

Step 6: Perform annual simulation and record the 
results.

Step 7: Repeat the previous steps for all other COP  values 
and record the results (Table 7.1).

Compare the results.

A unitary system combines heating, cooling and fan 
 sections all in one or a few assemblies for simplified 
application and installation and are used in most classes 
of buildings, particularly where low initial cost and 
 simplified installation are important.

In DesignBuilder, the Unitary single zone option allows 
you to model simple single constant volume direct expan-
sion (DX)-based HVAC configurations with  several heat-
ing options. Direct expansion includes  single-packaged 
rooftop systems commonly seen in commercial build-
ings and split systems commonly seen in residential 
buildings.

Source: http://www.designbuilder.co.uk/
helpv4.7/#_Unitary_single_zone.htm

http://www.designbuilder.co.uk/helpv4.7/#_Unitary_single_zone.htm
http://www.designbuilder.co.uk/helpv4.7/#_Unitary_single_zone.htm
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Table 7.1 Variation in annual energy consumption (kWh) with COP

End-use 
category

COP

1.5 2 2.5 3 3.5

Room 
electricity

51,114.94 51,114.94 51,114.94 51,114.94 51,114.94

Lighting 73,872.16 73,872.16 73,872.16 73,872.16 73,872.16
Cooling 
(electricity)

186,137.60 139,603.20 111,682.60 93,068.80 79,773.26

DHW 
(electricity)

4,625.06 4,625.06 4,625.06 4,625.06 4,625.06
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Results show that there is a decrease in energy consump-
tion with the increase in COP of the system. Systems with 
higher COP require lesser energy input to remove the same 
amount of heat from the thermal zone.

Save the model to use in the subsequent tutorial.

Exercise 7.1

Repeat the above tutorial for the heating system COP. Use 
CA-SAN FRANCISCO INTL, USA weather data.

End-use category

Annual energy consumption (kWh)

COP 
1.5

COP 
2.0

COP 
2.5

COP 
3.0

COP 
3.5

Room electricity
Lighting
System fans
Heating (electricity)
Cooling (electricity)
DHW (electricity)
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TUTORIAL 7.2  Evaluating the impact of the fan 
efficiency of a unitary air 
conditioning system

GOAL

To evaluate the impact of the fan efficiency of a unitary air 
conditioning system on energy performance. 

WHAT ARE YOU GOING TO LEARN? 

• Changing the fan efficiency

PROBLEM STATEMENT

In this tutorial, you are going to use a 50 m × 25 m five-
zone model with 5 m perimeter depth.

Model the unitary HVAC system with the following three 
fan efficiencies: 

 1. 0.600

 2. 0.700

 3. 0.800

Find change in energy consumption for all the cases.

Use Rio de Janeiro (AERO), Brazil location.

SOLUTION

Step 1: Open a new project and create a 50 m × 25 m 
building with 5 m perimeter depth. 
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Step 2: Select the HVAC tab. Click Simple link under 
the Help tab. The Model Options – Building and Block 
screen appears. 

Step 3: Click Detailed under the HVAC slider. Select 
Detailed HVAC Data from the Detailed HVAC drop-
down list. Click OK. It displays the <HVAC system> 
option under Building 1. 

Step 4: Click <HVAC System>. It displays initializing 
HVAC progress bar and subsequently the Load HVAC 
template screen appears. 
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Step 5: Click Detailed HVAC Template. It displays 
three (…) dots. Click the three dots. The Select the 
Detailed HVAC Template screen appears. 

Step 6: Select Unitary Heat Cool under Select Detailed 
HVAC Template. The Load HVAC template screen 
appears. 
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Step 7: Click Next. It displays all the zones. 

Step 8: Select the Building 1 check box and click Finish. 
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Step 9: In the navigation tree, select Air Loop Unitary 
HeatCool Supply Fan from the <HVAC System> tree. 
You need to click + to expand the tree. 

Step 10: Click Edit component. 

Step 11: Enter 0.600 for Fan total efficiency (%). Click OK. 
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Step 12: In the navigation tree, click Building 1. Perform 
annual simulation and record the results. 

A fan is a power-driven rotary machine that causes a 
 continuous flow of air.

A fan is a machine that causes flow of air.

There are two broad categories of fans – axial and 
centrifugal. 

Axis of
rotation

Axis of
rotation

Axial flow fan Centrifugal fan

Rotation

In axial flow fans, air moves parallel to the shaft. This 
type is used in many applications such as a cooling fan 
for electronics and wind tunnel.

A centrifugal fan blows air at 90° to the intake of the fan. 
Mostly, it is used for HVAC applications.

Fan Efficiency
The fan efficiency is the ratio between the power trans-
ferred to the air flow and the power used by the fan.

 
η = ∆P Q

W
.

fan  
(7.3)

where: 
η = fan efficiency (values between 0 and 1)
∆P  = total pressure (Pa)
Q = air volume delivered by the fan (m3/s)
Wfan = power used by the fan (Watt)
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Step 13: Repeat the previous steps for 0.700 and 0.800 
fan efficiency.

Compare the results (Table 7.2).

It can be seen that in addition to the reduction in energy 
consumption under system fans, there is a decrease in 
cooling (electricity) with the increase in fan efficiency. 
It is due to the fact that with a high- efficiency fan, lesser 
heat is added to the air while it passes over the fan motor, 
thus requiring a lesser cooling effect to be delivered by the 
system.

Save the simulation model with 0.7 fan efficiency to use 
in the next tutorial.

Exercise 7.2

Repeat the above tutorial for fan efficiency varying from 0.3 to 
0.9 with steps of 0.1 for  climate Melbourne, Australia.

TUTORIAL 7.3  Evaluating the impact of fan 
pressure rise

GOAL

To evaluate the impact of fan pressure on building energy 
performance. 

WHAT ARE YOU GOING TO LEARN? 

• Changing fan pressure rise

PROBLEM STATEMENT

In this tutorial, you are going to use the simulation model 
created in Tutorial 7.2 (50 m × 25 m model with 5 m peri-
meter depth).

Table 7.2 Variation of annual energy consumption with fan 
efficiency

End use

Annual energy consumption (kWh)

0.60 0.70 0.80

Room electricity 51,114.30 51,114.30 51,114.30
Lighting 73,871.25 73,871.25 73,871.25
System fans 23,220.41 19,903.21 17,415.31
Cooling (electricity) 84,774.20 83,792.05 83,051.09
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Model the unitary HVAC system with the following two 
fan pressures: 

 1. 500 Pa

 2. 750 Pa

Find the change in energy consumption for both cases.

Use Rio de Janeiro (AERO), Brazil weather location.

SOLUTION

Step 1: Open the project file used in Tutorial 7.2. In 
the navigation tree select Air Loop Unitary HeatCool 
Supply Fan. Click Edit component. 

Step 2: Enter 500 for Pressure rise (Pa). Click OK. 
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Step 3: In the navigation tree, click Building 1. Perform 
annual  simulation and record the results. 

Proper air filtration results in better conditions and air 
quality for occupants of the building as well as increases 
the longevity of the HVAC system. However, due to high 
negative pressure or resistance to flow with filtration 
devices, their use results in the rise in the static pressure 
requirement of the fan for maintaining the same flow rate.

Fans provide energy to air that helps the air to move 
through the ducts and other parts of the air side of an 
HVAC system, such as grills, diffusers, air filters, humidi-
fiers and dampers.

All these components impose resistance to the flow of 
air. To overcome such resistance, an increase in pressure 
is required.

As seen in Tutorial 7.2, fan power is inversely propor-
tional to pressure rise: 

• A typical fan running at a fixed speed can provide 
a greater volumetric flow rate for systems with 
smaller total pressure drops (if we are to the right 
of the peak in the fan curve).

Static pressure is used to overcome the pressure drop due 
to various ventilation system components on the airflow 
path within a given system. For mechanical ventilation 
systems, the fans create positive static pressure to move 
air through a given system.

The positive static pressure created by the fans equals 
the negative static pressure created by resistance as air 
navigates obstacles in the ventilation path plus the head 
required to impart sufficient kinetic energy to air for get-
ting spread into the space.
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Step 4: Repeat the previous steps for 750 Pa fan pressure.

Compare the results (Table 7.3).

From the results, you can observe that there is an increase 
in fan energy consumption due to the rise in fan pressure. 
Also you can observe that there is an increase in cooling 
energy consumption with the increase in pressure rise 
due to the addition of more heat to the air passing over a 
fan motor of higher power rating.

Exercise 7.3

In the tutorial, make Motor in airstream fraction as 0 and observe 
the effect on the cooling and fan energy consumption. Use the 
same Rio de Janeiro (AERO), Brazil weather file (Table 7.4). 

Table 7.3 Variation of annual energy consumption with fan 
pressure rise

End-use categories

Annual energy consumption (kWh)

500 Pa 750 Pa

Room electricity 51,114.30 51,114.30
Lighting 73,871.25 73,871.25
System fans 16,586.01 24,879.01
Cooling (electricity) 82,802.66 85,262.43
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Table 7.4 Variation of annual energy consumption with 
fan efficiency

End-use categories

Annual energy consumption (kWh)

500 Pa 750 Pa

Room electricity
Lighting
System fans
Cooling (electricity)
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CHAPTER EIGHT

Central HVAC System

Energy consumption of the centralized HVAC (Heating, 
Ventilating and Air Conditioning) system depends on the selec-
tion of individual components and their integration in the entire 
system. Major variations include the type of condenser for heat 
rejection, chilled water-pumping scheme, efficiency of the air 
distribution system, waste heat recovery and efficiency of the 
chiller and boiler. This chapter, through its tutorials, explains the 
method of modelling central HVAC systems. Different varia-
tions of systems are explained, such as types of chillers, cooling 
towers and the use of variable speed drives in HVAC compo-
nents. The impact of each variation on energy consumption is 
also explained.

TUTORIAL 8.1  Evaluating the impact of air-cooled 
and water-cooled chillers

GOAL

To evaluate the impact of air-cooled and water-cooled 
 chillers on the building energy consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Modelling the central HVAC system

• Modelling the air-cooled chiller

• Modelling the water-cooled chiller

PROBLEM STATEMENT

In this tutorial, you are going to use a G+5 floor building 
model. Each floor has a 50 m × 25 m area and five zones 
with 5 m perimeter depth. You need to make use of the 
floor/zone multiplier option to model the building. Model 
HVAC systems having VAV with reheat.
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Use the following two options for a chiller in the HVAC 
system: 

 1. Air cooled

 2. Water cooled

Compare the energy consumption of the two chillers for 
AZ-PHOENIX/SKY HARBOR, USA weather location. 
Phoenix has long, very hot summers and short, mild winters. 
The climate is arid, with plenty of sunshine and clear skies.

SOLUTION

Step 1: Open a new project and create a building with 
ground floor having a 50 m × 25 m area and five zones 
with 5 m perimeter depth. 

Step 2: Copy ground floor and create two other floors. 
(You can refer to Tutorial 6.1 to copy/clone floors.) 
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Step 3: Select Plan from View rotation drop-down. Click 
the add block icon. 

Before drafting, select Block type as Component block 
and Adiabatic in the Component block type and enter 
10.50 in Height (m). 

Go to Axonometric view, click in the corner and make 
sure that the roof is selected, when you click the point. 
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With the help of Move Selected Object icon, it can be 
adjusted. 

(You can also refer to Chapter 2 for floor/zone 
multiplier.) 

Step 4: Select the HVAC tab. Click Simple link under 
Help tab. The Model Options – Building and Block 
screen appears. 

Step 5: Click Detailed under HVAC slider. Select 
Detailed HVAC Data from the Detailed HVAC drop-
down list. Click OK. It displays <HVAC system> option 
under Building 1. 
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Step 6: Click <HVAC System>. It displays the initial-
izing HVAC progress bar and subsequently the Load 
HVAC template screen appears. 

Step 7: Select VAV Reheat, Air-cooled Chiller from 
Detailed HVAC Template. Click Next. 

Detailed HVAC – The HVAC system is modelled in 
detail using EnergyPlus air- and water-side components 
linked together on a schematic layout drawing. In this 
case, HVAC data is accessed by clicking on the <HVAC 
System> navigator node.
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In medium to large air conditioning systems, chilled water 
from the central plant is used to cool the air at the coils in 
an air handling unit (AHU).

Based on the condenser cooling, chillers are of two types: 

• An air-cooled chiller has a condenser that is cooled 
by ambient air. Air-cooled chillers are preferred for 
small or medium installations and are preferred in 
cases where there is not enough water.

• A water-cooled chiller has a condenser connected with 
a cooling tower. Cold water is obtained through partial 
evaporation of water through ambient air that is used 
to facilitate heat rejection from the condenser. The 
use of a cooling tower to cool the condenser increases 
the efficiency of water-cooled chillers over air-cooled 
systems in which ambient air cools the condenser.

Air cooled Water cooled

Efficiency Less High
Cost Less High
Maintenance Less High
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Step 8: Select all the check boxes from the Zones  section. 
Click Finish. It displays the system layout. 

Step 9: In the navigation bar, expand CHW Loop. 
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Step 10: Expand CHW Loop Supply Side and click 
Chiller. The Chiller layout appears. Click Edit compo-
nent under the Help tab. The Chiller data appears. 

Step 11: Make sure that Air Cooled Default is selected 
for Chiller template. 

Step 12: Simulate the model and record Annual Fuel 
Breakdown results.
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Step 13: Select the Edit tab. In the navigation tree click 
<HVAC System> and select Load HVAC Template. 

Step 14: Repeat the previous steps to select VAV Reheat, 
Water-cooled Chiller from Select the Detailed HVAC 
Template. 
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Step 15: Select DOE-2 Centrifugal/5.50COP in the 
chiller template field. 

Step 16: Perform annual energy simulation and compare 
results for both cases (Table 8.1). 

Table 8.1 Energy consumption for air- and water-cooled chillers

End-use categories

Annual energy consumption (kWh)

Air-cooled chiller Water-cooled chiller

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 168,257.40 168,257.40
System pumps 1,275.77 8,569.14
Heating (gas) 100,853.20 100,853.20
Cooling (electricity) 494,753.60 253,026.60
Heat rejection Not applicable 55,257.56
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Air-cooled chillers do not have a cooling tower for 
condenser cooling. In DesignBuilder, a heat rejection 
term is used for reporting cooling tower energy 
consumption. Hence, for the air-cooled chiller in the 
 end-use category – heat rejection – there is no value.

You can also observe that the cooling energy consump-
tion with the water-cooled chiller is less compared with 
the air-cooled chiller. The use of water instead of air 
increases the efficiency of heat transfer from the con-
denser, thereby increasing the efficiency of the chiller.

However, due to the addition of a water loop, a circu-
lation pump called condenser water pump is required, 
which increases the energy consumption under system 
pumps.

Save the simulation model with the water-cooled chiller to 
use in subsequent tutorials.

TUTORIAL 8.2  Evaluating the impact of variable 
speed drive (VSD) on a chiller

GOAL 

To evaluate the impact of VSD on a centrifugal chiller on 
building energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Modelling the chiller with VSD

PROBLEM STATEMENT 

In this tutorial, you are going to use the water-cooled chiller 
model saved in Tutorial 8.1 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You need to select the following two chillers and find out 
energy consumption in both cases: 

 1. EIRchiller Centrifugal Carrier 19XR 1213kW/ 
7.78COP/Vanes

 2. EIRchiller Centrifugal Carrier 19XR 1143kW/ 
6.57COP/VSD

Use AZ-PHOENIX/SKY HARBOR, USA weather 
location.
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SOLUTION

Step 1: Open the simulation model saved in Tutorial 8.1. 
Click <HVAC System> in the navigation pane. 

Step 2: Click CHW Loop. The components under the 
CHW loop appear. 
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Step 3: Click CHW Loop Supply Side. 

Step 4: Click Chiller. The chiller layout appears on the 
Layout tab. Click Edit component under the Help tab. 
The Edit Chiller screen appears. 
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Step 5: Click DOE-2 Centrifugal/5.5COP. Three dots 
(…) appear. Click the three dots. The Select the Chiller 
screen appears. 

Step 6: Click ElectricEIRChiller Centrifugal Carrier 
19XR 1213kW/7.78COP/Vanes. 
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Step 7: Click Electric input to cooling output ratio 
function of part load ratio curve. EIR vs part load 
curve is displayed on the right side. 

Numerically, EIR (energy input ratio) is the inverse 
of COP. The part-load ratio is the ratio of actual cool-
ing load delivered at any point of time compared to the 
 chiller’s cooling capacity.
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You can also view the curve coefficients. 
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Performance Curves

Cooling capacity function of temperature curve
The biquadratic performance curve parameterizes the 
 variation of the cooling capacity as a function of the leav-
ing chilled water temperature and the entering condenser 
fluid temperature. The output of this curve is multiplied 
by the reference capacity to give the cooling capacity at 
specific temperature operating conditions (i.e. at tem-
peratures different from the reference temperatures). The 
curve should have a value of 1.0 at the reference tem-
peratures and flow rates specified above. The biquadratic 
curve should be valid for the range of water temperatures 
anticipated for the simulation.

Electric input to cooling output ratio function of tem-
perature curve
The biquadratic performance curve parameterizes the 
variation of the energy input to cooling output ratio (EIR) 
as a function of the leaving chilled water temperature and 
the entering condenser fluid temperature. The output of 
this curve is multiplied by the reference EIR (inverse of 
the reference COP) to give the EIR at specific temperature 
operating conditions (i.e. at temperatures different from 
the reference temperatures). The curve should have a value 
of 1.0 at the reference temperatures and flow rates speci-
fied above. The biquadratic curve should be valid for the 
range of water temperatures anticipated for the simulation.

Electric input to cooling output ratio function of part 
load ratio curve
The quadratic performance curve parameterizes the vari-
ation of the EIR as a function of the part load ratio. The 
output of this curve is multiplied by the reference EIR 
(inverse of the reference COP) and the energy input to 
cooling output ratio function of temperature curve to give 
the EIR at the specific temperatures and part load ratio 
at which the chiller is operating. This curve should have 
a value of 1.0 when the part load ratio equals 1.0. The 
quadratic curve should be valid for the range of part load 
ratios anticipated for the simulation.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/Performance_Curves.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Performance_Curves.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Performance_Curves.htm
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Step 8: Perform annual simulation and record the results.

Step 9: Repeat the previous steps to select 
ElectricEIRChiller Centrifugal Carrier 19XR 
1143kW/6.57COP/VSD. 

 

VSD on the chiller provides you better efficiency while 
operating in part-load conditions.
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You can also view the curve coefficients. 

Step 10: Simulate the model and record the results.

Compare the energy consumption for both cases 
(Table 8.2). 
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There is a significant reduction in cooling energy consump-
tion with the VSD chiller. If you want to analyse the results, 
you need to look at the cooling load profile of the building.

Installing VSD on the chiller provides you better effi-
ciency while operating in part load conditions.

TUTORIAL 8.3  Evaluating the impact of VSD 
on a chilled water pump

GOAL 

To evaluate the impact of VSD on a chilled water pump on 
the building energy consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Modelling the variable speed chilled water pump

PROBLEM STATEMENT 

In this tutorial, you are going to use the water-cooled chiller 
model saved in Tutorial 8.1 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You need to select the following two configurations of the 
chilled water pump and compare energy consumption in 
both cases: 

 1. Constant flow

 2. Variable flow

Table 8.2 Effect of VSD on the chiller

Annual energy consumption (kWh)

Chiller without 
VSD

Chiller with 
VSD

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 168,257.40 168,257.40
System pumps 13,138.87 14,004.84
Heating (gas) 100,853.20 100,853.20
Cooling (electricity) 302,814.30 115,774.90
Heat rejection 80,947.34 82,738.82
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Use FL – MIAMI, USA weather location. Miami has a trop-
ical monsoon climate with hot, humid summers and short, 
warm winters, with a marked drier season in the winter.

SOLUTION

Step 1: Open the simulation model saved in Tutorial 8.1. 
Click <HVAC System> in the navigation pane. Click 
Load HVAC template. 

Step 2: Select System No. 8 VAV with PFP Boxes from 
ASHRAE 90.1 Appendix G baseline. Click OK. The 
Load HVAC template appears. 



274 BUILDING ENERGY SIMULATION

Step 3: Click Next. Select all the check boxes from 
the Zones section. Click Finish. It displays the system 
layout. 

Step 4: Select CHW Loop. Click Edit loop data under 
the Help tab. The Edit Plant loop screen appears. 
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Step 5: Select Constant flow from the Plant loop flow type. 

Step 6: Perform annual energy simulation and record the 
results.

Step 7: Repeat the previous steps for Variable flow 
CHW Loop. 

Step 8: Perform annual energy simulation and record the 
results.

Save the simulation model to use in subsequent tutorials.

Compare the energy consumption in both cases 
(Table 8.3).
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You can observe that there is a reduction in pump energy, 
cooling energy and energy consumption for heat rejection. 
Where variable flow is used, it can be clearly seen that there 
is less energy consumption for system pumps. Also there is 
a small decrease in cooling energy consumption of chiller 
and heat rejection due to the change in operating conditions 
of the chiller.

TUTORIAL 8.4  Evaluating the impact of a cooling 
tower fan type

GOAL 

To evaluate the impact of a cooling tower fan type on the 
building energy consumption. 

WHAT ARE YOU GOING TO LEARN? 

• Modelling the cooling tower with a single speed fan

• Modelling the cooling tower with a double speed fan

PROBLEM STATEMENT 

In this tutorial, you are going to use the variable flow model 
saved in Tutorial 8.3 (50 m × 25 m model with 5 m perim-
eter depth, six floors).

Table 8.3 Energy consumption for constant and 
 variable flow on the chilled water pump

End-use category

Annual energy consumption (kWh)

Constant flow Variable flow

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 72,965.29 72,965.28
System pumps 255,151.10 235,740.20
Heating (electricity) 8,253.35 8,253.35
Cooling (electricity) 297,860.90 296,225.90
Heat rejection 117,246.00 117,093.10
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You need to select the following two configurations of the 
chilled water pump and find out energy consumption in 
both cases: 

 1. Single speed fan cooling tower

 2. Double speed fan cooling tower

Use AZ-PHOENIX/SKY HARBOR, USA weather location.

SOLUTION

Step 1: Open the variable flow model saved in Tutorial 8.3. 
Expand <HVAC System> in the navigation pane. 

A cooling tower is an equipment that rejects heat extracted 
from the building to the atmosphere by the evaporation of 
water. Cooling tower fans help in governing the air flow 
and rate of evaporation.
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Step 2: Select Cooling Tower under Condenser Loop 
Supply Side. Click Edit component under the Help tab. 
The Edit Cooling Tower screen appears. 

Step 3: Select Single speed for cooling tower type. 

Step 4: Simulate the model and record the results.

Step 5: Repeat the previous steps to select Double speed 
cooling tower type. 
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Step 6: Perform annual energy simulation and record the 
results.

Save the simulation model to be used in the next tutorial.

Compare results for both cases (Table 8.4). 

Multi-speed/Variable Speed Drive (VSD) fan is the pre-
ferred method of capacity control for cooling towers. By 
matching the fan motor speeds to the required heat rejec-
tion, multi-speed/VSD cooling towers can significantly 
reduce energy consumption for heat rejection.
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You can observe from the results that there is a sig-
nificant reduction in energy consumption under heat 
rejection.

TUTORIAL 8.5  Evaluating the impact of condenser 
water pump with VSD

GOAL 

To evaluate the impact of using VSD with a condenser 
water pump on the building energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Modelling VSD on the condenser water pump

PROBLEM STATEMENT 

In this tutorial, you are going to use the double speed model 
saved in Tutorial 8.4 (50 m × 25 m model with 5 m perim-
eter depth, six floors).

You need to select the following two configurations of the 
condenser water pump and find out energy consumption in 
both cases: 

 1. One speed condenser water pump

 2. Variable speed condenser water pump

Use FL – MIAMI, USA weather location.

Table 8.4 Energy consumption for single speed and double 
speed cooling tower fans

End-use components

Annual energy consumption (kWh)

Single speed 
cooling tower fan

Double speed 
cooling tower fan

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 95,181.46 95,181.46
System pumps 165,284.00 165,284.00
Heating (electricity) 52,254.34 52,254.34
Cooling (electricity) 202,158.00 202,158.00
Heat rejection 82,768.20 28,458.18
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SOLUTION

Step 1: Open the double speed model saved in Tutorial 8.4. 
Expand <HVAC System> in the navigation pane. 

Step 2: Click Condenser Loop. It displays a condenser 
loop diagram in the Layout tab. 
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Step 3: Click Condenser Loop Supply Pump. Click 
Edit component under the Help tab. The Edit Pump 
screen appears. 

Step 4: Select Constant speed from the Type drop-down 
list. Click OK. 

Step 5: Simulate the model and record the results.

Step 6: Repeat the previous steps to select Variable 
speed from the Type drop-down list. 

Step 7: Simulate the model and record the results.
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Compare energy consumption for both cases (Table 8.5). 

A reduction in energy consumption under system pumps 
can be seen in the case of a variable speed condenser 
water pump. A small reduction in energy consumption 
for heat rejection can also be seen.

TUTORIAL 8.6  Evaluating the impact of 
an air-side economiser

GOAL 

To evaluate the impact of an air-side economiser on build-
ing energy performance.

WHAT ARE YOU GOING TO LEARN? 

• Modelling the air-side economiser (free cooling system)

PROBLEM STATEMENT 

In this tutorial, you are going to use the variable flow model 
saved in Tutorial 8.3 (50 m × 25 m model with 5 m perim-
eter depth, six floors).

Model the unitary HVAC system with the following options 
for the air-side economiser: 

 1. None

 2. Fixed dry bulb temperature based

 3. Fixed enthalpy based

Table 8.5 Energy consumption for the single speed and 
variable speed condenser water pumps

End-use category

Annual energy consumption (kWh)

Single speed 
condenser 
water pump

Variable speed 
condenser 
water pump

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 72,965.28 72,965.28
System pumps 235,740.20 110,578.00
Heating (electricity) 8,253.35 8,253.35
Cooling (electricity) 296,225.90 295,302.80
Heat rejection 117,093.10 110,880.00
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Find the change in energy consumption for all three cases.

Use New Delhi/Palam, India weather location. The cli-
mate of New Delhi is a monsoon-influenced humid sub-
tropical climate with high variation between summer and 
winter in terms of both temperature and rainfall. The tem-
perature varies from 46°C in summers to around 0°C in 
winters.

SOLUTION

Step 1: Open the variable flow model saved in Tutorial 8.3.

Step 2: Click Air Loop AHU. Click Edit component 
under the Help tab. The Air handling unit Data screen 
appears. 

An economiser is an adjustable fresh air intake unit that 
can draw up to 100% outside air when the outside air is 
cooler than the temperature inside the building and not 
humid, thereby providing free cooling.

Air-side economisers in HVAC can save energy in build-
ings by using cool outside air to cool the indoor space. 
When the temperature and/or enthalpy of the outside air 
is less than the temperature/enthalpy of the recirculated 
air, conditioning the outside air is more energy efficient 
than conditioning recirculated air. When the outside air is 
both sufficiently cool and dry (depending on the climate), 
no additional conditioning is required; this portion of the 
air-side economiser control scheme is called free cooling.
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Step 3: Select the Outdoor Air System tab. 

Step 4: Select No economiser from the Economiser 
control type drop-down menu under Economiser (Free 
Cooling). 

Step 5: Simulate the model and record the results.

Repeat the previous steps to select the fixed dry bulb 
 air-side economiser control type.
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Step 6: Select Fixed dry bulb from the Economiser 
control type drop-down menu under Economiser (Free 
Cooling). 

Step 7: Simulate the model and record the results.

Repeat the previous steps to select fixed enthalpy air-side 
economiser control type.

Step 8: Select Fixed enthalpy from the Economiser con-
trol type drop-down menu under Economiser (Free 
Cooling). 

Enthalpy is the total heat content of the air. This covers 
the combined effect of temperature and humidity.



287chapter eIGht centr al hVac SyStem

Step 9: Simulate the model and record the results. 
Compare the results (Table 8.6). 

You can observe that application of free cooling leads 
to reduction in annual cooling energy consumption. 
Enthalpy type air-side economiser leads to higher energy 
savings as compared to a dry bulb type economiser. 
There is a reduction in energy consumption of all the 
HVAC components, namely, cooling, pumps and heat 
rejection.

Save the model with no economiser for use in further 
tutorials.

Exercise

Compare the energy savings in Miami, Florida and London 
Gatwick using both types of air-side economisers.

Table 8.6 Energy consumption for no, fixed DBT and fixed 
enthalpy-based economisers

End-use category

Annual energy consumption (kWh)

No 
economiser

Fixed dry bulb 
temperature-based 
economiser

Fixed 
enthalpy-based 
economiser

Room electricity 153,342.90 153,342.90 153,342.90
Lighting 221,613.80 221,613.80 221,613.80
System fans 92,796.03 92,794.31 92,793.84
System pumps 244,590.30 196,796.50 196,773.80
Heating 
(electricity)

29,138.51 33,129.39 33,129.37

Cooling 
(electricity)

313,250.80 289,159.50 288,984.30

Heat rejection 80,399.58 80,292.47 80,233.80
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TUTORIAL 8.7  Evaluating the impact of supply 
air fan operation mode during 
unoccupied hours

GOAL

To evaluate the impact of fan operation mode during unoc-
cupied hours on energy consumption.

WHAT ARE YOU GOING TO LEARN? 

• Changing fan operation mode during unoccupied hours

PROBLEM STATEMENT 

In this tutorial, you are going to use the No economiser 
model saved in Tutorial 8.6 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You need to simulate the model with the following two 
options for New Delhi/Palam, India weather location for 
supply air fan operation: 

 1. Stay off

 2. Cycle on any

Find energy consumption in both cases.

Applicability schedule (night cycle)
This schedule determines whether or not for a given time 
period this mechanism is to be applied. Schedule values 
greater than zero (usually 1 is used) indicate the night 
cycle mechanism is to be applied, whereas schedule val-
ues less than or equal to zero (usually 0 is used) denote 
that it is not used for this time period.

Control type
The possible inputs are as follows: 

• Stay off means that the night cycle mechanism will 
have no effect – AHU on/off will be determined by 
the fan schedule.

• Cycle on any means that if any zone served by the 
air loop incorporating this AHU has an air tempera-
ture outside the cooling or heating setpoints, the 
central fan will turn on even though the fan sched-
ule indicates the fan is off.

(Continued)
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This setting is used to enable cycling of an air system when 
one or more zones become too hot or too cold. A com-
mon requirement for this mechanism is where the AHU is 
turned off at night. However, if the building gets too cold, 
there might be condensation on the walls and other dam-
age. Thus, the control system is usually programmed to 
turn the system on if either a specified control thermostat 
or any thermostat shows a zone temperature of less than 
a nighttime setpoint. Similarly, there might be a concern 
about a building getting too hot. Again the control system 
is programmed to turn the AHU back on if one or any 
zone temperature exceeds a nighttime cooling setpoint.

This mechanism offers considerable flexibility in deter-
mining how the nighttime on/off decision will be made. 
The temperature in one specific zone may be used or the 
temperatures in all the zones connected to the AHU may 
be sampled. You can specify a temperature tolerance and 
a run time for the system once it switches on. There is 
also an applicability schedule for scheduling when this 
mechanism may be applied.

Source: http://www.designbuilder.co.uk/
helpv4.7/#Generic_AHU.htm?Highlight=Generic 

Air Handling Unit (AHU)

Heating setback setpoint temperature
Some buildings require a low level of heating during 
unoccupied periods to avoid condensation/frost damage 
or to prevent the building from becoming too cold and to 
reduce peak heating requirements at start-up. Enter the 
setpoint temperature to be used at nighttime, weekends 
and other holidays during the heating season.

Cooling setback setpoint temperature
Some buildings require a low level of cooling during unoc-
cupied periods to prevent the building from becoming too 
hot and to reduce the start-up cooling load the next morn-
ing. Enter the setpoint temperature to be used at nighttime, 
weekends and other holidays during the cooling season.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/_Environmental_comfort.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Environmental_comfort.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Environmental_comfort.htm
http://www.designbuilder.co.uk/helpv4.7/#Generic_AHU.htm?Highlight=Generic
http://www.designbuilder.co.uk/helpv4.7/#Generic_AHU.htm?Highlight=Generic
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SOLUTION

Step 1: Open the fixed dry bulb model saved in 
Tutorial 8.6. Enter 8.0 in Heating set back (°C) and 35.0 
in Cooling set back (°C) text boxes in the Activity tab.

Step 2: Click Air Loop AHU in the navigation tree. 
Click Edit component under the Help tab. The Edit Air 
handling unit screen appears. 
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Step 3: Under the Night Cycle section, select Stay off 
from the Control type drop down menu and select 8:00 - 
18:00 Mon - Fri under the Operation section and make 
sure Heat Recovery check box is clear under Outdoor 
Air System tab. 

Step 4: Simulate the model and record the results.

Step 5: Repeat the previous steps to select Cycle on 
any from the Control type drop down menu and select 
8:00 - 18:00 Mon - Fri under the Operation section. 

Step 6: Simulate the model and record the results.

Compare the results (Table 8.7).

You can observe that there is an increase in systems 
fans, cooling and heating energy consumption. This is 
due to the reason that when the Cycle on any option is 
selected, fan runs for additional duration in unoccupied 
hours.
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Table 8.7 Energy consumption in changing supply air fan 
operating mode

End-use categories

Annual energy consumption (kWh)

Stay off Cycle on any

Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
System fans 36,524.22 61,160.97
System pumps 4,894.60 11,862.04
Heating (electricity) 161.73 32,574.40
Cooling (electricity) 149,971.20 258,275.00
Heat rejection 17,444.70 40,430.50

TUTORIAL 8.8  Evaluating the impact of heat recovery 
between fresh and exhaust air

GOAL 

To evaluate the impact of recovering heat between fresh air 
intake and exhaust on building energy performance. 

WHAT ARE YOU GOING TO LEARN? 

• Modelling the heat recovery system

PROBLEM STATEMENT 

In this tutorial, you are going to use the air-cooled chiller 
model saved in Tutorial 8.1 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You need to simulate the model with the following three 
options: 

 1. No heat recovery

 2. Sensible heat recovery

 3. Enthalpy-based heat recovery

Codes such as ASHRAE 90.1-2010 Appendix G, requires 
that schedules for HVAC fans, which provide outdoor air 
for ventilation, shall run continuously whenever spaces 
are occupied and shall be cycled on and off to meet heat-
ing and cooling loads during unoccupied hours.
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Find out energy for all the cases.

Use New Delhi/Palam, India weather location.

Energy recovery ventilation is the energy recovery pro-
cess of exchanging the energy contained in air exhausted 
from building or space air and using it to treat (precon-
dition) the incoming outdoor ventilation air in HVAC 
systems. Air-to-air energy recovery reduces energy use 
and can significantly reduce heating and cooling system 
sizes. The driving force behind the exchange is the differ-
ence in temperatures between the opposing air streams, 
which is also called the thermal gradient.

Supply fresh air with
heat recovery

Part of return air at
room temperature for

exhaust

Exhaust air

Cold outside air

There are two types of heat recovery: 

 1. Sensible

 2. Enthalpy (The enthalpy of moist and humid air 
in cludes the enthalpy of the dry air – the sensible heat and 
the enthalpy of the evaporated water – the latent heat.)

Sensible heat recovery is possible by the use of fixed plate 
heat exchangers. A fixed plate heat exchanger has no mov-
ing parts, and consists of alternating layers of plates that 
are separated and sealed. Typical flow is cross current, and 
since the majority of plates are solid and non-permeable, 
sensible only transfer is the result. Sensible heat recovery 
is also possible through a rotating wheel heat exchanger.

Enthalpy heat recovery is possible by the use of a rotating 
wheel heat exchanger. Rotating wheel heat exchanger is 
composed of a rotating cylinder filled with an air permeable 
material resulting in a large surface area. The surface area 
is the medium for the sensible energy transfer. As the wheel

(Continued)
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SOLUTION

Step 1: Open the air-cooled chiller model saved in 
Tutorial 8.1. Select the Activity tab. Enter 7.100 in 
the Fresh air (l/s-person) text box in the Minimum 
Fresh Air tab and select 24×7 Generic Office Area as 
Template.

rotates between the ventilation and exhaust air streams, 
it picks up heat energy and releases it into the colder air 
stream.

The enthalpy exchange is accomplished through the use 
of desiccants. Desiccants transfer moisture through the 
process of adsorption that is predominantly driven by 
the difference in the partial pressure of vapour within the 
opposing air streams. Typical desiccants consist of silica 
gel and molecular sieves.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/Unitary_Heat_Recovery.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Unitary_Heat_Recovery.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Unitary_Heat_Recovery.htm
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Step 2: Click Air Loop AHU in the navigation tree. 
Click Edit component under the Help tab. The Edit Air 
Handling Unit Data screen appears. 

Step 3: Select the Outdoor Air System tab. Select the 
On checkbox under Heat Recovery. Make sure that 
Plate is selected from the Heat exchanger type drop-
down list. 



296 BUILDING ENERGY SIMULATION

Step 4: Click HW Loop in the navigation tree. Click 
Edit loop data under the Help tab. The Edit Plant loop 
screen appears. 

Step 5: Select Off 24/7 in the Availability schedule. 
Click OK. 

Step 6: Simulate the model and record the results.

Step 7: Select Rotary from the Heat exchanger type 
drop-down list. Enter 0.70 under Latent effectiveness. 
Click OK. 
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Step 8: Simulate the model and record the results.

Step 9: Simulate the model and record the results with-
out heat recovery. You can do it by clearing the On 
check box under the Heat Recovery section. Click OK. 

Compare the results (Table 8.8).
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You can observe that there is a decrease in cooling 
energy consumption with sensible heat recovery. Use of 
enthalpy heat recovery gives higher savings.

Generally, there is an increase in fan energy consump-
tion with the heat recovery system. This is due to the 
increase in static pressure of the fan for the heat recov-
ery wheel. To model this effect in the compact option, 
you need to change the fan pressure rise.

Building an air conditioning system requires fresh air 
 supply to maintain indoor air quality. There are differ-
ent standards such as ASHRAE 60.1-2010 that specify 
 minimum fresh air requirements in different space types. 
In a cold climate, the temperature of fresh air is lower 
than the exhaust air (which is nearly at the room tem-
perature). Bringing fresh air temperature from low to 
room temperature requires heating energy. Similarly, in 
hot climates bringing fresh air temperature from hot to 
room temperature requires cooling energy. Recovering 
heat/coolth from outgoing air offers energy saving 
opportunity.

Table 8.8 Effect of exhaust air heat recovery in the HVAC system

Annual energy consumption (kWh)

None
Sensible heat 
recovery

Enthalpy heat 
recovery

Room electricity 271,405.70 271,405.70 271,405.70
Lighting 619,839.30 619,839.30 619,839.30
System fans 186,069.30 186,036.80 186,031.70
System pumps 2,306.85 2,264.16 1,989.80
Cooling (electricity) 630,411.30 613,200.20 578,378.80
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Nominal electric power
This is the electric consumption rate of the device (W). 
Electric power is considered constant whenever the unit 
operates. This numeric input can be used to model elec-
tric power consumption by controls (transformers, relays, 
etc.) and/or a motor for a rotary heat exchanger. None of 
this electric power contributes thermal load to the supply 
or exhaust air streams. The default value for this field is 0.

Economiser lockout
This input denotes whether the heat exchanger unit is 
locked out (bypassed for plate type heat exchangers or 
the rotation is suspended for rotary type heat exchang-
ers) when the air-side economiser is operating. Both the 
economiser and high humidity control activate the heat 
exchanger lockout as specified by this input. The input 
choices are Yes (meaning locked out) or No.

Sensible effectiveness at 100% heating air flow
The sensible heat exchange effectiveness at the heating 
condition defined in the above table with both the supply 
and exhaust air volume flow rates is equal to 100% of 
the nominal supply air flow rate specified in the previous 
input field. The default value for this field is 0.

Latent effectiveness at 100% heating air flow
The latent heat exchange effectiveness at the heating con-
dition defined in the Operating Conditions for Defining 
Heat Exchanger Performance table with both the supply 
and exhaust air volume flow rates is equal to 100% of the 
nominal supply air flow rate. Specify this value as 0.0 if 
the heat exchanger does not transfer latent energy. The 
default value for this field is 0.

Sensible effectiveness at 75% heating air flow
The sensible heat exchange effectiveness at the heating 
condition defined in the Operating Conditions for Defining 
Heat Exchanger Performance table with both the supply and 
exhaust air volume flow rates is equal to 75% of the nominal 
supply air flow rate. The default value for this field is 0.

Latent effectiveness at 75% heating air flow
The latent heat exchange effectiveness at the heating con-
dition defined in the Operating Conditions for Defining 

(Continued)
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Heat Exchanger Performance table with both the supply 
and exhaust air volume flow rates is equal to 75% of the 
nominal supply air flow rate. Specify this value as 0.0 if 
the heat exchanger does not transfer latent energy. The 
default value for this field is 0.

Sensible effectiveness at 100% cooling air flow
The sensible heat exchange effectiveness at the cooling 
condition defined in the Operating Conditions for Defining 
Heat Exchanger Performance table with both the supply and 
exhaust air volume flow rates is equal to 100% of the nominal 
supply air flow rate. The default value for this setting is 0.

Latent effectiveness at 100% cooling air flow
The latent heat exchange effectiveness at the cooling con-
dition defined in the Operating Conditions for Defining 
Heat Exchanger Performance table with both the supply 
and exhaust air volume flow rates is equal to 100% of the 
nominal supply air flow rate. Specify this value as 0.0 if 
the heat exchanger does not transfer latent energy. The 
default value for this setting is 0.

Sensible effectiveness at 75% cooling air flow
The sensible heat exchange effectiveness at the cool-
ing condition defined in the Operating Conditions for 
Defining Heat Exchanger Performance table with both 
the supply and exhaust air volume flow rates is equal to 
75% of the nominal supply air flow rate. The default value 
for this setting is 0.

Latent effectiveness at 75% cooling air flow
The latent heat exchange effectiveness at the cooling con-
dition defined in the Operating Conditions for Defining 
Heat Exchanger Performance table with both the supply 
and exhaust air volume flow rates is equal to 75% of the 
nominal supply air flow rate. Specify this value as 0.0 if 
the heat exchanger does not transfer latent energy. The 
default value for this field is 0.

Source: http://www.designbuilder.
co.uk/helpv4.7/#Generic_AHU.

htm?Highlight=Generic AHU.htm

http://www.designbuilder.co.uk/helpv4.7/#Generic_AHU.htm?Highlight=GenericAHU.htm
http://www.designbuilder.co.uk/helpv4.7/#Generic_AHU.htm?Highlight=GenericAHU.htm
http://www.designbuilder.co.uk/helpv4.7/#Generic_AHU.htm?Highlight=GenericAHU.htm
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Exercise

Repeat the tutorial for Montreal, Canada climate.

TUTORIAL 8.9  Evaluating the impact of boiler 
nominal thermal efficiency

GOAL 

To evaluate the impact of boiler efficiency on building 
energy performance.

WHAT ARE YOU GOING TO LEARN? 

• Changing boiler efficiency

PROBLEM STATEMENT 

In this tutorial, you are going to use the air-cooled chiller 
model saved in Tutorial 8.1 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You need to simulate the model with the following boiler 
efficiencies ranging from 0.89 to 0.95 in increment of 0.02. 
Find out energy consumption for all the cases.

Use PARIS-AEROPORT CHAR, France weather location.

Nominal thermal efficiency
This is the heating efficiency (as a fraction between 0 and 1) 
of the boiler’s burner relative to the higher heating value 
(HHV) of fuel at a part load ratio of 1.0. Manufacturers 
typically specify the efficiency of a boiler using the higher 
heating value of the fuel. For the rare occurrences when a 
manufacturer’s (or particular data set) thermal efficiency is 
based on the lower heating value (LHV) of the fuel, multiply 
the thermal efficiency by the lower-to-higher heating value 
ratio. For example, assume that a fuel’s lower and higher 
heating values are approximately 45,450 and 50,000 kJ/kg, 
respectively. For a manufacturer’s thermal efficiency rating 
of 0.90 (based on the LHV), the nominal thermal efficiency 
entered here is 0.82 (i.e. 0.9 multiplied by 45,450/50,000).

Heating value: The amount of heat produced by a com-
plete combustion of fuel and it is measured as a unit of 
energy per unit mass or volume of substance (e.g. kcal/kg, 
kJ/kg, J/mol and Btu/m3).

(Continued)
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SOLUTION

Step 1: Open the simulation model created in Tutorial 8.1 
with an air-cooled chiller. Click HW Loop.

Step 2: Click HW Loop Supply Side. 

Step 3: Click Boiler. Click Edit component under the 
Help tab. The Edit Hot Water Boiler screen appears. 

HHV is defined as the gross calorific value, defined as 
the amount of heat released when fuel is combusted and 
the products have returned to a temperature of 25°C. The 
heat of condensation of the water is included in the total 
measured heat.

The LHV is defined as the net calorific value and is deter-
mined by subtracting the heat of vaporization of water 
vapour (generated during combustion of fuel) from the HHV.

Source: http://www.designbuilder.
co.uk/helpv4.7/#Boilers.htm

http://www.designbuilder.co.uk/helpv4.7/#Boilers.htm
http://www.designbuilder.co.uk/helpv4.7/#Boilers.htm
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Step 4: Enter 0.890 in the Nominal thermal efficiency 
text box under the Efficiency subtab. 

Step 5: Simulate the model and record the results.

Step 6: Repeat the previous steps to simulate the model 
with 0.91, 0.93 and 0.95 nominal thermal efficiencies 
(Table 8.9). 
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Table 8.9 Energy consumption with change in nominal thermal 
efficiency

End-use 
category

Annual energy consumption (kWh)

0.89 0.91 0.93 0.95

Room 
electricity

153,342.90 153,342.90 153,342.90 153,342.90

Lighting 221,613.80 221,613.80 221,613.80 221,613.80
System fans 128,277.70 128,277.70 128,277.70 128,277.70
System pumps 419.34 419.34 419.34 419.34
Heating (gas) 423,825.50 414,510.70 405,596.40 397,057.60
Cooling 
(electricity)

255,680.80 255,680.80 255,680.80 255,680.80
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CHAPTER NINE

Simulation Parameters

This chapter will help you to understand the nuances of 
simulation engine settings that not only affect the accuracy 
of calculations but also affect the run time of a model. This 
becomes very important especially for large building models. 
Three concepts covered in this chapter are time step, which 
may be treated analogous to the least count of the model, 
method of calculation for energy balance and the algorithm 
for convective heat transfer in various building components. 
Simulation tools offer freedom to choose a smaller time step 
at the cost of a significant increase in running time. Similarly, 
the calculation method and convection algorithm are also 
associated with the accuracy of calculation at the cost of run 
time. These tutorials help in understanding the methods as 
well as the extent of difference that is obtained in the results 
while using different approaches. This information can be 
useful to the simulator to decide the appropriate simulation 
setting as per the availability of computing power, time and 
requirement of accuracy.
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TUTORIAL 9.1  Evaluating the impact of time 
steps per hour on run time

GOAL 
To evaluate the change in simulation run time with the 
change in time steps per hour.

WHAT ARE YOU GOING TO LEARN?

• Changing time steps per hour

PROBLEM STATEMENT 

In this tutorial, you are going to use the water-cooled chiller 
model saved in Tutorial 8.1 (50 m × 25 m model with 5 m 
perimeter depth, six floors).

You are going to use the following time steps per hour:

2, 10, 30 and 60.

Find the change in energy consumption and run time for 
all cases.

Use Brisbane Aero, Australia weather location.

Simulation time steps define the interval at which the 
heat transfer calculations are performed. In EnergyPlus 
(which is the simulation engine of DesignBuilder), this 
minimum time step is 1, which means that the heat trans-
fer and load calculation are performed on an hourly basis. 
The maximum number of time steps that can be assigned 
is 60, which means the calculations are performed for 
every minute. The allowed options for time steps are 1, 2, 
3, 4, 5, 6, 10, 15, 20, 30 and 60. The higher the number of 
time steps, the more precise are the results.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/Calculation_Options.htm

Caution: Note the difference between simulation time steps, 
simulation period (also called run period) and run time. A run 
period is the time of the year for which the calculation should 
be performed, whereas time step is the frequency at which 
these calculations are performed. Further, run time is the time 
taken for performing energy simulation. Run time depends 
on several factors such as the complexity of the model, the 
speed of the computer  hardware, run period and the time step.

http://www.designbuilder.co.uk/helpv4.7/Content/Calculation_Options.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Calculation_Options.htm
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SOLUTION

Step 1: Open the simulation model saved in Tutorial 8.1. 
Select the Simulation tab. The Edit Calculation 
Options screen appears.

Step 2: Select the Options tab. 

Step 3: Select 2 from the Time steps per hour drop-
down list and click OK. 

Step 4: Perform annual simulation and note down the 
results for energy and run time.
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Step 5: Repeat the previous steps for the time steps 10, 
30 and 60.

Compare the run time for all the cases (Table 9.1).
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How to record the run time:

After the simulation is complete, open the eplusout.err 
file from the EnergyPlus folder. You can use any text 
editor to view this file. 

At the end of the file, you can find Elapsed Time.

You need to record the elapsed time.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/_DesignBuilder_files_

location_and_extensions.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_DesignBuilder_files_location_and_extensions.htm
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You can observe from the results that as the number of 
time steps per hour increases, the simulation run time 
also increases. You can also observe a slight change in 
the HVAC energy consumption due to the change in the 
resolution of energy calculations. Please note that since 
the above-mentioned run times depend on the system 
configuration, your results might differ from the ones 
shown above. However, the trend would remain the 
same. In most cases, the difference in the results is very 
less, of the order of 1%; hence, unless necessary, use of 
smaller time steps is not recommended.

Save the simulation model with time steps 2 per hour to 
use in subsequent tutorials.

Table 9.1 Variation of annual energy consumption with 
variation in time steps

Time steps 
2 per hour

Time steps 
10 per 
hour

Time 
steps 30 
per hour

Time steps 
60 per 
hour

Run time 
(min)

0:24 1:15 2:59 5:43

Room 
electricity

153,342.9 153,342.9 153,342.9 153,342.9

Lighting 221,613.8 221,613.8 221,613.8 221,613.8
System fans 132,544 133,927.5 134,233.3 134,310.2
System 
pumps

8,179.506 8,246.28 8,260.38 8,264.02

Heating (gas) 80,341.41 85,960.33 87,098.55 87,375.35
Cooling 
(electricity)

231,246.2 232,903.3 233,253.2 233,372.8

Heat 
rejection

53,253.13 55,180.27 55,330.14 55,359.05
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TUTORIAL 9.2  Evaluating the impact of the solar 
distribution algorithm

GOAL 

To evaluate the impact of the solar distribution algorithm 
on energy consumption and simulation run time.

WHAT ARE YOU GOING TO LEARN?

• Changing the solar distribution algorithm

PROBLEM STATEMENT 

In this tutorial, you are going to use the time steps 2 per 
hour as the model saved in Tutorial 9.1 (50 m × 25 m model 
with 5 m perimeter depth, six floors). Add 1 m overhang on 
all the windows.

You need to select the following solar distribution:

 a. Full exterior

 b. Minimal shading

Find the change in energy consumption for both cases.

Use AZ – PHOENIX/SKY HARBOR, Arizona, USA 
weather location.

This option determines how EnergyPlus treats beam solar 
radiation and reflectance from exterior surfaces that strike 
the building and, ultimately, enter the zone.

(1) Minimal shadowing: in this case, there is no exte-
rior shadowing except from window and door reveals. 
All beam solar radiation entering the zone is assumed 
to fall on the floor, where it is absorbed according to 
the floor’s solar absorptance. Any reflected by the floor 
is added to the transmitted diffuse radiation, which is 
assumed to be uniformly distributed on all interior sur-
faces. If no floor is present in the zone, the incident 
beam solar radiation is absorbed on all interior surfaces 
according to their absorptances. The zone heat balance 
is then applied at each surface and on the zone’s air 
with the absorbed radiation being treated as a flux on 
the surface.

(Continued)
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SOLUTION

Step 1: Open the simulation model saved in Tutorial 9.1 
with time steps per hour as 2.

Step 2: Select the Openings tab. Select the Local 
Shading check box in the Shading section. Select 1.0 m 
Overhang as Type. 

(2) Full exterior: in this case, shadow patterns on 
exterior surfaces caused by detached shading, wings, 
overhangs, and exterior surfaces of all zones are com-
puted. As for Minimal shadowing, shadowing by win-
dow and door reveals is also calculated. Beam solar 
radiation entering the zone is treated as for ‘Minimal 
 shadowing’—all beam solar radiation entering the zone 
is assumed to fall on the floor, where it is absorbed 
according to the floor’s solar absorptance. Any reflected 
by the floor is added to the transmitted diffuse radiation, 
which is distributed among interior surfaces according 
to view factors. If no floor is present in the zone, the 
incident beam solar radiation is absorbed on all interior 
surfaces according to their absorptance.

(3) Full interior and exterior: this is the same as Full 
exterior except that instead of assuming all transmitted 
beam solar falls on the floor the program calculates the 
amount of beam radiation falling on each surface in the 
zone, including floor, walls and windows, by project-
ing the sun’s rays through the exterior windows, taking 
into account the effect of exterior shadowing surfaces 
and window shading devices. If this option is used, 
you should be sure that the surfaces of the zone totally 
enclose a space. This can be determined by viewing the 
eplusout.dxf file with an external DXF viewer program.

Source: http://www.designbuilder.co.uk/
helpv4.7/#Solar_Options.htm

http://www.designbuilder.co.uk/helpv4.7/#Solar_Options.htm
http://www.designbuilder.co.uk/helpv4.7/#Solar_Options.htm
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Step 3: Select the HVAC tab and select Detailed HVAC 
detail under Info, Help. 

Step 4: Click Simple under the HVAC slider. 



313chapter NINe SImulatIoN par ameterS

Step 5: Select the Simulation tab. The Edit Calculation 
Options screen appears.

Step 6: Select the Options tab. Expand the Solar section. 
Select Full exterior from the Solar distribution drop-
down list. Click OK. 

Step 7: Simulate the model and record the results for 
energy and simulation run time.

Step 8: Select the Summary tab and click Table of 
Contents. 
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Step 9: Click the Sensible Heat Gain Summary link. 

Step 10: Copy the table Annual Building Sensible Heat 
Gain Components to a spreadsheet program. (You need 
to select the table and right click and select copy and 
paste in the spreadsheet.) 
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Step 11: Repeat the previous steps to select Minimal shad­
owing from the Solar distribution drop-down list. 

Step 12: Click OK. Record the results.

Compare results for both simulations (Tables 9.2 
and 9.3).

It can be observed from the results that with the Minimal 
shading option, there is an increase in the HVAC energy 
consumption, as there is no exterior shadowing consid-
ered in the calculations except from window and door 
reveals.

The results also show that the window heat gain is lesser 
with Full exterior. This is because the shadow patterns on 
the exterior surface caused by overhangs and exterior sur-
faces are taken into account for calculations.

Table 9.2 Variation of annual energy consumption with 
variation in local shading

Annual fuel breakdown 
consumption (kWh)

Full exterior Minimal shading

Run time 0:16 0:14
Room electricity 153,342.90 153,342.90
Lighting 221,613.80 221,613.80
Heating (gas) 10,616.47 8,836.53
Cooling (electricity) 256,906.00 287,547.30
DHW (electricity) 13,875.00 13,875.00



316 BUILDING ENERGY SIMULATION

Save the model to use in the next tutorial.

Exercise 9.1

Repeat the above tutorial for the Full interior and exterior solar 
distribution algorithm.

TUTORIAL 9.3  Evaluating the impact of the 
solution algorithm

GOAL 

To evaluate the building energy performance and the run 
time with the change in the solution algorithm.

WHAT ARE YOU GOING TO LEARN?

• Changing the solution algorithm

PROBLEM STATEMENT 

In this tutorial, you are going to use the simulation model 
saved in Tutorial 9.1 with time steps per hour as 2.

You need to select the following algorithms:

 1. Conduction Transfer Function

 2. Finite Difference

Table 9.3 Heat gains from window

Window heat addition (GJ)

Minimal Full exterior

Ground: West 72.42 48.44
Ground: North 57.40 51.35
Ground: East 71.50 47.74
Ground: South 169.90 96.46
Ground: Core – –
Middle: West 68.29 45.60
Middle: North 53.42 47.73
Middle: East 67.08 44.72
Middle: South 161.26 91.53
Middle: Core – –
Top: West 69.19 46.11
Top: North 54.05 47.96
Top: East 68.17 45.24
Top: South 162.27 91.54
Top: Core – –
Total facility 1,074.94 704.41
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Find the change in energy consumption with both cases.

Use AZ – PHOENIX/SKY HARBOR, Arizona, USA 
weather location.

SOLUTION

Step 1: Open the simulation model saved in Tutorial 9.1 
with time steps per hour as 2. Select the Simulation tab.

Step 2: Select the Options tab and expand the Advanced 
section. 

CTF: the default method used in EnergyPlus for CTF 
calculations is known as the state space method. CTF is a 
sensible heat-only solution not taking into account mois-
ture storage or diffusion in the  construction elements.

Finite Difference: this solution technique uses a 1-D 
finite difference solution in the construction  elements. 
It is a sensible heat-only solution and does not take into 
account moisture storage or diffusion in the construction 
elements.

Finite Difference Settings

The settings below are required when the general solution 
algorithm is set to 2-Finite Difference or if any construc-
tions used in the simulation override the general setting 
to use the Finite Difference algorithm.

Difference Scheme

This field determines the solution scheme used by the 
Conduction Finite Difference model.

There are two options:

(1) Fully implicit first-order scheme, which is first order 
in time and is more stable over time. But it may be slower 
than option 2.

(2) Crank Nicholson second order, which is second order 
in time and may be faster than option 1, but it can be 
unstable over time when boundary conditions change 
abruptly and severely.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/Advanced_Calculation_Options.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Advanced_Calculation_Options.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Advanced_Calculation_Options.htm
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Step 3: Select Conduction Transfer Function from the 
Solution algorithm drop-down list. 

Step 4: Simulate the model and record the results.

Step 5: Repeat previous steps and select Finite Differ­
ence from the Solution algorithm drop-down list. 
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Step 6: Simulate the model and record the results.
Compare the results for both simulations (Table 9.4).
It can be seen from the results that with the Finite Difference 
method there is an increase in the simulation run time.

TUTORIAL 9.4  Evaluating the effect of the inside 
convection algorithm

GOAL 

To evaluate building energy performance with the change 
in the inside convection algorithm.

WHAT ARE YOU GOING TO LEARN?

• Changing the inside convection algorithm

PROBLEM STATEMENT 

In this tutorial, you are going to use the simulation model 
saved in Tutorial 9.1 with time steps per hour as 2.

You are going to select the following algorithms:

 1. Adaptive convection

 2. Simple

 3. CIBSE

 4. TARP

Find the change in energy consumption for all cases.

Use PARIS­AEROPORT CHAR, France weather location.

Table 9.4 Variation in simulation run time with variation in the 
solution algorithm

Annual fuel breakdown consumption (kWh)

Conduction 
Transfer Function

Finite Difference (fully 
implicit first order)

Run time 0:27 3:57
Room electricity 153,342.90 153,342.90
Lighting 221,613.30 221,613.80
System fans 155,002.60 156,511.60
System pumps 7,939.26 8,021.31
Heating (electricity) 101,686.90 106,023.80
Cooling (electricity) 230,764.70 232,707.50
Heat rejection 51,146.54 51,847.43
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Inside convection algorithm
You can select from six main EnergyPlus inside convec-
tion algorithms for calculating the convection between 
internal zone surfaces and the rest of the zone air in the 
simulation calculations. Unless you have a good reason to 
do so, you are advised to use the default TARP convec-
tion algorithm.

• 1­Adaptive convection algorithm: this advanced 
option provides a dynamic selection of convection 
models based on conditions. Beausoleil–Morrison 
(2000, 2002) developed a methodology for dynami-
cally managing the selection of hc equations, called 
the adaptive convection algorithm. The algorithm 
is used to select among the available hc equations 
for the one that is most appropriate for a given sur-
face at a given time. As Beausoleil–Morrison notes, 
the adaptive convection algorithm is intended to be 
expanded and altered to reflect different classifica-
tion schemes and/or new hc equations. The adaptive 
convection algorithm implemented in EnergyPlus 
for the inside face has a total of 45 different cat-
egories for surfaces and 29 different options for 
hc equation selections. The tables provided in the 
Engineering document summarize the categories 
and the default assignments for hc equations.

• 2­Simple: the simple convection model uses con-
stant coefficients for different heat transfer con-
figurations, using the criteria to determine reduced 
and enhanced convections. The coefficients are 
taken directly from Walton (1983). Walton derived 
his coefficients from the surface conductance for 
ε = 0.90 found in the ASHRAE Handbook (1985) 
in Table 1 on p. 23.2. The radiative heat transfer 
component was estimated at 1.02 * 0.9 = 0.918 
BTU/h ft2 F and then subtracted off. Finally, the 
coefficients were converted to SI units to yield the 
following values. For a vertical surface, hc = 3.076. 
For a horizontal surface with reduced convection, 
hc = 0.948. For a horizontal surface with enhanced 
convection, hc = 4.040. For a tilted surface with 

(Continued)
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reduced convection, hc = 2.281. For a tilted surface 
with enhanced convection, hc = 3.870.

• 3­CIBSE: applies constant heat transfer coefficient 
derived from traditional CIBSE values.

• 4­Ceiling diffuser: a mixed and forced convection 
model for ceiling diffuser configurations. The model 
correlates the heat transfer coefficient to the air change 
rate for ceilings, walls and floors. The ceiling diffuser 
algorithm is based on empirical correlations developed 
by Fisher and Pedersen (1997). The correlation was 
reformulated to use the room outlet temperature as 
the reference temperature. The correlations are shown 
below. For floors, hc = 3.873 + 0.082 × ACH ^ 0.98. 
For ceilings, hc = 2.234 + 4.099 × ACH ^ 0.503. For 
walls, hc = 1.208 + 1.012 × ACH ^ 0.604.

• 5­Cavity: this algorithm was developed to model 
convection in a ‘Trombe wall zone’ that is the air 
space between the storage wall surface and the exte-
rior glazing. (See the later sections on Passive and 
Active Trombe Walls below for more information 
about Trombe walls.) The algorithm is identical to 
the convection model (based on ISO 15099) used in 
Window5 for convection between glazing layers in 
multipane window systems. The use of the algorithm 
for modelling an unvented Trombe wall has been 
validated against experimental data by Ellis (2003). 
This algorithm gives the convection coefficients for 
air in a narrow vertical cavity that is sealed and not 
ventilated. This applies both to the air gap in between 
panes of a window and to the air gap between the 
Trombe wall glazing and the inner surface (often a 
selective surface). These convection coefficients are 
really the only difference between a normal zone and 
a Trombe zone. See also the note below.

• 6­TARP: based on variable natural convec-
tion based on the temperature difference from 
ASHRAE algorithms. This is the same as the old 
‘Detailed’ Inside convection algorithm provided in 
earlier versions of DesignBuilder.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/Surface_Convection.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Surface_Convection.htm
http://www.designbuilder.co.uk/helpv4.7/Content/Surface_Convection.htm
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SOLUTION

Step 1: Open the simulation model saved in Tutorial 9.1 
with time steps per hour as 2.

Step 2: Select the Simulation tab.

Step 3: Select the Options tab and expand the Advanced 
section. 

Step 4: Select Adaptive Convection Algorithm from 
the Inside convection algorithm drop-down list in the 
Convection section. 

Step 5: Click OK and note down the results.
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Step 6: Repeat the previous steps for Simple, CIBSE 
and TARP from the Inside convection algorithm drop-
down list.

Compare the results for simulations (Table 9.5).

Difference in the HVAC energy consumption and the run 
time while using different algorithms can be noted from 
the above table.

Exercise 9.2

Repeat the above tutorial to evaluate the building energy per-
formance with the change in the outside convection algorithm.

You need to select the following algorithms:

 1. Adaptive convection

 2. Simple combined

 3. TARP

 4. DOE-2

Use PARIS­AEROPORT CHAR, France weather location.

Table 9.5 Variation in simulation run time with variation in the 
inside convection algorithm

Annual fuel breakdown consumption (kWh)

Adaptive 
convection 
algorithm Simple CIBSE TARP

Run time (min) 0.27 0.22 0.19 0.20
Room 
electricity

153,342.90 153,342.90 153,342.90 153,342.90

Lighting 221,613.80 221,613.80 221,613.80 221,613.80
System fans 122,129.20 131,199.00 134,431.30 128,277.70
System pumps 4,215.91 4,841.64 5,136.61 4,664.57
Heating (gas) 417,841.00 437,897.80 440,730.00 423,825.50
Cooling 
(electricity)

86,390.53 98,280.73 102,366.10 94,650.77

Heat rejection 26,360.16 30,413.91 31,752.80 29,144.83
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TUTORIAL 9.5  Evaluating the impact of the 
shadowing interval

GOAL

To evaluate the impact of the shadowing interval on the 
building energy consumption.

WHAT ARE YOU GOING TO LEARN?

• Changing the shadowing interval

PROBLEM STATEMENT 

In this tutorial, you are going to use the simulation model 
saved in Tutorial 9.2 with Full exterior.

You are going to simulate the model for the following 
intervals:

5, 10, 20 and 30 days

Use New Delhi/Palam, India weather location.

Shadowing interval is important for determining the 
amount of sun entering your building and by inference 
the amount of cooling or heating load needed for main-
taining the building. Though termed ‘shadowing’ cal-
culations, it in effect determines the sun’s position on a 
particular day in a weather file period simulation. (Each 
design day will use the date of the design day object.) 
Even though weather file data contain the amount of solar 
radiation, the internal calculation of the sun’s position 
will govern how it affects various parts of the building.

By default, the calculations are done for every 20 days 
throughout a weather run period; an average solar posi-
tion is chosen and the solar factors (such as sunlit areas 
of surfaces) remain the same for that number of days. 
More integrated calculations are needed for controlling 
dynamic windows or shades.

Source: EnergyPlus InputOutput Reference
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SOLUTION

Step 1: Open the simulation model saved in Tutorial 9.2.

Step 2: Select the Simulation tab.

Step 3: Select the Options tab. 

Step 4: Type 5 in the Shadowing interval (days). 
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Step 5: Simulate the model and record the results.

Step 6: Repeat previous steps for shading intervals of 10, 
20 and 30 days.

Compare the data for all the cases (Table 9.6).

 

Table 9.6 Variation in simulation run time with variation in the 
shadowing interval

Annual fuel breakdown data

End use 
component

Shading interval

5 days 10 days 20 days 30 days

Run time (min) 0:18 0.15 0.14 0.13
Room electricity 153,342.90 153,342.90 153,342.90 153,342.90
Lighting 221,613.80 221,613.80 221,613.80 221,613.80
Heating (gas) 10,568.76 10,578.89 10,616.47 10,658.09
Cooling 
(electricity)

256,742.50 256,770.60 256,906.00 256,897.60

DHW 
(electricity)

13,875.00 13,875.00 13,875.00 13,875.00
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CHAPTER TEN

Natural Ventilation

The method of simulating natural ventilation is somewhat 
different from that of simulating HVAC components. Natural 
ventilation is often achieved either using windows or using 
ventilation fans. Simulation tools can model both the cases 
and can predict the thermal conditions of indoors. Mixed-
mode buildings, which use both natural ventilation when 
ambient conditions are moderate and HVAC system when it 
is harsh, can also be modelled by defining the opening of 
windows and operation of HVAC in the simulation model. 
In this chapter, the method of modelling naturally ventilated 
buildings is explained through six  tutorials. Various aspects 
of modelling of natural ventilation, such as how to define 
window opening, how to define scheduled opening and clos-
ing of windows and the impact of window opening on indoor 
conditions are explained. Design issues such as the size of the 
openable window and the temperature-controlled automatic 
opening of windows are also discussed.
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TUTORIAL 10.1  Evaluating the impact of wind 
speed on natural ventilation

GOAL

To evaluate the impact of the change in wind speed on ven-
tilation rate.

WHAT ARE YOU GOING TO LEARN?

• Modelling natural ventilation

• Defining glazing area openings for natural ventilation

PROBLEM STATEMENT

In this tutorial, you are going to use a 10 m × 10 m single-
zone model.

Find zone air changes for the model with natural ventilation.

Use New Delhi/Safdarjung, India weather location.

SOLUTION

Step 1: Open a new blank project file and create a 
10 m × 10 m single-zone building. Select the Activity tab.

There are two general approaches to natural ventilation 
and infiltration modelling in DesignBuilder depending on 
the setting of the Natural ventilation model option:

• Scheduled in which the natural ventilation change 
rate is explicitly defined for each zone in terms of a 
maximum ACH value and a schedule, and infiltra-
tion air change rate is defined by a constant ACH 
value. A range of control options are provided.

• Calculated where natural ventilation and infiltra-
tion are calculated based on window openings, 
cracks, buoyancy and wind-driven pressure differ-
ences, crack dimensions and so on. Control options 
are provided.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/_Natural_ventilation_modelling.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Natural_ventilation_modelling.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Natural_ventilation_modelling.htm
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Step 2: Select the 24×7 Generic Office Area template. 
Set Fresh air (l/s-person) and Mech vent per area (l/s-
m2) to 0.

Step 3: Select the HVAC tab. Select the Natural 
 ventilation – No Heating/Cooling template. 
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Step 4: Click Simple under the Help tab. 

Step 5: Click Calculated under Natural ventilation. 
Click OK. 

Step 6: Click the Options sub-section in the Natural 
Ventilation section and select Constant for the External 
control mode and Internal control mode drop-down lists. 



331chapter teN Natur al VeNtilatioN

Step 7: Select the Opening tab. Set Window to wall % to 20.00. 
Click the Free Aperture section. Set % Glazing area opens 
to 100.0 and select On 24/7 in Operation schedule. 

Step 8: Perform hourly simulation. After simulation, 
click Clear all.

Step 9: Now click the links Fabric and ventilation and 
Site from Add Data to record the results for Wind speed 
and Mechanical ventilation. Select Grid in the Show as 
dropdown list. 

Constant – Whenever an opening’s operation schedule 
allows venting, all of the zone’s openable windows and 
doors are open, independent of indoor or outdoor condi-
tions. Note that ‘Constant’ here means that the size of 
each opening is fixed while venting; the air flow through 
each opening can, of course, vary from time step to 
time step. This option allows modelling of a window 
that is opened for fresh air regardless of inside/outside 
temperature/enthalpy.

Source: http://www.designbuilder.co.uk/
helpv4.7/Content/CalculatedNatVent.htm

http://www.designbuilder.co.uk/helpv4.7/Content/CalculatedNatVent.htm
http://www.designbuilder.co.uk/helpv4.7/Content/CalculatedNatVent.htm
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Export the results to a spreadsheet and plot a scatter graph 
between Mech Vent + Nat Vent + Infiltration (ac/h) and 
Wind speed (m/s).
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You can observe that with an increase in wind speed, 
there is an increase in zone air change.

Step 10: Repeat the above tutorial with Scheduled under 
Natural ventilation. 

Step 11: Select the Activity tab. Clear both Indoor 
min and max temperature control checkboxes in the 
Natural Ventilation section. 

Scheduled – the ventilation rates are predefined using 
a maximum air change rate modified by operation 
schedules.

Source: http://www.designbuilder.co.uk/helpv4.7/
Content/_Ventilation_model_detail.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Ventilation_model_detail.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Ventilation_model_detail.htm
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Step 12: Select the Construction tab. Clear Model 
infiltration in the Airtightness section. 

Step 13: Enter 3.000 for Outside air (ac/h) under the 
Natural Ventilation section and select On 24/7 in 
the Operation section. 
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Perform hourly simulation and record the results.
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You may note that there is no change in ventilation rate 
with wind speed, since in this option, the ventilation is 
fixed.

Exercise 10.1

Repeat the above tutorial for % Glazing area opens to 50. 
Plot the chart between zone air changes (ac/h) with Wind speed 
(m/s). Observe the change in Air changes per hour.
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TUTORIAL 10.2  Evaluating the impact of natural 
ventilation with constant 
wind speed and direction

GOAL

To understand the impact of natural ventilation with con-
stant wind and direction.

WHAT ARE YOU GOING TO LEARN?

• Changing the weather data file for wind speed and 
direction

PROBLEM STATEMENT

In this tutorial, you are going to use a 10 m × 10 m single-
zone model with a window on the north and south façades. 
You are going to change wind velocity and direction in the 
weather file.

• Wind velocity 1 and 2 m/s

• Wind direction 0° (wind from the north to south)

Then simulate the weather file and observe the effect on 
Air changes per hour.

Use New Delhi/Safdarjung, India weather location.

SOLUTION

First, you are going to modify the weather data file for wind 
speed and direction.

Step 1: Download the weather data for New Delhi from 
the following link and download the .epw file.*

Or

Copy from the Weather data folder.

Step 2: Download the following CSV editor tool.† (You 
can use any csv editor.)

(For this tutorial, we have used CSVed 2.4.)

Step 3: Open the CSV editor tool and select the down-
loaded .epw file of New Delhi weather location.

* https://energyplus.net/weather-location/asia_wmo_region_2/IND//IND_
New. Delhi.421820_ISHRAE

† http://csved.sjfrancke.nl (by Sam Francke)

https://energyplus.net/weather-location/asia_wmo_region_2/IND//IND_New.Delhi.421820_ISHRAE
https://energyplus.net/weather-location/asia_wmo_region_2/IND//IND_New.Delhi.421820_ISHRAE
http://csved.sjfrancke.nl
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Source: From http://csved.sjfrancke.nl/.

Step 4: After opening the file, go to Set Start Row in 
Start and Item Edit tab. Set Start Row to 9. 

In the .epw file, Columns 21 and 22 represent the Wind 
direction and speed, respectively.

Source: From http://csved.sjfrancke.nl/.

http://csved.sjfrancke.nl/
http://csved.sjfrancke.nl/
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Step 5: For changing the wind direction to 0°, select 
Column Edit 1 tab and select Column 21 from the 
drop-down and enter 0 in the New Value text box. Click 
Edit Column. 

Source: From http://csved.sjfrancke.nl/.

Step 6: Similarly, for changing the wind speed to 1 m/s, 
select Column 22 and enter 1 in the New Value text box. 
Click Edit Column. 

Source: From http://csved.sjfrancke.nl/.

Step 7: Save the file with the name Delhi Constant 
Wind.epw on Desktop.

Open DesignBuilder.

Select the File > Folders > Weather data folder and 
paste it as the Delhi Constant Wind.epw weather file. 

http://csved.sjfrancke.nl/
http://csved.sjfrancke.nl/
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Source: From http://csved.sjfrancke.nl/.

Step 8: Open the project file saved in Tutorial 10.1 with 
calculated Natural ventilation and delete both east and 
west façades. 

Step 9: Select the Construction tab. Select Outer for 
the Zone volume calculation method and Zone floor 
area calculation method in the Geometry, Areas and 
Volumes section. 

http://csved.sjfrancke.nl/
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Step 10: Select the Location tab and select Hourly 
weather data under the Simulation Weather Data 
section. 

Step 11: Click the Add new item icon under the Help 
tab. 

Step 12: In the Edit hourly weather - Delhi Constant 
Wind screen, rename with your custom weather file and 
search for the file by clicking Filename. Click OK to 
successfully select the file. 

Step 13: Select Exposed from the Exposure to wind 
drop-down list under the Site Details section. 
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Step 14: Simulate the model and record the results. 
Observe the results in Wind Speed, Wind Direction and 
Mech Vent + Nat Vent + Infiltration (ac/h).
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You can observe that Air changes per hour are almost 
constant throughout the year.

Step 15: Modify the weather data with Wind speed 
as 2 m/s and Wind direction as 0° with the help of previ-
ous steps.

Step 16: Simulate the model and note down the results. 
Observe the results in Wind Speed, Wind Direction and 
Mech Vent + Nat Vent + Infiltration (ac/h).
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You can calculate the Air changes per hour for two win-
dows with the following equation:*
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where Cp is the pressure drag coefficient, C is the dis-
charge coefficient, U is the wind speed and A is the area 
of the opening.

* ASHRAE Handbook of Fundamentals – 2015. ©ASHRAE, www.ashrae.
org. (2015) ASHRAE Handbook—(Fundamentals).

Wind pressure coefficient data

4 Roof ridge

Wide angle

3

2

1

Low-rise buildings (up to three storeys)

Length-to-width ratio: 1:1

Shielding condition: exposed

Wind speed reference level = building height

Wind angle (Table 10.1)

Source: http://www.designbuilder.co.uk/downloads/
AIVCWindPressureCoefficientData.pdf

http://www.designbuilder.co.uk/helpv4.7/
Content/Pressure_Coefficients_Data.htm

Table 10.1 Wind pressure coefficient data

Location 0 45 90 135 180 225 270 315

Face 1 0.7 0.35 –0.5 –0.4 –0.2 –0.4 –0.5 0.35
Face 2 –0.2 –0.4 –0.5 0.35 0.7 0.35 –0.5 –0.4
Face 3 –0.5 0.35 0.7 0.35 –0.5 –0.4 –0.2 –0.4
Face 4 –0.5 –0.4 –0.2 –0.4 –0.5 0.35 0.7 0.35

http://www.designbuilder.co.uk/helpv4.7/Content/Pressure_Coefficients_Data.htm
http://www.designbuilder.co.uk/downloads/AIVCWindPressureCoefficientData.pdf
http://www.designbuilder.co.uk/helpv4.7/Content/Pressure_Coefficients_Data.htm
http://www.designbuilder.co.uk/downloads/AIVCWindPressureCoefficientData.pdf
http://www.ashrae.org
http://www.ashrae.org
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Wind speed provided in the weather file is for 10-m 
height. You can use the following formula to calculate 
the wind speed at 2-m height: 

 
u u

z
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r
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
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α

α is approximately 1/7, or 0.143 (it varies with local 
topography).

Tables 10.2 and 10.3 gives the calculation for natural 
ventilation in the zone.

Wind pressure coefficient templates
Wind pressure coefficients are used when the Natural ven-
tilation model option is set to ‘Calculated’. The EnergyPlus 
Airflow Network calculations use pressure coefficients 
when calculating wind-induced pressure on each surface 
during simulations when the Calculated Natural ventilation 
option is selected.

DesignBuilder is supplied with a database of wind 
pressure coefficients based on the data from Martin 
Liddament, Air Infiltration Calculation Techniques, 
An Applications Guide, AIVC. The Cp data are build-
ings of three storeys or less, with square surfaces and for 
three levels of site exposure. The data are given in 45° 
increments.

http://www.designbuilder.co.uk/downloadsv1/
AIVCWindPressureCoefficientData.pdf

http://www.designbuilder.co.uk/helpv4.7/
Content/Pressure_Coefficients_Data.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Pressure_Coefficients_Data.htm
http://www.designbuilder.co.uk/downloadsv1/AIVCWindPressureCoefficientData.pdf
http://www.designbuilder.co.uk/helpv4.7/Content/Pressure_Coefficients_Data.htm
http://www.designbuilder.co.uk/downloadsv1/AIVCWindPressureCoefficientData.pdf
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Exercise 10.2

Repeat the above tutorial for the window area 16 m2.

Table 10.2 Calculation of zone air changes per hour 
at a wind speed of 1 m/s at 10-m height

Wind speed at 2 m 0.72 m/s
Area of window 6.59 m2

Cp1 0.7

Cp2 –0.2

C1 0.65

C2 0.65

Q 2.07 m3/s
Q 7,442 m3/h
Zone volume 350 m3

Air changes 21.26 ac/h

Table 10.3 Calculation of zone air changes per hour 
at a wind speed of 2 m/s at 10 m-height

Wind speed at 2 m 1.44 m/s
Area of window 6.59 m2

Cp1 0.7
Cp2 –0.2
C1 0.65
C2 0.65
Q 4.13 m3/s
Q 14,885 m3/h
Zone volume 350 m3

Air changes 42.53 ac/h
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TUTORIAL 10.3  Evaluating the impact of window 
opening and closing schedule

GOAL

To evaluate the impact of window opening and closing 
schedule.

WHAT ARE YOU GOING TO LEARN?

• Defining window opening and closing schedule for 
natural ventilation

PROBLEM STATEMENT

In this tutorial, you are going to use the model saved in 
Tutorial 10.2 and add windows in remaining two directions.

You need to simulate the model for the following two win-
dow operation schedules:

 1. On (windows are always open)

 2. 8:00–18:00 Mon–Sat

Use New Delhi/Safdarjung, India weather location.

SOLUTION

Step 1: Open a project saved in Tutorial 10.2. 

Step 2: In the navigation tree select East facing wall by 
selecting Wall – 35.000 m2 – 90.0°.
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Step 3: Select Left in the View rotation dropdown list 
then select Draw window in the Help tab to draw a win-
dow with the same dimensions as that on the north or 
south side. 

4.44 m

2.80 m

0.80 m

1.50 m

Step 4: Similarly, draw the west window.
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Step 5: Select the Openings tab. Click the Operation 
section. Make sure that Operation schedule is On 24/7. 

Simulate the model and record the results by exporting 
them to the spreadsheet.

Step 6: Repeat the above steps for Operation schedule 
8:00 - 18:00 Mon - Sat. 

Simulate the model and record the results. Plot the 
graph for January 1 and 2 for Mech Vent + Nat Vent + 
Infiltration (Air changes per hour, ac/h).
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You can observe the impact of window opening and clos-
ing on air change rate.

TUTORIAL 10.4  Evaluating the impact of window 
opening control based 
on temperature

GOAL

To evaluate the impact of window opening control based on 
zone and outdoor air temperature.

WHAT ARE YOU GOING TO LEARN?

• Defining window operation control for natural 
ventilation

PROBLEM STATEMENT

In this tutorial, you are going to use the calculated model 
saved in Tutorial 10.1. You are going to simulate the model 
for Temperature control mode.

Use New Delhi/Safdarjung, India weather location.

SOLUTION

Step 1: Open the model saved in Tutorial 10.1 with 
natural ventilation set to calculate. 
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Step 2: Select the Activity tab. Set Min temperature 
to 20.0.
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Step 3: Select the Openings tab. Click the Operation 
section. Make sure that Operation schedule is On 24/7. 

Step 4: Select the HVAC tab. Enter Outside air (ac/h) 
as 3.000. Select Temperature for the External and 
Internal Control mode drop-down lists. 

Natural ventilation min temperature
This is the fixed indoor temperature below which ventila-
tion is shut off. The control is visible when the 1-By value 
option is selected for Min temperature definition. It can 
be thought of as the cooling setpoint temperature which 
controls the activation of natural ventilation. If the inside 
air temperature is greater than this setpoint temperature 
(and the natural ventilation operation schedule is on), 
then natural ventilation can take place.

http://www.designbuilder.co.uk/helpv4.7/
Content/_Environmental_comfort.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Environmental_comfort.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Environmental_comfort.htm


352 BUILDING ENERGY SIMULATION

To see the effect of window opening controls, we need 
the following:

 1. Generate and view the results at system time 
steps instead of fixed user defined time steps. 
This can be achieved by selecting the ‘detailed’ 
frequency option on an HVAC output variable 
(e.g. Zone Air Temperature).

 2. Generate more output variables such as window 
opening factor, zone infiltration and zone air 
temperature.
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System time step is a variable-length time step that governs 
the driving time step for HVAC and Plant system model-
ling. The user cannot directly control the system time step 
(except by use of the ConvergenceLimits object). When 
the HVAC portion of the simulation begins its solution for 
the current zone time step, it uses the zone time step as 
its maximum length but can then reduce the time step, as 
necessary, to improve the solution.

Users can see the system time step used if they select 
the ‘detailed’ frequency option on an HVAC output vari-
able (e.g. Zone Air Temperature). In contrast, the ‘Zone’ 
variables will only be reported on the zone time step (e.g. 
Zone Mean Air Temperature).

Note that hourly data (such as outdoor conditions 
expressed by Design Days or Weather data) are interpo-
lated to the Zone Time step.

Source: EnergyPlus InputOutput Reference

Field: Ventilation Control Mode

Specifies the type of zone-level natural ventilation con-
trol. The windows are ‘open’ when:

Tzone_air > Tsetpoint AND Tzone_air > Toutside_air AND the 
schedule value = 1

where Toutside_air is equal to the outdoor air temperature, 
Tzone_air is equal to the previous time step’s zone air tem-
perature, Tsetpoint is equal to the Vent Temperature Schedule 
value.

http://www.designbuilder.co.uk/helpv4.7/
Content/_Operation2.htm

http://www.designbuilder.co.uk/helpv4.7/Content/_Operation2.htm
http://www.designbuilder.co.uk/helpv4.7/Content/_Operation2.htm
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Step 5: Minimize the DesignBuilder window. Create a 
new file named output.idf. Write additional output vari-
ables as follows:

Output:Variable, *, Zone Air Temperature, Detailed;

Output:Variable, *, AFN Surface Venting Window or 
Door Opening Factor, Detailed;

Output:Variable, *, AFN Zone Infiltration, Detailed; 

Zone Mean Air Temperature (°C)
Zone Mean Air Temperature is the average temperature 
of the air temperatures at the system time step. Remember 
that the zone heat balance represents a ‘well-stirred’ 
model for a zone; therefore, there is only one mean air 
temperature to represent the air temperature for the zone. 
This is reported only at the zone time step.

Zone Air Temperature (°C)
This is very similar to the mean air temperature. The 
‘well-stirred’ model for the zone is the basis, but this tem-
perature is also available at the ‘detailed’ system time step.

Source: EnergyPlus InputOutput Reference
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This .idf file needs to be placed in the following path: 

You can use any text editor such as Notepad++ and 
Editplus.

Step 6: Maximize the DesignBuilder window and select 
the HVAC tab. Click Simple under the Help tab. The 
Model Options – Building and Block screen appears. 
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Step 7: Select the Simulation tab. Click the Advanced 
section. 

Step 8: Select the IDF File 1 check box and select the 
Output.idf file from the EnergyPlus folder. Click OK. 
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Step 9: Select the Simulation tab. The Edit Calculation 
Options screen appears. Click OK. 

After simulation, the results on the screen appear, but 
DesignBuilder does not support viewing ‘Detailed’ 
reporting frequency. 

After simulation, an ESO file is generated in the 
EnergyPlus folder which contains results at detailed 
reporting frequency. You can view this in the xESOView 
tool.

xESOView can be downloaded from http://xesoview.
sourceforge.net/.

Step 10:  Click the View EnergyPlus results icon. 
From the EnergyPlus folder, select the eplusout.eso file. 
xESOView tool will open. 

 

http://xesoview.sourceforge.net/
http://xesoview.sourceforge.net/
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Step 11: Enter Site Outdoor Air Drybulb Temperature 
in the Name field of the Filter section to view the vari-
able. From the filtered list select the variable with hourly 
Timestep.

You can copy the variable data to view in a spreadsheet.
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Step 12: Click Copy and select Copy variable data. 

You can copy only one variable at a time. 

Step 13: Open a spreadsheet program and paste the data 
as shown in the below screen. 

Similarly, copy and paste the below variables with time 
step as hourly:

• AFN Surface Venting Window or Door 
Opening Factor BLOCK1:ZONE1_WALL_ 
2_0_0_0_0_0_WIN []

• AFN Surface Venting Window or Door 
Opening Factor BLOCK1:ZONE1_WALL_ 
3_0_0_0_0_0_WIN []
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• AFN Surface Venting Window or Door 
Opening Factor BLOCK1:ZONE1_WALL_ 
4_0_0_0_0_0_WIN []

• AFN Surface Venting Window or Door 
Opening Factor BLOCK1:ZONE1_WALL_ 
5_0_0_0_0_0_WIN []

• AFN Zone Infiltration Air Change Rate 
BLOCK1: ZONE1 [ach]

• Zone Air Temperature BLOCK1:ZONE1 [C]

You can observe from the above that if the following 
conditions are true, then there is natural ventilation. 

 T T T Tzone_air setpoint zone_air outside_air >  AND  > 

Please note that the zone setpoint is 20°C. You can see 
that the windows open in the succeeding time step after 
the above mentioned condition is met. Please note that the 
Zone infiltration air change rate is reported hourly and 
not on the system timestep. Hence, even when the win-
dows are open the zone ventilation will not be reported in 
that timestep, it will be reported in the hourly time step.

TUTORIAL 10.5  Evaluating the impact of window 
opening area modulation 
on natural ventilation

GOAL

To evaluate the impact of window opening area modulation 
based on zone and outdoor air temperature.

WHAT ARE YOU GOING TO LEARN?

• Defining window opening area modulation
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PROBLEM STATEMENT 

In this tutorial, you are going to use the model saved in 
Tutorial 10.4.

You are going to simulate the model for Temperature con-
trol mode.

Use New Delhi/Safdarjung, India weather location.

The modulation takes the following form when 
Ventilation Control Mode = Temperature.

Tzone – Tout = [Lower value on inside/outside temperature 
difference for modulating the venting open factor]; then 
multiplication factor = 1.0.

[Lower value on inside/outside temperature difference 
for modulating the venting open factor] < Tzone – Tout < 
[upper value on inside/outside temperature difference for 
modulating the venting open factor]; then multiplication 
factor varies linearly from 1.0 to [limit value on multi-
plier for modulating the venting open factor].

Tzone – Tout = [upper value on inside/outside temperature 
difference for modulating the venting open factor]; then 
multiplication factor = [limit value on multiplier for mod-
ulating the venting open factor].

Multiplier on
the venting
open factor

1.0

0.0 Tzone − Tout

Limit value on
multiplier for
modulating the
venting
open factor Lower value on

inside/outside
temperature difference for
modulating the venting
open factor

Upper value on
inside/outside
temperature difference for
modulating the venting
open factor

Ref: EnergyPlus InputOutput Reference.
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 SOLUTION

Step 1: Open the project saved in Tutorial 10.4. 

Step 2: Select the HVAC tab. Expand the Natural 
Ventilation section. 
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Step 3: Select the Modulate opening areas check box. 
Enter the lower value of Tin – Tout as 5.0 and the upper 
value as 15. 

Step 4: Minimize the DesignBuilder window. Create an 
output.idf file. Write additional output variables:

Output: Variable, *, Zone Air Temperature, Detailed;

Output: Variable, *, AFN Surface Venting Window or 
Door Opening Factor, Detailed;

Output: Variable, *, AFN Zone Infiltration, Detailed; 
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This .idf file needs to be placed in the following path: 

Step 5: Maximize the DesignBuilder window and select 
the HVAC tab. Click Simple under the Help tab. The 
Model Options – Building and Block screen appears. 
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Step 6: Select the Simulation tab. Click the Advanced 
section. 

Step 7: Select the IDF File 1 check box and select the 
Output.idf file from the EnergyPlus folder. Click OK. 
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Step 8: Select the Simulation tab. The Edit Calculation 
Options screen appears. Click OK. 

Step 9: Select the EnergyPlus results. Select eplusout 
file, so that the file will automatically open in the xESO-
View tool. 
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The xEsoView screen appears: 
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Step 10: Enter Site Outdoor Air Drybulb Temperature 
in the Name field of the Filter section to view the 
variable. 

You can copy the variable data to view in a spreadsheet.

Step 11: Click Copy and select Copy variable data. 
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Step 12: Open a spreadsheet and paste the data.

 

You can check if natural ventilation is working as per the 
controls applied.

 

You can observe from the above that if the following 
conditions are true, then there is natural ventilation 

 T T T Tzone_air setpoint zone_air outside_air >  AND  > 

and Window opening fraction is dependent on the 
Tzone – Tout.

TUTORIAL 10.6  Evaluating the impact of mixed 
mode operation

GOAL

To evaluate the impact of mixed mode operation on energy 
performance.

WHAT ARE YOU GOING TO LEARN?

• Modelling mixed-mode ventilation
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PROBLEM STATEMENT 

In this tutorial, you are going to use the model saved in 
Tutorial 10.4.

Find out the energy consumption for the following two 
cases:

 1. With mixed mode

 2. Fully air conditioned

Use the New Delhi/Safdarjung, India weather location.

Mixed-Mode Cooling
In mixed-mode buildings, natural ventilation is used as 
the primary means of providing cooling, and active cool-
ing is introduced when this is inadequate to provide com-
fort conditions.

Mixed-Mode Building
Mixed mode refers to a hybrid approach to space con-
ditioning that uses a combination of natural ventilation 
from operable windows (either manually or automati-
cally controlled) and mechanical systems that include air 
distribution equipment and refrigeration equipment for 
cooling. A well-designed mixed-mode building begins 
with an intelligent façade design to minimize cooling 
loads. It then integrates the use of air conditioning when 
and where necessary, with the use of natural ventilation 
whenever it is feasible or desirable, to maximize comfort 
while avoiding the significant energy use and operating 
costs of year-round air conditioning.

Source: http://www.cbe.berkeley.edu/mixedmode

http://www.cbe.berkeley.edu/mixedmode
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SOLUTION

Step 1: Open the file saved in Tutorial 10.4. 

Step 2: Select the HVAC tab. Select the HVAC template 
as Radiator heating, Boiler HW, Mixed mode Nat 
Vent, Local comfort cooling. 
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Step 3: Clear the Heated checkbox in the Heating sec-
tion and make sure Outside air (ac/h) is 3.000. 

Step 4: Ensure the Mixed mode on check box is selected. 

 

Step 5: Minimize the DesignBuilder window. Create 
an output.idf file. Write additional output variables as 
follows:

Output: Variable, *, Zone Air Temperature, Detailed;

Output: Variable, *, AFN Surface Venting Window or Door 
Opening Factor, Detailed;

Output: Variable, *, AFN Zone Infiltration Air Change 
Rate, Detailed;

Output: Variable, *, Zone Ideal Loads Supply Air Total 
Cooling Rate, Detailed;
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This .idf file needs to be placed in the following path: 

 

Step 6: Maximize the DesignBuilder window and select the 
HVAC tab. Click Simple under the Help tab. The Model 
Options – Building and Block screen appears. 
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Step 7: Select the Simulation tab. Click the Advanced 
section.

Step 8: Select the IDF File 1 check box and select the 
Output.idf file from the EnergyPlus folder. Click OK. 
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Step 9: Select the Simulation tab. The Edit Calculation 
Options screen appears. Click OK. 

Step 10: Select the EnergyPlus results. Select eplusout 
file, so that the file will automatically open in the xESO-
View tool. 
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The xEsoView screen appears: 

Step 11: Enter Site Outdoor Air Drybulb Temperature 
in the Name field of the Filter section to view the 
variable. 

You can copy the variable data to view it in a spreadsheet.
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Step 12: Click Copy; then select Copy variable data. 

Step 13: Open a spreadsheet and paste the data.
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You can observe from the above that if the following 
conditions are true, then there is natural ventilation. 

 T T T Tzone_air setpoint zone_air outside_air >  AND  >  

When the outside temperature is more than zone temper-
ature, natural ventilation in OFF and mechanical cooling 
takes place.

Step 14: Clear the On check box to switch off the natu-
ral ventilation, so that the zone runs in the air condition 
mode. 

Simulate the model and record the monthly energy con-
sumption results.

Compare the results in both cases. 
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You can observe that natural ventilation is effective in cli-
mate of New Delhi from January to March and October to 
December.

Exercise 10.6

Repeat the above tutorial for the window area modulation based 
on zone and outdoor air temperature.



http://taylorandfrancis.com
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CHAPTER ELEVEN

Building Energy Code 
Compliance

Building energy code compliance in most countries has the 
 following two paths: 

 1. Prescriptive

 2. Performance-based

Prescriptive path give specific requirements for all the building 
components and all the requirements have to be met for compli-
ance. This generally limits design freedom.

Performance-based path provides more design freedom and can 
lead to innovative design but involves more complex energy 
simulations and trade-offs between systems. Residential and 
smaller commercial buildings with singular heating ventilation 
and air conditioning (HVAC), service hot water and lighting 
systems are more likely to be designed by using a prescriptive 
approach. Larger commercial buildings that have multiple sys-
tems or varied uses and loads may find it more advantageous to 
follow a performance-based path for code compliance.*

The performance-based path requires the whole building 
energy simulation.

ASHRAE 90.1-2010 has two methods for the whole building 
simulation: 

 a. Energy cost budget (ECB) method

 b. Performance rating method given in ASHRAE 90.1 
Appendix G

* https://www.energycodes.gov/resource-center/ace/enforcement/step2

https://www.energycodes.gov/resource-center/ace/enforcement/step2
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Both methods require energy simulation of the proposed build-
ing design and the budget building design.

TUTORIAL 11.1  Simulating building performance 
in four orientations

The baseline building performance shall be generated 
by simulating the building with its actual orientation and 
again after rotating the entire building by 90°, 180° and 
270°, and then deriving the average from the results. This is 
illustrated by the following example. The field Site orienta-
tion can be use for achieving the desired orientation.

  

The building face is 150° from the north. (The rectangle 
inside the  circle is the building, and the face is shown with 
the bold line.)

North

30°
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North

12
0°

With 90° rotation from the building face.

 

North

12
0°

90°

With 180° rotation from the building face.
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North

12
0°

90° 90
°

With 270° rotation from the building face.

TUTORIAL 11.2  Creating the base case external wall 
for ASHRAE 90.1-2010 Appendix G

The ECB method requires modelling of opaque assemblies 
such as roof and walls with the same heat capacity as of the 
proposed design, whereas in Appendix G, the performance-
based method requires these to be modelled as lightweight/
steel-framed.

ASHRAE 90.1-2010 Appendix G requires that the exter-
nal wall be steel-framed. You can refer to TABLE 5.5-1 of 
ASHRAE 90.1 for the U-value.

In this tutorial you need to create a steel-framed external 
wall with a U-value of 0.705 W/m2-K. 
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Step 1: Create a new external wall and select Wall, 
 Steel-Framed, R-13 (2.3), U-0.124 (0.70) - 16 in. 
(400mm) On Center, 3.5 in. (89mm) Depth Framing. 

Step 2: Edit the construction to view properties.
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Step 3: Select the Calculated tab. It displays all con-
struction properties. 

Please refer to Tutorial 3.1 to understand the effect of 
steel-framed and mass walls.

TUTORIAL 11.3  Modelling flush windows for the 
base case

As per ASHRAE 90.1-2010 Appendix G Table G 3.1, you 
must  not model shading projections on the fenestration of 
the base case building. The fenestration needs to be mod-
elled as flush with the exterior wall or roof.
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In the Reveal section, make sure that the Outside reveal 
depth (m) is zero for the base case.

Window shading and Local shading must not be modelled.

TUTORIAL 11.4  Selecting HVAC system for the 
base case

As per ASHRAE 90.1-2010 Section G3.1.3, building type 
can be determined based on the conditioned floor area, 
number of floors and the fuel type.

In DesignBuilder, you can select ASHRAE 90.1 
Appendix G  baseline systems from the template.
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TUTORIAL 11.5  Calculating fan power for the base case

As per ASHRAE 90.1-2010 Section G3.1.2.10, for the base 
case  system fan electrical power for supply, return, exhaust 
and relief (excluding power to fan- powered VAV boxes) 
needs to be calculated with the  following formulae:

For systems 1 and 2,
Pfan (watts) = CFMs × 0.3
For systems 3 and 4,
Baseline fan motor brake horsepower = CFMs × 0.00094 + A
Baseline fan motor brake horsepower = CFMs × 0.0013 + A
Where A = sum of (PD × CFMD/4131)
CFMs = The maximum design supply air flow rate to 
conditioned spaces served by the system in cubic feet 
per minute
CFMD = the design airflow through each applicable 
device in cubic feet per minute 
PD = each applicable pressure prop adjustment
(Please refer to Table 6.5.3.1.1B of ASHRAE 90.1 for 
PD adjustment values.)
Modelling in DesignBuilder*

 Delta P = 1000 × SFP × Fan total efficiency

* http://www.designbuilder.co.uk/helpv4.7/Content/Fans.htm

http://www.designbuilder.co.uk/helpv4.7/Content/Fans.htm
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The Specific Fan Power (SFP) is a function of the volume 
flow of the fan and the electrical power input and is quoted 
for a particular flow rate.

 SFP = Pe (W)/V (l/s)

where:
V is volume flow (l/s)
Pe is electrical power input (W) to the fan system or 
complete air movement installation

In this tutorial you will calculate the base case power (kW) 
requirement for the AHU having the supply air volume 
4000 CFM (2.359 m3/s) (1888 l/s) for system 8. (Assume 
that air-filtering system’s pressure drop is less than 1 inch 
WG when filters are clean.)

Variable volume systems 5–8
Baseline fan motor brake horsepower = CFMs × 0.0013 + A
Where A = sum of (PD × CFMD/4131)
PD = each applicable pressure drop adjustment
A = 0.97
Baseline fan motor brake horsepower = 6.17 BHP = 
4601.54 W
SFP = Pe (W)/V (l/s)
SFP = 4601.54/1888 = 2.4 W/(l/s)
Let fan efficiency be 0.6
Delta P = 1000 × SFP × fan total efficiency
Delta P = 1000 × 2.4 × 0.6
Delta P = 1440 Pa
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TUTORIAL 11.6 Understanding fan cycling

As per ASHRAE 90.1-2010 Section G3.1.2.5, Fan System 
Operation, supply and return fans shall operate continu-
ously whenever spaces are occupied and shall be cycled to 
meet heating and cooling loads during unoccupied hours. 
Supply, return and/or exhaust fans will remain on during 
occupied and unoccupied hours in spaces that have health- 
and safety-mandated minimum ventilation requirements 
during unoccupied hours.

You can refer to Tutorial 8.7 for more details.

TUTORIAL 11.7  Specifying room air to supply air 
temperature difference

As per ASHRAE 90.1-2010 Section G3.1.2.5, System Types 
1 through 8, system’s supply air flow rates for the baseline 
building design shall be based on a supply-air-to-room-air 
temperature difference of 11°C (20°F), or the minimum 
outdoor air flow rate, or on the air flow rate required to 
comply with applicable codes or accreditation standards, 
whichever is greater.
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For example, if your room’s air temperature setpoint is 
24°C, then for the base case, you need to set the supply air 
temperature to 13°C.

TUTORIAL 11.8 Number of chillers in the base case

As per ASHRAE 90.1-2010 Section G3.1.3.7, Type and 
Number of Chillers (Systems 7 and 8), electric chillers shall 
be used in the baseline building design regardless of the 
cooling energy source. 

To choose the number of chillers in the base case, you need to 
find out the building peak cooling load. Based on the building 
cooling load you can refer to Table G3.1.3.7 of ASHRAE 90.1 
to know about the numbers and type of the chillers.

In DesignBuilder, you can add chillers with the following 
steps: 

Step 1: Click Chiller. It shows the chiller layout. 
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Step 2: Click the Add Chiller link. It displays one more 
chiller on the layout screen. 



393CHAPTER ELEVEN BuiLdiNg ENERgy CodE ComPLiANCE

Step 3: Click Connect components. It shows a green dot 
when you click on the node of the chiller. 
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Step 4: Connect connector to the chilled-water loop 
splitter. 
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Step 5: Repeat step 4 to connect the chilled-water output 
loop.

 

Step 6: Connect the condenser water loop nodes. 
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You can change the type of chiller by clicking on Edit 
component. 

TUTORIAL 11.9  Defining chilled-water supply 
temperature reset for the base case

As per ASHRAE 90.1-2010 Section G3.1.3.9, Systems 7 
and 8, the chilled-water supply temperature shall be reset 
based on the outdoor dry-bulb temperature by using the fol-
lowing schedule: 

• Chilled-water temperature 7°C at DBT 27°C and above

• Chilled-water temperature 12°C at DBT 16°C and 
below

• Chilled-water temperature ramped linearly between 
7°C and 12°C at outdoor dry-bulb temperatures 
between 27°C and 16°C 
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TUTORIAL 11.10  Type and number of boilers for the 
base case

As per ASHRAE 90.1-2010 Section G3.1.3.2 for Systems 1, 
5 and 7, the boiler plant shall use the same fuel as the pro-
posed design and shall be a natural draft, except as noted 
in Section G3.1.1.1 (Purchase Heat). The baseline building 
design boiler plant shall be modelled as having a single 
boiler if the baseline building design plant serves a condi-
tioned floor area of 1400 m2 or less and has two equal-sized 
boilers for plants serving more than 1400 m2. Boilers shall 
be staged as required by the load. 
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Fuel type should be the same as used in the proposed design.

TUTORIAL 11.11  Defining hot-water supply 
temperature reset

As per ASHRAE 90.1-2010 Section G3.l.3.4 Hot-water 
Supply Temperature Reset (Systems 1, 5 and 7), the hot-
water supply temperature shall be reset based on the out-
door dry-bulb temperature by using the following schedule: 

• 82°C at –7°C and below

• 66°C at 10°C and above

• Ramped linearly between 82°C and 66°C at tempera-
tures between –7°C and 10°C 
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TUTORIAL 11.12 Hot-water pumps

As per ASHRAE 90.1-2010 Section G3.1.3.5, Hot-water 
Pumps, the baseline building design hot-water pump power 
shall be 301 kW/1000 L/s. The pumping system shall be 
modelled as  primary-only, with a continuous variable flow. 
Hot-water  systems serving 11,148 m2 or more shall be mod-
elled with  variable-speed drives, and systems serving less 
than 11,148 m2 shall be modelled as riding the pump curve.*

 

TUTORIAL 11.13  Defining exhaust air energy 
recovery parameters

As per ASHRAE 90.1-2010 Section 6.5.6.1, each fan  system 
shall have an energy recovery system when the system’s 
supply airflow rate exceeds the value listed in Table 6.5.6.1, 
based on the climate zone and the percentage of outdoor 
airflow rate at design conditions.

* http://www.designbuilder.co.uk/helpv4.7/#Pump_-_Variable_Speed.htm

http://www.designbuilder.co.uk/helpv4.7/#Pump_-_Variable_Speed.htm
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Energy recovery systems required by this section shall have 
at least 50% energy recovery effectiveness. Fifty percent 
energy recovery effectiveness shall mean a change in the 
enthalpy of the outdoor air supply equal to 50% of the dif-
ference between the outdoor air and return air enthalpies 
at design conditions. Provision shall be made to bypass or 
control the energy recovery system to permit air economiser 
operation, as required by Section 6.5.1.1. There are some 
exceptions to this, which you can refer to in Section 6.5.6.1.

You can refer to Tutorial 8.8 for modelling a heat recovery 
system.

TUTORIAL 11.14 Defining economiser parameters

As per ASHRAE 90.1-2010 Section G3.1.2.7, Economisers, 
outdoor air economisers shall not be included in baseline 
HVAC systems 1, 2, 9 and 10. Outdoor air economisers shall 
be included in baseline HVAC systems 3 through 8 based 
on climate, as specified in Table G3.1.2.6A. Exceptions can 
be referred to in the relevant section.

The high-limit shutoff shall be a dry-bulb switch with set-
point temperatures in accordance with the values in Table 
G3.1.2.6B.

 

You can refer to Tutorial 8.6 for more details.
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TUTORIAL 11.15  Finding unmet hours after 
simulation

As per ASHRAE 90.1-2010 Section G3.1.2.3, unmet load 
hours for the proposed or baseline building designs shall not 
exceed 300 (of the 8760 simulated hours). You can get unmet 
hours in the Summary tab after simulation of the building. 

TUTORIAL 11.16  Generating the performance rating 
method compliance report 
in DesignBuilder

You can get the LEED summary in DesignBuilder by 
 selecting the LEED Summary checkbox.
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After simulation, you can get the LEED summary in the 
Summary tab. 
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TUTORIAL 11.17  Finding process load for the 
base case

Process loads must be identical for both the baseline build-
ing  and the proposed building. However, project teams 
may follow the exceptional calculation method (ANSI/
ASHRAE/IESNA Standard 90.1-2010 G 2.5) to document 
measures that reduce process loads. Documentation of pro-
cess load energy savings must include a list of assumptions 
made for both the baseline and the proposed design and 
theoretical or empirical supporting information.

The total process energy cost must be equal to at least 25% 
of the baseline building performance. For buildings where 
the process energy cost is less than 25% of the baseline 
building energy cost, you should include the documen-
tation substantiating that the process energy inputs are 
appropriate.
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TUTORIAL 11.18  Getting ASHRAE 62.1 standard 
summary in DesignBuilder

Many rating systems require meeting the minimum require-
ments of Sections 4 through 7 of ASHRAE Standard 62.1-
2007, Ventilation for Acceptable Indoor Air Quality. You 
can get this summary from the DesignBuilder output.
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Reference

ASHRAE, ASHRAE Standard 90.1-2010: Energy Standard for 
Buildings Except Low-Rise Residential Buildings. Atlanta, GA: 
ASHRAE, www.ashrae.org.

http://www.ashrae.org


http://taylorandfrancis.com
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CHAPTER TWELVE

Project: Small Office

Project goal

The goal of this project is to create a DesignBuilder model 
of a small office building. The office is located in Jaipur, 
India, which is climate Zone 1A: Hot and Dry, as defined by 
ASHRAE 90.1-2010. This project will help you learn to model 
a small office and analyse the key results of a whole building 
energy simulation.

Overview

The building is a small office with three floors. An overview of 
the building is provided in Table 12.1. 

Climate and location

The building is located in Jaipur, India. In this particular cli-
mate zone, the maximum daytime temperature in summers is 
in the range of 32°C–44°C and night temperature ranges from 
27°C to 32°C. In winters, the values are between 10°C and 
25°C during the day and between 4°C and 10°C at night. The 
relative humidity is about 20–25% in dry periods and 55–95% 
in the monsoon season.
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The following figures provide the temperatures range (in degree 
Celsius) and Psychrometric chart for Jaipur climate, generated 
using Climate Consultant.

 
Source: From http://www.energydesign-tools.aud.ucla.edu/

climate-consultant/.

Table 12.1 Building overview

Variable Value

Built-up area 11,306 m2

Total air conditioned area 9,959 m2

Building use Office
Number of above-grade floors 3 (G+2)
Wintow-to-wall ratio 27% distributed equal in all 

directions in horizontal strips
Heating None
Cooling Variable refrigerant volume (VRV) 

system

Average utility costs
Electricity $0.12/kWh

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
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Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.

Floor plans

For creating any energy simulation model, it is important to 
have all floor plans. The following two figures give the floor 
plans for the ground and the first floor.

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
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A soft copy of CAD is provided with the book for import in 
DesignBuilder (https://www.crcpress.com/9781498744515). 

https://www.crcpress.com/9781498744515
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Building envelope

This small office is proposed to be constructed with parameters 
as shown in Table 12.2.
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First floor

230 mm brick

115 mm brick

35 mm insulation

+4000

Ground floor
±00

Internal loads and schedules

The building is a small office. Details of activity, equipment and 
lighting loads in each room are provided in Table 12.3. 

Table 12.2 Construction parameters

S. No. Model input parameter Details

1. Exterior wall 
construction

Assembly U-0.72 W/m2-K
230 mm brick + 35 mm XPS 
insulation + 115 mm brick

2. Roof construction Assembly U-value – 
0.35 W/m2-K
125 mm RCC with underdeck 
75 mm XPS insulation

3. Glazing Double-glazed glass with 
low-heat gain and 
high visible transmittance
U-value: 1.9 W/m2-K
SC (all): 0.28 & VLT: 39%

4. Window-to-wall 
ratio (%)

27

5. Roof reflectance 0.7
6. Infiltration through 

envelope (ac/h)
0.5
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Table 12.3 Internal loads and schedule details

S. No. Model input parameter Details

1. Equipment power 
density (W/m2)

23

2. Occupancy (m2/person) 5.4
3. Lighting power density 

(W/m2)
4.6

4. Shading devices Overhang 0.15 m on 
all windows

5. Occupancy sensors Installed in all areas
6. Daylight sensors Installed in daylit areas
7. Fresh air 30% over ASHRAE 

62.1-2010
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Mechanical systems

The building is cooled and heated by a ducted VRV system. 
Details of the HVAC systems are provided in Tables 12.4 and 12.5. 

Table 12.4 HVAC efficiency details

S. No. Model input parameter Value

1. HVAC system type VRV system
2. AHU fan power 1.5 inch WG
3. Demand control 

ventilation
CO2 sensors installed to 
modulate fresh air

4. Heat recovery wheel Enthalpy wheel type with 
75% rated efficiency

5. Winter heating source None



417chapter t WeLVe project: SmaLL office

You need to find base case parameters from ASHRAE 
90.1-2010.

Simulate and compare the base case and design case models in 
Desgin Builder. 

You can get more information about modelling VRF 
system from: https://www.designbuilder.co.uk/helpv4.7/
Content/VRFOutdoorUnit.htm  

On this page you will also get a link to a webinar - 
VRF System Design and Simulation, presented by 
DesignBuilder, Mitsubishi and Building Performance 
Team, recorded on 01.09.15.

Table 12.5 VRV specifications details

COP 3.75
Capacity 9.6 TR
Input power 8.93 kW
Refrigerant R410A

https://www.designbuilder.co.uk/helpv4.7/Content/VRFOutdoorUnit.htm
https://www.designbuilder.co.uk/helpv4.7/Content/VRFOutdoorUnit.htm


http://taylorandfrancis.com
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CHAPTER THIRTEEN

Project: Single-Family 
Residence

Project goal

The goal of this project is to create a DesignBuilder model of a 
single-family detached house located in the United States. The 
house is located in Chicago, Illinois, which is climate Zone 5A: 
Cool and Humid. You will learn to model a real-world example 
building and analyse the key results of a whole building energy 
simulation.

Overview

A single-family home with two floors and one basement will 
be modelled in this project. An introduction of the building is 
provided in Table 13.1. 
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Table 13.1 Building overview

Variable Value

Year of construction 2015
Total built-up area 280 m2

Building use Single-family detached
Number of floors 2 + basement
Number of above-grade floors 2
Number of floors below grade 1
Construction type Wood-framed: advance framing
Window-to-wall ratio 20%
Heating Gas furnace
Cooling Air conditioner – ducted split 

system
Domestic hot water Gas boiler with storage tank

Average utility costs
Natural gas $0.785/therm
Electricity $0.113/kWh



421chapter thIrteeN project: SINgle-FamIly reSIdeNce

Climate and location

The house is located in Chicago, Illinois. Chicago has a cool 
and humid climate, with hot and humid summers and cold 
winters. Therefore, in such climates, buildings are designed 
to meet both the cooling and heating needs.

Table 13.2 provides information on the geography and  climate 
of Chicago. The building is oriented to the true north, with the 
slopes of the roofs facing north and south.

Floor plans

For creating any energy simulation model, it is important to 
define the area of the building within the thermal boundary. In 
this home, all the rooms within the building, including the attic 
area, are insulated, except the garage.

The figures that follow show the floor plans of the house. The 
first-level floor plan shows the kitchen, master bedroom and 
living room. On the second level of the home there are three 
bedrooms. The basement floor comprises a family room, game 
room, laundry room and mechanical room.

Table 13.2 Building location and orientation

Variable Value

City/state Chicago, Illinois
Climate zone 5A (cool-humid)
Latitude N 41°50′13″
Longitude W 87°41′05″
Elevation 100 m
Heating design days (18.3°C baseline) 3506
Cooling design days (10°C baseline) 1689
Building orientation 0° from the true 

north
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As seen in the 3D image, the building has a sloped roof and 
an attic under the sloped roof. The home is insulated at the 
ceiling level, and, hence, the attic is also a conditioned space. 
However, the garage on the first level is unconditioned.

Therefore, the thermal boundary of the building, is as shown 
in the plan and cross-section. The complete home is centrally 
conditioned and is controlled with a single thermostat. 

Family/
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5.4

3.8 3.91.5
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Internal loads and schedules

The building is a single-family residence. The occupancy of the 
home is five people. Details of activity, maximum occupancy, 
equipment load and lighting loads in each of the room are pro-
vided in Table 13.3.

Equipment load radiant fraction is 0.2.

Occupancy, equipment, lighting, and mechanical equipment 
schedules are provided in Tables 13.4 and 13.5.

Table 13.3 Activities and schedules

Room
Activity/
MET

Maximum 
occupancy

Equipment 
load 
(W/m2)

Lighting 
load 
(W/m2)

Living/dining 
room

Eating & 
drinking

5 10.8 5

Master 
bedroom

Sleeping 2 3.3 3

Bedrooms 
1, 2 & 3

Sleeping 1 per 
room

3.3 3

Kitchen Cooking 2 4.3 5
Game room Light manual 

work
5 10.8 5

Family room Seated quiet 5 16.1 5
Bathrooms Standing/

walking
1 per 
room

2.2 2
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The following figures give the 24 hours schedules for various 
parameters.
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Building envelope

This home is constructed using advanced framing  techniques. 
Layer-by-layer details of the wall, roof and floors is 
 provided.  Using these details, create custom layers and, if 
 necessary,  materials under the DesignBuilder construction tab. 
The Window-to-wall ratio of the home is 25%, with most of the 
glazing on the north and south (Table 13.6). 
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The above-grade walls of the home are designed to use flash 
and batt insulation. Open-cell spray foam used in the cavities 
above dense-packed cellulose is installed.

Mechanical systems

The building is centrally heated and cooled. The heating is pro-
vided through a gas furnace, and the cooling system is a central 
split system. Efficiency details of the HVAC and SHW systems 
are provided in the following table. Both the heating and cool-
ing systems are connected to the same air handling unit with a 
constant volume fan (Table 13.7).

Hint: Windows are only on the conditioned walls, and 
the building is completely conditioned. With the knowl-
edge from previous examples and exercises in other 
 chapters, should the windows be modelled in detail with 
exact dimensions and locations?

Tip: Using the area-weighted average method, calculate 
the effective R value of the insulation (fibre glass batt) 
used in the wall, considering 16% area for advanced 
framing.
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IECC 2015 compliance

You are required to run simulation for IECC 2015 compliance.

Table 13.7 Mechanical system details

Variable Value

Heating
System type Furnace
Fuel type Natural gas
Heating system efficiency (AFUE) 80%
Maximum supply air temperature 30°C
Maximum supply air humidity ratio 0.0156
Heating system capacity 26 kW

Cooling
System type Central air conditioning 

using split system
Fuel type Electricity
Cooling system EER 12.00
Cooling system SEER 17.50
Cooling system capacity 14 kW

Domestic hot-water system
System type A storage hot-water system 

(standalone)
System fuel Natural gas
Energy factor 0.82
Hot-water delivery temperature 75°C
Mains supply temperature 10°C
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CHAPTER FOURTEEN

Project: Large Office

Project goal

The goal of this project is to create a DesignBuilder model 
of a large office building located in Ulsan, South Korea. The 
office is located in climate Zone 4A: Mixed Humid, as defined 
by ASHRAE 90.1-2010. You will learn to model a large office 
building and analyse the key results of a whole building energy 
simulation.

Overview

The building is a large office with five floors. An introduction 
of the building is provided in Table 14.1. 

Climate and location

The building is located in Ulsan, Korea. Ulsan has a monsoon-
influenced humid subtropical climate, with somewhat cold but 
dry winters and hot, humid summers (Table 14.2).
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Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.  

Table 14.2 Building location and orientation

Variable Value

City/state Ulsan, Korea
Climate zone 4A (mixed-humid)
Building orientation 0° from the true north

Table 14.1 Building overview

Variable Value

Total built-up area 54,317 m2

Building use Office
Number of above-grade floors 2
Window-to-wall ratio 35%
Heating Natural gas-fired steam boiler
Cooling Water-cooled centrifugal chillers

Average utility costs
Natural gas $1.7/therm
Electricity $0.08/kWh

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
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Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.

Floor plans

Following figures give the plan and elevations of the building.

A soft copy of CAD is provided with the book (https://www.
crcpress.com/9781498744515).

 

79064 mm

137400 mm

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
https://www.crcpress.com/9781498744515
https://www.crcpress.com/9781498744515
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
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Building envelope

This large office is proposed to be constructed with parameters 
as shown in Table 14.3. 

Internal loads and schedules

Details of activity, equipment load and lighting load in each of 
the room are provided in Table 14.4.

Table 14.3 Building envelope parameters

S. No. Model input parameter Details

1. Exterior wall 
construction

Assembly U-0.340 W/m2-K
Metal panel 50 mm + 75 mm PUF 
thickness

2. Roof construction Assembly U-value: 0.340 W/m2-K 
(100 mm concrete + 75 mm PUF)

3. Glazing U-value: 3.463 W/m2-K
SC (all): 0.6 & VLT: 50%
Window frame U-value: 
6.41 W/m2-K

4. Window-to-wall ratio 35%
5. Roof reflectance 0.8
6. Infiltration through 

envelope
0.5 ac/h

7. Shading devices None

Table 14.4 Parameters related to internal loads

S. No. Model input parameter Details

1. Fresh air C.F.M./person 30% over ASHRAE 
62.1-2007

2. Equipment power density (W/m2) 15
3. Occupancy (m2/person) 9.30
4. Lighting power density (W/m2) 7
5. Occupancy sensors Installed in all areas
6. Daylight sensors None
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Mechanical systems

The building is centrally heated and cooled. Efficiency details 
of the HVAC systems are provided in Table 14.5.
  

Table 14.5 HVAC parameters

S. No. Model input parameter Value

1. HVAC system type VAV system
2. AHU fan power 4 in WG
3. Demand control 

ventilation
CO2 sensors installed to modulate 
fresh air

4. Heat recovery wheel Enthalpy wheel type with 75% 
rated efficiency

5. Airside economiser 
(100% fresh air 
system)

None

6. Chiller parameter 3 numbers of 1000 TR 
water-cooled centrifugal chillers 
with COP 6.17

7. Chilled water loop Variable secondary flow
CHW out = 6.66°C &
CHW in = 12.22°C

8. Winter heating source Natural gas-fired steam boiler
9. Boiler efficiency 96%
10. Pump motor class Standard
11. Cooling tower fan Variable speed
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Show compliance for ASHRAE 90.1-2010

You need to find base case parameters as per ASHRAE 
90.1-2010.

Prepare the DesignBuilder model for the base case and design 
case. Then compare energy savings (Table 14.6).
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Appendix A: Working of 
EnergyPlus™ Simulation

EnergyPlus™ is a whole building energy simulation program 
used by engineers, architects and researchers to model energy 
consumption for heating, cooling, ventilation, lighting and plug 
and process loads. EnergyPlus can also be used for simulating 
water use in buildings. Some of the features and capabilities of 
EnergyPlus include (Source: https://www.energyplus.net):

• Integrated, simultaneous solution of thermal zone condi-
tions and HVAC system response that does not assume 
that the HVAC system can meet zone loads and can simu-
late un-conditioned and under-conditioned spaces.

• Heat balance-based solution of radiant and convective 
effects that produce surface temperatures thermal com-
fort and condensation calculations.

• Sub-hourly, user-definable time steps for interaction 
between thermal zones and the environment; with auto-
matically varied time steps for interactions between ther-
mal zones and HVAC systems. These allow EnergyPlus 
to model systems with fast dynamics while also trading-
off simulation speed for precision.

• Combined heat and mass transfer model that accounts 
for air movement between zones.

• Advanced fenestration models including controllable 
window blinds, electrochromic glazings and layer- by-
layer heat balances that calculate solar energy absorbed 
by window panes.

• Illuminance and glare calculations for reporting visual 
comfort and driving lighting controls.

https://www.energyplus.net
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• Component-based HVAC that supports both standard 
and novel system configurations.

• A large number of built-in HVAC and lighting control 
strategies and an extensible runtime scripting system for 
user-defined control.

• Functional Mockup Interface import and export for 
 co-simulation with other engines.

• Standard summary and detailed output reports as well 
as user definable reports with selectable time- resolution 
from annual to sub-hourly, all with energy source 
multipliers.

EnergyPlus is a console-based program that reads input and 
writes output to text files. It ships with a number of utili-
ties including IDF-Editor for creating input files using a 
simple spreadsheet-like interface, EP-Launch for managing 
input and output files and performing batch simulations, and 
EP-Compare for graphically comparing the results of two or 
more simulations. Several comprehensive graphical inter-
faces for EnergyPlus are also available (https://energyplus.net/ 
interfaces). One of the interfaces is DesignBuilder. 

One of the strong points of EnergyPlus is the integration of all 
aspects of the simulation – loads, systems and plants. Based on 
a research version of the Building Loads Analysis and System 
Thermodynamics (BLAST) program called IBLAST, system 
and plant output is allowed to directly impact the building ther-
mal response rather than calculating all loads first, then simu-
lating systems and plants. The simulation is coupled allowing 
the designer to more accurately investigate the effect of under-
sizing fans and equipment, and what impact that might have 
on the thermal comfort of occupants within the building.  The 
figures below show the big picture and a basic overview of the 
integration of these important elements of a building energy 
simulation.

https://energyplus.net/interfaces
https://energyplus.net/interfaces
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More information on EnergyPlus can be found in the 
Getting Started manual available at https://energyplus.net/
sites/all/ modules/custom/nrel_custom/pdfs/pdfs_v8.6.0/
GettingStarted.pdf.

https://energyplus.net/sites/all/modules/custom/nrel_custom/pdfs/pdfs_v8.6.0/GettingStarted.pdf
https://energyplus.net/sites/all/modules/custom/nrel_custom/pdfs/pdfs_v8.6.0/GettingStarted.pdf
https://energyplus.net/sites/all/modules/custom/nrel_custom/pdfs/pdfs_v8.6.0/GettingStarted.pdf
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Appendix B: Weather 
Data and Tools

For simulating a building, its model and weather data for the 
location are required. There are various formats for storing 
the hourly weather data. EnergyPlus uses .epw format.

In a .epw file, all the data are in SI units. The format is text-
based and comma-separated. The data file format contains 
commas to facilitate data reading and analysis with spreadsheet 
programs.

More information on the .epw format is given at http:// 
bigladdersoftware.com/epx/docs/8-2/auxiliary-programs/ epw-
csv-format-inout.html#epw-csv-format-inout.

Weather data for more than 2100 locations are now available 
in EnergyPlus weather format at https://energyplus.net/weather.

Weather data analysis tools

It was developed by the Department of Architecture and Urban 
Design, University of California, Los Angeles. Graphically, it 
displays climate data in either metric or imperial units in doz-
ens of ways useful to architects.

Benefits
• Easier to identify unique patterns and subtle details that 

characterize each different climate.

• Thresholds and comfort zones are more flexible.

• In contrast to the Weather Tool, detailed technical infor-
mation about the passive strategies criteria is documented 
and is freely available.

Climate 
 consultant

https://energyplus.net/weather
http://bigladdersoftware.com/epx/docs/8-2/auxiliary-programs/epwcsv-format-inout.html#epw-csv-format-inout
http://bigladdersoftware.com/epx/docs/8-2/auxiliary-programs/epwcsv-format-inout.html#epw-csv-format-inout
http://bigladdersoftware.com/epx/docs/8-2/auxiliary-programs/epwcsv-format-inout.html#epw-csv-format-inout
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• The ‘Wind Wheel’ graphics show velocity and direction 
correlated with temperature and humidity and can be 
animated hourly, daily or monthly.

• The psychometric analysis recommends the most appro-
priate passive design strategies, as outlined in Givoni’s 
Man, Climate and Architecture.

Climate Consultant is free to download from the website http://
www.energy-design-tools.aud.ucla.edu/. 

Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.

 

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energy-design-tools.aud.ucla.edu/
http://www.energy-design-tools.aud.ucla.edu/
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Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.  

Source: From http://www.energydesign-tools.aud.ucla.edu/
climate-consultant/.

http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
http://www.energydesign-tools.aud.ucla.edu/climate-consultant/
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It is developed by the Centre for IT in Building Science (CBS), 
International Institute of Information Technology, Hyderabad, 
India. This is a web-based tool that shortlists the best-matched 
weather based on parameters such as the latitude, altitude and 
temperature range.

The Surrogate City Finder (SCF) tool has been tested by ana-
lysing the annual energy consumption of 16 reference-building 
models simulated for eight locations from different interna-
tional climate zones and their surrogate cities to find that the 
deviation in annual energy consumption was mostly within the 
range of ±2%.

The tool can be accessed at cityfinder.cbs.iiit.ac.in. 

 

Surrogate 
City Finder
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DView is used by BEopt for visualizing time-series weather 
data at any time step (e.g. hourly and subhourly). DView opens 
CSV files and also recognizes several weather data file formats, 
including TMY2, TMY3 and EPW files.

The hourly, daily and monthly graphs allow you to turn vari-
ables on or off with a single click and to zoom and pan very 
easily. DView has the ability to display simultaneous line and 
stacked areas, as demonstrated in the hourly graph below. 

Source: From https://beopt.nrel.gov/downloadDView.

Daily and monthly time series graphs are automatically  created 
by averaging or summing the hourly data: 

Source: From https://beopt.nrel.gov/downloadDView.

DView is free to download from the website https://beopt.nrel.
gov/downloadDView.

DView

https://beopt.nrel.gov/downloadDView
https://beopt.nrel.gov/downloadDView
https://beopt.nrel.gov/downloadDView
https://beopt.nrel.gov/downloadDView


http://taylorandfrancis.com
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Note: Page numbers followed by f and t refer to figures and tables, respectively.

A

Adaptive convection algorithm, 320
Adiabatic surface, 120
Air

conditioning system, 298
flow calculation method, 229–233
gap, 136–139

annual fuel breakdown data for 
different, 139

space layer, 136
Air-cooled chiller, 258, 263

energy consumption, 262t
Air-side economiser, 283–287

in HVAC, 284
Air temperature (AT), 221

control, 56
Air-to-air energy recovery, 293
Annual energy consumption

ASHRAE 90.1 equivalent glass, 163–164
with change in

glass type, 62t
occupancy density, 66t
orientation, 38t
space activity, 72t
with/without lighting control, 83t

double glazing, 158t, 159t, 160
local shading, variation in, 158t, 159t, 160
single glazing, 161–162
time steps, variation in, 309t

Annual energy simulation method, 222–229
Annual fuel breakdown

with change in LPD, 76t
energy with thermal zoning, 96t, 97t
for surface absorptance, 143t
for thermal absorptance, 149t
underdeck/overdeck roof insulation

for Dubai location, 135t
for Frankfurt location, 134t

for various air gap, 139t

with and without green roof, 154t
Applicability schedule, 288–289
Architectural and thermal zoning, 92–97
ASHRAE 90.1-2010 Appendix G, 292

base case external wall for, 384–386
for whole building simulation, 381

ASHRAE 90.1 equivalent glass, annual energy 
consumption, 163–164

Aspect ratio, 91, 102–109
for 64 m2 floor area, 103t
for 624 m2 floor area, 103t
energy consumption with different

with daylight sensor, 106, 106t, 108t, 109
without daylight sensor, 105, 105t, 

108t, 109
AT. See Air temperature (AT)
Axial flow fans, 246
AZ-PHOENIX DEER VALLEY, USA, 88
AZ-PHOENIX/SKY HARBOR, USA, 64, 230, 

254, 263, 277, 310, 317

B

Baseline building performance, 382–384
BEopt, 455
Biquadratic performance curve, 269
‘Black body’ conditions, 146
BLAST (Building Loads Analysis and System 

Thermodynamics) program, 448
Boiler nominal thermal efficiency, 301–304
Building energy code compliance, 381

ASHRAE 62.1 standard summary, 406–407
base case external wall for ASHRAE 

90.1-2010, 384–386
baseline building performance, 382–384
boilers, type and number of, 398–399
chilled-water supply temperature reset for, 

396–397
chillers, number of, 391–396
economiser parameters, 402
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Building energy code compliance (Continued)
exhaust air energy recovery parameters, 

401–402
fan

cycling, 390
power, 388–389

flush windows for base case, 386–387
hot-water pumps, 401
hot-water supply temperature reset, 399–400
HVAC system for base case, 387–388
LEED summary, 403–405
process load for base case, 405–406
unmet hours after simulation, 403

Building energy simulation, 1
advantage over classical method, 4
basic information of, 2–3

envelope components, 3
geometry, 3
location and weather file, 2
services, 3
usage of building, 3

daylight controls, 78–85
energy performance evaluation, 4–15
EnergyPlus, 447
fresh air supply, 88–90
glazing area, 48
large office, 437–446

building envelope, 441
climate and location, 437–439
floor plans, 439–440
HVAC parameters, 443t
internal loads and schedules, 441–443
mechanical systems, 443

lighting and equipment power, 75–77
location and orientation evaluation, 31–41
occupancy density, 64–67
opaque envelope components, 41–48
parameters, 305–327

inside convection algorithm, 319–323
shadowing interval, 324–327
solar distribution algorithm, 310–316
solution algorithm, 316–319
time steps per hour on run time, 306–309

Perimeter and Core zoning, 54
purpose of, 2–3
run

period, 306
time. See Run time

setpoint temperature, 85–87
single-family residence, 419–435

building envelope, 431–434
building overview, 420t
climate and location, 421
floor plans, 421–423
internal loads and schedules, 424–431
mechanical systems, 434–435

occupancies and operating schedule, 
425t–426t

operating schedules for mechanical 
equipment, 427t–428t

single-zone model, 16–30
small office, 409–417

building overview, 410t
climate and location, 409–410
construction parameters, 414t
floor plans, 411–413
HVAC efficiency details, 416t
internal loads and schedules, 414–416
mechanical systems, 416–417

space activity, 67–74
tools, 2
weather data tools, 451–455

Climate Consultant, 451–453
DView, 455
SCF, 454

working of software, 3–4
WWR and glass type, 48–64

Building Loads Analysis and System 
Thermodynamics (BLAST) 
program, 448

C

Calculated natural ventilation, 328
CA-SAN FRANCISCO INTL, USA, 6, 146, 240
Cavity algorithm, 321
Ceiling diffuser algorithm, 320–321
Central HVAC system

air-cooled and water-cooled chillers, 253–263
air-side economiser, 283–287
boiler nominal thermal efficiency, 301–304
cooling tower fan type, 276–280
fan operation mode during unoccupied hours, 

288–292
heat recovery between fresh and exhaust air, 

292–298
VSD impact on

chilled water pump, 272–276
chiller, 263–272
condenser water pump with, 280–283

Centre for IT in Building Science (CBS), 454
Centrifugal fan, 246
Chilled water pump

configurations of, 272, 277
VSD impact on, 272–276

Climate Consultant tool, 451–453
Coefficient of performance (COP), 235

refrigeration cycle, 236
Compact HVAC system, 237
Component/material selection tool, 2
Condenser water pump, 263

with VSD, 280–283
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Conduction Transfer Function (CTF), 317
Continuous control of lighting, 82
Cooling

capacity function, 269
design calculation, 223
equipment capacity, 222
setback setpoint temperature, 289
tower, 277

fan type, 276–280
COP. See Coefficient of performance (COP)
Courtyard with VAV Example, 4, 6, 41, 75
Crank Nicholson second order, 317
CTF (Conduction Transfer Function), 317
Cycle on any, 288

D

Daylight
controls, 78–84

daylight sensor installation, 81–83
sensor placement, 193–208

at 2 and 8 m from window, 203–205
at 2 m from window, 196–202
at 8 m from window, 202–203
annual lighting energy consumption, 207t
illuminance map, 200–202, 201t, 206t

Daylighting-based controls, 189–193
linear/off, 191–192
with no lighting control, 190–191

Day of week field, 214
Degree days, 40
Desiccants, 294
DesignBuilder

ASHRAE 62.1 standard summary in, 
406–407

compliance report generation in, 403–405
cooling design in, 225
data structure hierarchy in, 49–50
default ground temperatures in, 114
drafting options, 50
EnergyPlus weather file, 114
eplusout.err file, 94
heating/cooling systems in, 237
HVAC model in, 237–238
lighting control options, 82
line representation in, 17
model for

large office, 437–446
single-family residence, 419–435
small office, 409–417

natural ventilation approaches in, 328
schedules in, 69
site orientation in, 37
template, 42

file, 6
Templates, 42

Unitary single zone in, 239
weather files, 35
wind pressure coefficients, 344
zone multiplier, 98–99

Design capacity, building, 24
Design day selection, 222–229
Detailed HVAC system, 238, 257
Direct expansion (DX)-based HVAC system, 239
Double glazing, annual energy consumption, 

158t, 159t, 160
Dry resultant temperature, 215
DUBAI INTERNATIONAL, United Arab 

Emirates, 116, 132, 150, 169
DView, 455
DX (direct expansion)-based HVAC system, 239

E

Early design decisions tool, 2
ECB (energy cost budget) method, 381, 384
Economiser, 284

lockout, 299
EIR (energy input ratio), 267, 269
Electric input to cooling output ratio function, 

269
Energy consumption of building, 40

with 30% and 80% WWR, 61t
annual. See Annual energy consumption
with change in nominal thermal efficiency, 

304t
constant and variable flow, chilled water 

pump, 276t
with different aspect ratios

with daylight sensor, 106, 108t, 109f
without daylight sensor, 105, 108t, 109f

effects of
air gap thickness, 136–139
daylighting-based controls, 189–193
roof insulation, 126–131
thermal zoning, 92–97
zone multiplier, 98–102

enthalpy-based economisers, 287t
heating and cooling, 131t
impact of

air-cooled and water-cooled chillers, 
253–263

air fan operation mode, 288–292
condenser water pump with VSD, 

280–283
cooling tower fan type, 276–280
daylight controls, 78–84
daylight sensor placement, 193–208
fresh air supply quantity, 88–90, 89t
green roof, 150–154
internal operable shades, 178–187
occupancy density, 64–67
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Energy consumption of building (Continued)
setpoint temperature, 85–87
shadowing interval, 324–327
solar distribution algorithm, 310–316
space activity, 67–74
VSD on centrifugal chiller, 263–272
VSD on chilled water pump, 272–286
WWR and glazing type, 156–168

with location change, 385t
single speed/double speed cooling tower 

fans, 280t
Energy cost budget (ECB) method, 381, 384
Energy input ratio (EIR), 267, 269
Energy Performance Index (EPI), 12
Energy performance of building, 4–15

annual performance of, 12–13
building layout with tabs, 8
CA-SAN FRANCISCO INTL, 6
Courtyard with VAV Example, 4, 6, 41
EUI, 11–12
impact of

air-side economiser, 283–287
aspect ratio, 102–109
boiler nominal thermal efficiency, 

301–304
fan efficiency, unitary air conditioning 

system, 241–247
fan pressure rise, 247–251
glazing area/properties, 48–64
ground surface, 110–114
heat recovery between fresh and exhaust 

air, 292–298
mixed mode operation, 369–379
overhangs and fins, 168–178
unitary air conditioner COP, 235–240

inside convection algorithm, change in, 
319–323

LONDON/GATWICK ARPT, 7
monthly performance, 9
roof underdeck radiant barrier on, 146–150
simulation, 8–9
solution algorithm, change in, 316–319
surface reflectance, effects of, 140–145
unit conversion, 13–14

EnergyPlus, 447–448
beam solar radiation/reflectance in, 310–311

full exterior, 311
full interior and exterior, 311
minimal shadowing, 310

ESO file, 357
features and capabilities of, 447–448
simulation time steps in, 306
weather file, 114

cooling design simulations using, 223
working, 447–449

Energy recovery ventilation, 293

Energy simulation. See Building energy simulation
Enthalpy, 286

exchange, 294
heat recovery, 293

Enthalpy-based economiser, 287t
Envelope components information, 3
EPI (Energy Performance Index), 12
Eplusout.err file, 94, 308

.epw file, 451
EUI, 11–12

F

Fan, 235, 246, 249
efficiency, 246

annual energy consumption variation 
with, 247t

operation mode during unoccupied hours, 
288–292

pressure rise, 247–251
annual energy consumption variation 

with, 250t
Finite Difference solution technique, 317
Fins, 155, 168–178

energy transfer
no shades, 169–172, 172t
vertical fins, 173–176, 173t

Fixed building shades, 155
Fixed plate heat exchanger, 293
FL – MIAMI, USA, 236, 273
FRANKFURT MAIN ARPT, 92, 132
Fresh air supply, 88–90

G

Geometry of building, 3, 91
aspect ratio, 102–109
surface adjacency, 110–114
thermal zoning, 92–97
zone multiplier, 98–102

Glass type, 155
impact on energy consumption. See 

Window-to-wall ratio (WWR)
properties, 157t

Glazing area, 48
Green roof, 150–154

addition to model, 151–153
annual fuel breakdown, 154t
definition, 151

Gross floor area, building, 12

H

Heating
setback setpoint temperature, 289
value, 301
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Heating, ventilation and air conditioning (HVAC) 
system, 209

Central. See Central HVAC system
compact, 237
design day selection, 222–229
detailed, 238, 257
DX-based, 239
exhaust air heat recovery effect in, 298t
model in DesignBuilder, 237–238
simple, 237
sizing and energy consumption

air flow calculation method, 229–233
lighting and equipment power density, 

75–77
location and orientation, 31–41
opaque envelope components, 41–48
temperature control types, 209–222

unitary. See Unitary HVAC systems
Heat recovery, 293

between fresh and exhaust air, 292–298
Higher heating value (HHV), 301–302
HVAC system. See Heating, ventilation and air 

conditioning (HVAC) system

I

IBLAST, 448
Illuminance map, 200–202, 201t
Inside convection algorithm, 320–321

adaptive convection algorithm, 320
cavity, 321
ceiling diffuser, 321
CIBSE, 321
simple, 320–321
TARP, 321

L

Latent cooling load, 233
Latent heat, 27

exchange effectiveness
75% cooling air flow, 300
75% heating air flow, 299–300
100% cooling air flow, 300
100% heating air flow, 299

Lighting
and controls

daylighting-based controls, 189–193
daylight sensor placement, 193–208

and equipment power, 75–77
Lighting power density (LPD), 75, 84

annual fuel breakdown with change in, 76t
Light-to-solar gain (L/S), 156
Lightweight and heavyweight construction, 

116–125
Linear control of lighting, 82

Living roof, 151
Location and orientation evaluation, building, 

31–41
location change effects, 34–36

on energy consumption, 35t
on heating and cooling equipment 

capacity, 36t
LONDON/GATWICK ARPT, 32
NEW DELHI/PALAM, 33
orientation change effects, 36–38

on energy consumption, 38t
on heating and cooling equipment 

capacity, 38t
simulation results comparison for location, 

35–36
weather files, 32

Location and weather file information, 2
LONDON/GATWICK ARPT, 7, 32, 136
London Gatwick location, United Kingdom, 

78, 98
Lower heating value (LHV), 301–302
LPD. See Lighting power density (LPD)

M

Material and construction, 115
air gap between roof layers, 136–139
green roof, 150–154
lightweight and heavyweight construction, 

116–125
position of roof insulation, 126–131
roof underdeck radiant barrier, 146–150
surface reflectance, 140–145

Mean radiant temperature, environment, 215
Metabolic activity, 66
Mixed-mode building, 370
Mixed-mode cooling, 370
Multi-speed/Variable Speed Drive (VSD) 

fan, 276

N

Natural ventilation, 327, 360, 369, 378
with constant wind speed and direction, 

336–345
min temperature, 351
mixed mode operation, 369–379
window opening

area modulation on, 360–369
and closing schedule, 346–349
control based on temperature, 349–360

wind speed impact on, 328–335
New Delhi/Palam, India, 178, 193, 210, 223, 284, 

288, 293, 324
New Delhi/Safdarjung, India, 328, 336, 346, 349, 

361, 370
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Night
cycle mechanism, 288–289
purge, 120

Nominal electric power, 299
Nominal thermal efficiency, 301–302

O

Occupancy
density, 64–67

on energy consumption, 65–67
equipment and lighting schedule, 69
zone, parameters of, 66

Opaque envelope components, 41–48
Courtyard with VAV Example, 41
external wall construction, alteration of, 

44–45
on energy consumption, 45t
on heating and cooling equipment 

capacity, 46t
Openings and shading, 155

internal operable shades, 178–187
overhangs and fins, 168–178
WWR and glazing type, 156–168

Operable shades, 155
internal, 178–187

Operative temperature (OT), 209, 215, 221
Overdeck roof insulation, 132–134

annual fuel breakdown
for Dubai location, 135t
for Frankfurt location, 134t

Overhangs, 155, 168–178
energy transfer

no shades, 169–172, 172t
overhangs, 172–173, 173t
vertical fins, 173–176, 173t

P

PARIS-AEROPORT CHAR weather file, 85, 
301, 319

Part-load ratio, 267
Performance-based path, building energy code 

compliance, 381
Performance curves, 269
Perimeter and Core zoning, 54
Prescriptive path, building energy code 

compliance, 381

Q

QC – Montreal/Mirabel INT’L A, Canada, 110

R

Radiant barrier, 146

Refrigeration
cycle of COP, 236
ton, 26

Resultant temperature, 215
Retrofitting decisions tool, 2
Rio de Janeiro (AERO), Brazil, 241
Roof insulation, 126–131

position of, 132–135
construction layers, 132t

U-values and R-values, 126t
Roof underdeck radiant barrier, 146–150
Rotating wheel heat exchanger, 293
Run period (simulation period), 306
Run time, 306

solar distribution algorithm impact on, 
310–316

solution algorithm, change in, 316–319, 319t
time steps per hour, 306–309
variation with

inside convection algorithm variation, 
323t

shadowing interval variation, 326t
R-value, 127

S

SCF (Surrogate City Finder) tool, 454
Scheduled natural ventilation, 328, 333
Sensible cooling load, 233
Sensible heat, 26

exchange effectiveness
75% cooling air flow, 300
75% heating air flow, 299
100% cooling air flow, 300
100% heating air flow, 299

recovery, 293
Services of building, 3
Setpoint temperature, 85–87

energy consumption, 86t
heating sizing capacity, 86t

Shades, 155. See also Openings and shading
internal, sunpath, 183–186

Shadowing interval, 324
SHGC (solar heat gain coefficient), 155
Simple convection model, 320–321
Simple HVAC system, 237
SINGAPORE/PAYA LEBA, 140, 156
Single glazing, annual energy consumption, 

161–162
Single-zone model, 16–30

annual simulation, 27–28
cooling design calculation, 25–26
data for, 26t
design capacity, 24
dynamic orbit, 21
heating design calculations, 22–24
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rectangular model, 16–21
sensible heat and latent heat, 27
sizing factor, 24
steady-state heat loss, 24

Site orientation (º), 37
Sizing factor, 24
Solar control, 182
Solar distribution algorithm, 310–316

minimal shadowing, 310
Solar heat gain coefficient (SHGC), 155
Space activity impact evaluation, 67–74

annual energy consumption, 72t
interior load parameters, 72t

Split no fresh air template, 169
State space method, 317
Static pressure, 249
Stay off, 288
Steady-state heat loss, 24
Sunpath diagram, 178

internal shade, 182–186
Supply air

for cooling, 231
for dehumidification, 231

Surface
absorptance, 140

annual fuel breakdown for 
different, 143t

adjacency, 110–114
annual fuel breakdown data, 113t

reflectance, 140–145
Surrogate City Finder (SCF) tool, 454
System time step, 353

T

TARP convection algorithm, 320–321
Temperature

control types, 209–222
annual cooling energy consumption, 

218, 221
curve, 269

Thermal absorptance, 146
annual fuel breakdown for, 149

Thermal gradient, 293
Thermal resistance (r), 127
Thermal transmittance, 127
Thermal zone, 92–97

annual fuel breakdown energy, 96t
definition, 96
simulation run time, 96t
zone floor area calculation method, 93

Thermostats of HVAC, 209
Time step, 305

per hour on run time, 306–309
system, 353
zone, 353–354

Tons of refrigeration (TR), 26
Trombe wall zone, 321

U

Underdeck
radiant barrier, 146–150
roof insulation, 133

annual fuel breakdown, 134t, 135t
Unitary air conditioner

COP, 235–240
fan efficiency, 241–247

Unitary HVAC systems
for air-side economiser, 283
fan pressure rise, 247–251
unitary air conditioner

COP, 235–240
fan efficiency, 241–247

Unitary system, 239
Usage of building information, 3
U-value, 127

heating and cooling energy consumption for 
different, 131

V

Variable Speed Drive (VSD) fan, 279
Variable speed drive (VSD) impact

on chilled water pump, 272–286
on chiller, 263–272, 272t
condenser water pump with, 280–283

Ventilation Control Mode, 353
Visible light transmittance (VLT), 155
VLT to SHGC ratio, 155
VSD. See Variable speed drive (VSD) impact

W

Water-cooled chiller, 258
energy consumption, 262t

WIEN/HOHE WARTE, 189
WIEN/SCHWECHATFLUG, AUSTRIA, 126
Wind

pressure coefficient
data, 343
templates, 344

speed on natural ventilation, 328–335
Window opening

controls, 352
impact on natural ventilation

area modulation, 360–369
and closing schedule, 346–349
control based on temperature, 

349–360
Window-to-wall ratio (WWR), 48–64

air temperature control, 56
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Window-to-wall ratio (WWR) (Continued)
annual energy consumption, 62t
cooling design calculation, 56–57, 58t, 60t
energy consumption, 61t
heating

and cooling sizing, 61t
design calculation, 55–56

impact on energy consumption, 156–168
with ASHRAE 90.1-2007 equivalent 

glass, 162–165, 166–168
with Dbl Green 6mm/6mm Air glass, 156–160
with Sgl Clr 6mm glass, 160–162

WWR setting to building, 54–57
zone

creation, 49–53
renaming, 54

Wind Wheel graphics, 452
WWR. See Window-to-wall ratio (WWR)

X

xESOView, 357

Z

Zone, 96
floor area calculation method, 93
multiplier, 98–102

impact on annual fuel 
breakdown, 102t

Zone Air Temperature (°C), 354
Zone Mean Air Temperature (°C), 354
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